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Informazioni generali 
PC-ECG 1200. Istruzioni per l'uso. 

Per la versione software: 5.988   |   Data di rilascio del software: 24.02.2026 

Per i modelli: 1200S/M/HR/W, Blue-ECG, NR-1207-E e NR-1207-3 

Numero documento (ND): NV-100.5988.050   |   Revisione: 260224   |   Data di rilascio del documento: 24.02.2026 

Articoli UDI-DI base 
Software: PC-ECG 1200 v5.988 426049856DE55252NMKEYVQ 
Dispositivi: 1200S/M/HR/W, Blue-ECG 426049856DE55252NMDECT9 
Dispositivi: NR-1207-E e NR-1207-3 426049856DE55252NMNRSX2 

 

Informazioni sul copyright 
Il presente documento e il software in esso descritto sono di proprietà di Norav Medical e sono protetti dalla normativa sul copyright. 
Non possono essere copiati, riprodotti, trasmessi o tradotti, interamente o in parte, senza il preventivo consenso scritto di Norav 
Medical. Modifiche non autorizzate al presente documento o al software possono invalidare la conformità alle normative e la 
responsabilità del produttore. 

Le informazioni contenute nel presente documento hanno esclusivamente finalità indicative e sono fornite solo per consentire l'uso, la 
manutenzione o l'assistenza corretti e sicuri del software qui descritto. Tali informazioni sono soggette a modifiche senza preavviso e 
non devono essere interpretate come un impegno da parte di Norav Medical. Norav Medical non si assume alcuna responsabilità per 
errori o imprecisioni eventualmente presenti nel documento. Norav Medical non si assume inoltre alcuna responsabilità per l'uso 
improprio o illegale del software né per la mancata osservanza delle istruzioni, delle avvertenze o delle linee guida per l'uso previsto 
fornite nel presente documento. 

Windows® è un marchio registrato di Microsoft Corporation negli Stati Uniti e in altri Paesi. Tutti gli altri marchi citati sono di 
proprietà dei rispettivi titolari. 

La versione più recente di questo documento può essere scaricata dal sito Web: https://www.noravmedical.com/support-center/ 

©2026, Norav Medical. Tutti i diritti sono riservati. 

Dati del produttore e recapiti 

 

Prodotto da:  Persona responsabile nel Regno 
Unito 

 Rappresentante in Svizzera 

Norav Medical GmbH  MEDES LIMITED  Arazy Group Swiss GmbH 
Christof-Ruthof-Weg 10  5 Beaumont Gate  Bruderholzallee 53 
55252 Mainz-Kastel  Shenley Hill  4059 Basilea 
Germania  Radlett, Hertfordshire WD7 7AR  Svizzera 
Telefono: +49 6134-
567983-0 

 Inghilterra, Regno Unito  Telefono: (+41) 33533 2267 

E-mail: info@norav.com  E-mail: medes@arazygroup.com   E-mail: swiss.ar@arazygroup.com 
 

Informazioni sulla conformità 
Questo prodotto (software) è conforme ai requisiti applicabili del Regolamento (UE) 2017/745 del Parlamento Europeo e del 
Consiglio d'Europa sui dispositivi medici e ai requisiti dei Regolamenti sui dispositivi medici del 2002 (Statutory Instruments 2002 N. 
618 Consumer Protection) del Regno Unito e successive modifiche. 
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ND:  NV-100.5988.050|Rev.260224 PC-ECG 1200 Istruzioni per l'uso Pagina 3 di 129 

Questo prodotto (software) è destinato all'installazione su apparecchiature che soddisfano l'edizione applicabile della norma IEC 
62368-1. I dispositivi medici utilizzati insieme a questo prodotto devono essere conformi alle norme della serie IEC 60601 pertinenti, a 
seconda dei casi. Inoltre, qualsiasi interferenza elettromagnetica generata dai dispositivi in questa configurazione deve essere conforme 
alla Direttiva 2014/30/UE del Parlamento Europeo e del Consiglio d'Europa del 26 febbraio 2014. 

⚠Attenzione: La legge federale degli Stati Uniti limita la vendita di questo dispositivo a medici o operatori sanitari 
autorizzati oppure ad altri soggetti in presenza di una prescrizione medica. 

Questo prodotto (software) è conforme agli standard riconosciuti per l'analisi dei potenziali ventricolari tardivi mediante 
elettrocardiografia ad alta risoluzione o con media del segnale pubblicati nel 1991 dalla Task Force Committee della European Society 
of Cardiology, dell'American Heart Association e dell'American College of Cardiology, se ancora accettati nella pratica clinica corrente. 

Esclusione di responsabilità 
Questo prodotto (software) è destinato esclusivamente a essere un dispositivo di supporto decisionale per coloro che hanno ricevuto 
un'adeguata formazione medica. Non deve essere utilizzato come unico riferimento per prendere decisioni cliniche relative alla 
diagnosi, alla cura o alla gestione del paziente. Qualsiasi applicazione delle informazioni mediche ottenute dal prodotto diversa dall'uso 
previsto o dall'intento originario non è consigliata ed è considerata uso improprio del prodotto. 

Avviso importante sull'utilizzo 
Come in tutti i sistemi che elaborano dati medici (inclusi, a titolo esemplificativo ma non esaustivo, l'ECG), interferenze o artefatti 
possono produrre eventi falsi positivi. Pertanto i dati del paziente devono essere esaminati e modificati solo da un medico o da un 
tecnico qualificato che abbiano ricevuto un'adeguata formazione. Norav Medical e il suo personale non saranno ritenuti responsabili 
per i dati dei pazienti esaminati o modificati da una persona non qualificata o da una persona qualificata che agisca al di fuori 
dell'ambito di un giudizio medico appropriato. 

Garanzia limitata Norav Medical 
I prodotti Norav Medical sono garantiti contro difetti di produzione e dei materiali per un periodo di due (2) anni dalla data di 
spedizione da parte di Norav Medical o di un rivenditore autorizzato all'acquirente originale.  

La presente garanzia non copre i materiali di consumo, inclusi, a titolo esemplificativo ma non esaustivo, elettrodi, derivazioni e cavi 
paziente. Questa garanzia non si applica ai prodotti che, secondo il giudizio di Norav Medical, sono stati modificati o danneggiati dal 
cliente. 

Fatta eccezione per le garanzie espresse sopra indicate, Norav Medical declina tutte le garanzie, anche quelle implicite di 
commerciabilità e di idoneità. Le garanzie espresse indicate sostituiscono tutti gli obblighi o le responsabilità di Norav Medical per 
danni, inclusi, a titolo esemplificativo ma non esaustivo, danni speciali, incidentali, indiretti o consequenziali, derivanti o collegati all'uso 
o alle prestazioni dei prodotti Norav Medical. 

Qualsiasi azione per violazione della garanzia deve essere avviata tassativamente entro un (1) anno dalla violazione. Eventuali 
riparazioni effettuate sul prodotto non coperte dalla garanzia saranno fatturate al cliente. 

Per assistenza o supporto tecnico, contattare il fornitore locale o Norav Medical. 
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INTRODUZIONE 

Struttura del manuale 
Questo manuale spiega nel dettaglio come installare e utilizzare il PC-ECG 1200. 

All'inizio di ogni capitolo relativo alle diverse applicazioni è presente la sezione Avvio rapido, che illustra brevemente come eseguire 
un esame, inclusi i tasti di scelta rapida per le funzioni principali. Se l'utente ha dimestichezza con le procedure ECG, può utilizzare la 
sezione Avvio rapido per iniziare a utilizzare rapidamente il dispositivo. 

Il software deve essere installato prima dell'hardware. Vedere le sezioni Installazione del software e Installazione dell'hardware. 

Convenzioni utilizzate nel documento 

Note e precauzioni 
Prestare particolare attenzione ai punti specifici delle procedure quando viene visualizzato uno dei seguenti messaggi: 

 
AVVERTENZA 

I messaggi di avvertenza richiamano l'attenzione su possibili pericoli che comportano 
potenziali danni o lesioni alle persone. 

 

! 
Attenzione 

I messaggi di attenzione riguardano le procedure necessarie per la protezione contro 
potenziali danni o perdite dell'apparecchiatura. Prestare attenzione alle. 

 

 
Nota 

Le note forniscono informazioni rilevanti per ottenere prestazioni ottimali dal software o 
per indicare un passaggio o una procedura importanti che richiedono particolare attenzione. 

 

Abbreviazioni e acronimi 
Abbreviazione Significato 

PA Pressione sanguigna 

ECG Elettrocardiogramma 

VFC Variabilità della frequenza cardiaca 

ID Identificazione 

PT Potenziale tardivo 

LQTS Sindrome del QT lungo 

MET Stima dello stress metabolico 

NS Numero di serie 

USB Universal Serial Bus (Bus seriale universale) 
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Glossario dei simboli dell'apparecchiatura 
Questa sezione fornisce una descrizione dei simboli e dei contrassegni che possono essere presenti sui dispositivi e sui relativi accessori 
menzionati nelle presenti Istruzioni per l'uso. Utilizzare questa sezione come riferimento per comprendere i simboli e i contrassegni e 
garantire la conformità agli standard internazionali e il corretto utilizzo del dispositivo. 

Simbolo Titolo Descrizione 

 

Produttore Indica il produttore del dispositivo medico, come definito nelle direttive UE 
90/385/CEE, 93/42/CEE, 98/79/CE e nel regolamento UE 2017/745. 

 

Numero di riferimento/Numero 
di catalogo 

Indica il numero di riferimento del produttore (catalogo) che consente di identificare il 
dispositivo medico. 

 

Numero di serie Indica il numero di serie del produttore che consente di identificare un dispositivo 
medico specifico. 

 

Codice di lotto/Numero di lotto Indica il codice del lotto del produttore che consente di identificare il lotto o il gruppo. 
 

 

Data di produzione Indica la data di produzione del dispositivo medico. 

 

Numero articolo commerciale 
globale 

Indica un numero utilizzato per identificare gli articoli commerciali per vari livelli di 
imballaggio. 

 

Dispositivo medico Indica che l'articolo è un dispositivo medico. 

 

Identificatore unico del dispositivo 
(UDI) 

Indica un operatore che contiene informazioni identificative univoche del dispositivo. 

 

Numero di modello Indica il numero di modello o il codice di un prodotto. 

 

Contiene/Contenuto Indica i componenti di un particolare dispositivo medico. 

 

Quantità del contenuto Indica che questa confezione contiene una singola unità del prodotto. 

 

Marchio CE Indica che il prodotto è conforme alla normativa europea per i dispositivi medici. 

 

Marchio CE con numero dell'ente 
notificato 

Indica che il prodotto è conforme alla normativa europea per i dispositivi medici. Il 
numero a quattro cifre (in questo caso, 2797) visualizzato accanto al marchio CE sul 
dispositivo medico è il numero dell'ente notificato (BSI). 

 

Parte applicata di tipo BF Identifica una parte applicata di tipo BF conforme alla norma IEC 60601-1. 
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Parte applicata di tipo BF a prova 
di defibrillazione. 

Identifica una parte applicata di tipo BF a prova di defibrillazione conforme alla norma 
IEC 60601-1. 

 

Parte applicata di tipo CF Per identificare una parte applicata di tipo CF conforme alla norma IEC 60601-1. 

 

Parte applicata di tipo CF a prova 
di defibrillazione. 

Identifica una parte applicata di tipo CF a prova di defibrillazione conforme alla norma 
IEC 60601-1. 

 

Apparecchiatura di Classe II Identifica un'apparecchiatura che soddisfa i requisiti di sicurezza specificati per le 
apparecchiature di Classe II secondo la norma IEC 61140. 

 

Consultare le Istruzioni per l'uso o 
le Istruzioni per l'uso elettroniche 

Indica la necessità per l'utente di consultare le Istruzioni per l'uso. 

 

Seguire le Istruzioni per l'uso o le 
Istruzioni per l'uso elettroniche 

Indica che è necessario leggere il manuale/libretto di istruzioni. 

 

Attenzione Indica che è necessario prestare attenzione quando si utilizza il dispositivo o il comando 
vicino al punto in cui è posizionato il simbolo o che la situazione corrente richiede la 
massima attenzione dell'operatore o un suo intervento per evitare conseguenze 
indesiderate. 

 

Avvertenza generale / 
L'accessorio è a prova di 
defibrillatore (DF) 

Indica la necessità di prestare attenzione. Gli utenti devono consultare la 
documentazione allegata per informazioni cruciali relative alla sicurezza o istruzioni 
specifiche che non possono essere completamente applicate al dispositivo o 
all'accessorio stesso (ISO 15223-1:2021). 
 
Se posizionato specificamente su cavi paziente o parti applicate, questo simbolo 
indica inoltre che questi accessori hanno una protezione da defibrillazione integrata, 
come definito nella norma IEC 60601-1. Questo contrassegno sottolinea che il cavo 
paziente o l'accessorio sono a prova di defibrillazione e che devono essere utilizzati per 
garantire la protezione da defibrillazione del dispositivo durante gli eventi di 
defibrillazione. L'uso di cavi senza questo contrassegno può compromettere la sicurezza 
del paziente, l'integrità del dispositivo e le sue prestazioni essenziali durante la 
defibrillazione. 

 

Solo dietro prescrizione medica Attenzione: la normativa federale degli Stati Uniti limita la vendita di questo dispositivo 
a operatori sanitari autorizzati oppure ad altri soggetti in presenza di una prescrizione 
medica. 

 

Radiazioni elettromagnetiche non 
ionizzanti 

Indica livelli generalmente elevati e potenzialmente pericolosi di radiazioni non 
ionizzanti, apparecchiature o sistemi (ad esempio nell'area elettromedicale) che 
includono trasmettitori RF (radiofrequenza) o che applicano intenzionalmente energia 
elettromagnetica RF per la diagnosi o il trattamento. 

 

Non sicuro per la risonanza 
magnetica (RM) 

Un oggetto che presenta rischi inaccettabili per il paziente, il personale medico o altre 
persone nell'ambiente RM. 

 

Grado di protezione ingresso 
fornito dall'involucro 

Grado di protezione contro l'ingresso di particelle e acqua determinato dal produttore, 
dove: 
N1 = grado di protezione dalle particelle (scala da 0 a 6);  
N2 = grado di protezione dall'acqua (scala da 0 a 8). 

 

Grado di protezione ingresso 
fornito dall'involucro 

Protezione contro corpi estranei solidi di 12,5 mm o superiori. Protezione contro la 
caduta verticale di gocce d'acqua quando l'involucro è inclinato fino a 15°. 

 

Grado di protezione ingresso 
fornito dall'involucro 

Protetto dall'ingresso totale di polvere. Protetto dagli spruzzi d'acqua da qualsiasi 
direzione. 
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Marchio della Federal 
Communications Commission 

FCC: Testato secondo i requisiti della Federal Communications Commission. 

 

Identificativo della Federal 
Communication Commission 
(FCC ID: n.) 

Un identificativo univoco assegnato a un dispositivo registrato presso la Federal 
Communications Commission degli Stati Uniti. Indica che questo dispositivo è 
conforme alle normative statunitensi per i dispositivi a radiofrequenza. 

 

Identificativo della Federal 
Communication Commission 
(FCC ID: n.) 

Un identificativo univoco assegnato a un modulo del dispositivo registrato presso la 
Federal Communications Commission degli Stati Uniti. Indica che il dispositivo 
contiene un modulo conforme alle normative statunitensi per i dispositivi a 
radiofrequenza. 

 

Identificativo canadese (IC: n.) per 
l'innovazione, la scienza e lo 
sviluppo economico (ISED) 

Un identificativo univoco assegnato a un dispositivo conforme alla specifica degli 
standard radio ISED Canada. 

 

Marchio di conformità normativa Indica che il dispositivo medico è conforme ai requisiti essenziali di sicurezza per le 
apparecchiature elettriche in Australia e Nuova Zelanda. 

 

Marchio di conformità giapponese 
per gli standard tecnici per le 
apparecchiature radio 

Indica che il dispositivo medico è conforme ai requisiti indicati per le apparecchiature 
radio specificate nell'apposita normativa giapponese. 

 

Marchio di certificazione della 
normativa giapponese sulle 
apparecchiature radio. 

Indica la certificazione secondo la normativa giapponese sulle apparecchiature radio. 

 

Marchio della tecnologia wireless 
Bluetooth® 

Questo simbolo indica che il dispositivo incorpora la tecnologia wireless Bluetooth per 
la trasmissione o la comunicazione dei dati. I dispositivi medici che visualizzano il 
marchio Bluetooth® possono interfacciarsi in modalità wireless con i sistemi compatibili 
tramite protocolli Bluetooth. 

 

Non sterile Indica un dispositivo medico che non è stato sottoposto a un processo di sterilizzazione. 

 

Limite di temperatura Indica i limiti di temperatura ai quali il dispositivo medico può essere esposto in modo 
sicuro. 

 

Limite di umidità Indica l'intervallo di umidità a cui il dispositivo medico può essere esposto in modo 
sicuro. 

 

Conservare in luogo asciutto Indica un dispositivo medico che deve essere protetto dall'umidità. 

 

Fragile, maneggiare con cura Indica un dispositivo medico che può essere rotto o danneggiato se non maneggiato con 
cura. 
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Privo di lattice di gomma naturale Indica che il prodotto non è stato realizzato con lattice di gomma naturale. 

 

 

Non realizzato in PVC Indica che il prodotto non è stato realizzato con PVC. 

 

 

Non realizzato in DEHP Indica che il prodotto non è stato realizzato con DEHP. 

 

 

Riciclo: apparecchiature 
elettroniche 

Smaltimento del dispositivo in conformità alla Direttiva UE 2002/96/CE (RAEE). 
Raccolta differenziata per apparecchiature elettriche ed elettroniche. Non smaltire 
questo prodotto nei rifiuti indifferenziati. 

 

Simbolo delle specifiche della 
batteria/Contrassegno del vano 
batteria 

Indica che il dispositivo supporta due celle AA di batterie alcaline o NiMH. 
 
2×1,5 V modello mignon AA: richiede due batterie alcaline AA (chiamate anche 
"mignon"), ciascuna con tensione nominale di 1,5 V. 
 
2×1,2 V NiMH ACCU: In alternativa, supporta due batterie ricaricabili AA NiMH (Ni-
MH), ciascuna con una potenza nominale di 1,2 V. 

 

Simbolo delle specifiche della 
batteria/Contrassegno del vano 
batteria 

Indica che il dispositivo richiede una batteria AA - (R6), che può essere compresa tra 1,2 
V (comune nelle batterie ricaricabili NiMH) e 1,5 V (comune nelle batterie alcaline o 
primarie al litio). 

 

Simbolo delle specifiche della 
batteria/Contrassegno del vano 
batteria 

Indica i requisiti di orientamento e le dimensioni corrette della batteria da installare. La 
batteria deve essere conforme agli standard IEC R6, ovvero a una cella cilindrica AA 
standard. 

 

Avviso di utilizzo del dispositivo Il dispositivo (registratore) non è adatto all'uso su bambini che pesano meno di 10 kg, 
perché sussiste il rischio di attorcigliamento del cavo paziente. 
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Indicazioni per l'uso del software PC-ECG 1200 

Uso previsto dell'ECG 
L'ECG è destinato a rivelare una condizione normale o situazioni di aritmia, ischemia miocardica, anomalie della frequenza cardiaca o 
caratteristiche di valore prognostico in popolazioni adulte e pediatriche nei seguenti casi: 

◊ Pazienti con sospette anomalie cardiache 

◊ Popolazioni di pazienti con età o in un periodo in cui è auspicabile una valutazione basale di routine delle caratteristiche 
dell'ECG. 

L'analisi QT è utile nella valutazione della sindrome del QT lungo (LQTS). In alcuni casi, la LQTS può essere corretta mediante terapia 
farmacologica. L'analisi QT viene utilizzata anche per misurare la dispersione QT, la differenza tra i valori QT massimo e minimo. 

La dispersione QT è una misura dell'omogeneità della ripolarizzazione ventricolare. PC-ECG 1200 contiene il software di variabilità 
della frequenza cardiaca. Il significato clinico delle misure di variabilità della frequenza cardiaca deve essere determinato da un medico. 
PC-ECG 1200 contiene il software di analisi dei potenziali tardivi. 

La rilevanza clinica delle misure dei potenziali tardivi deve essere determinata da un medico. 

Uso previsto dell'esame da sforzo 
L'angina pectoris (dolore al torace) è una sindrome clinica dovuta a ischemia miocardica, che indica una riduzione dell'apporto di 
sangue al muscolo cardiaco. L'elettrocardiogramma può stabilire la diagnosi di cardiopatia ischemica se ne sono presenti i cambiamenti 
caratteristici. L'esame da sforzo è il metodo più ampiamente utilizzato per decidere se il dolore toracico è correlato all'ischemia 
miocardica e, di conseguenza, alla coronaropatia. Negli esami da sforzo, la capacità di contrazione del muscolo cardiaco viene 
monitorata mediante ECG durante l'esercizio fisico del paziente. I pazienti svolgono attività fisica con cyclette, tapis roulant o altri 
strumenti, mentre l'ECG viene monitorato in modo continuo. I carichi per l'esame da sforzo sono determinati da protocolli predefiniti. 
I segnali ECG vengono registrati per le fasi di riposo, quella di esercizio fisico e quella di recupero del protocollo per l'esame da sforzo. 
Le variazioni delle forme d'onda ECG vengono confrontate con le registrazioni ECG a riposo. La maggior parte dei sistemi per gli 
esami da sforzo commerciali controlla automaticamente la cyclette o il tapis roulant in base ai requisiti del protocollo scelto, sebbene 
questo non sia essenziale. Il monitoraggio del tratto ST è inteso come ausilio nella valutazione dell'ischemia miocardica in pazienti con 
coronaropatia nota o sospetta. L'algoritmo del tratto ST è stato testato per l'accuratezza dei dati del tratto ST e un database viene 
utilizzato come strumento per il test delle prestazioni. 

La rilevanza delle variazioni del tratto ST deve essere determinata da un medico. 

Controindicazioni per l'uso ed effetti avversi 
Il dispositivo non presenta controindicazioni o effetti avversi. 
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PANORAMICA 

Contenuto della confezione 
La confezione di PC-ECG 1200 include i seguenti elementi: 

• Modulo di acquisizione (uno dei modelli seguenti): 

◊ PC-ECG 1200S/1200M 

◊ PC-ECG 1200HR 

◊ PC-ECG 1200W 

◊ Blue-ECG 

◊ NR-1207-E/NR-1207-3 

• Scheda di memoria SD (solo per il modello NR-1207-3) 

• Cavo paziente 

• Cavo dati USB o adattatore RF wireless (per 1200 W) o trasmettitore USB Bluetooth (per Blue-ECG, NR-
1207-E e NR-1207-3) 

• Supporto di installazione software con il pacchetto PC-ECG 1200, che include: 

◊ Resting ECG (ECG a riposo) 

◊ Stress ECG (ECG da sforzo) 

◊ Monitoring ECG (ECG di monitoraggio) 

◊ HRV (VFC) 

◊ LP (PT) 

• Chiave software (se è incluso il software opzionale) 
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Programmi 
Ciascun programma ha uno scopo specifico. Di seguito si riporta una breve descrizione per capire quando utilizzarli: 

 

ECG a riposo Registra e misura brevi esami ECG su pazienti in posizione di riposo (fino a 24 ore) 

ECG da sforzo Registra e misura gli esami ECG su pazienti in condizioni di stress utilizzando un protocollo di 
esame predefinito. 

ECG di monitoraggio Funziona con un dispositivo ECG per registrare, monitorare e salvare un esame ECG prolungato in 
condizioni di riposo 

HRV (VFC) Esegue gli esami in base all'ora in cui il polso e la frequenza cardiaca del paziente variano con il 
carico, i farmaci, ecc. 

LP (PT) Prevede la tendenza alla tachicardia ventricolare 

 

Modelli di PC-ECG 
 

1200S Acquisizione ECG collegata tramite USB per eseguire esami a riposo o da sforzo. 

1200M Acquisizione ECG collegata tramite USB per eseguire esami a riposo. 

1200HR Acquisizione dei dati ECG collegati tramite USB per eseguire esami a riposo o da sforzo. Il 
dispositivo è posizionato su un tavolo/carrello. Oltre che per gli esami da sforzo e a riposo, possono 
essere utilizzati anche per effettuare test avanzati 

1200 W Acquisizione ECG collegata tramite RF wireless per eseguire esami a riposo o da sforzo. 

Blue-ECG Acquisizione ECG con connessione Bluetooth wireless per eseguire esami a riposo. 

 
NR-1207-E 

Acquisizione ECG con connessione Bluetooth wireless per eseguire esami a riposo o da sforzo. Il 
modulo di acquisizione include lo schermo LCD a colori per verificare lo stato di collegamento degli 
elettrodi ECG applicati e per configurare le impostazioni del dispositivo. 

 
NR-1207-3 

Acquisizione ECG con connessione Bluetooth wireless e funzione di registrazione su scheda di 
memoria interna. Dedicato all'esecuzione di esami a riposo o da sforzo. Il modulo di acquisizione 
include lo schermo LCD a colori per verificare lo stato di collegamento degli elettrodi ECG applicati 
e per configurare le impostazioni del dispositivo. 

 

Compatibilità tra dispositivo e opzione software 
 

Dispositivo
/Modulo di 
acquisizione 

I1, 
Sistema 
Measures ed 
Expert 

I3 MEANS 
Interpretation+
I1 

D1/D3 
NEMS ECG 
Gestione 

S1 
Sforzo 

S2 
Sforzo 
avanzato 

M1 
Monitoraggio 

L1 
Potenziali 
tardivi 

H1 
Variabilità della 
frequenza cardiaca 

1200M + + + - - - - - 
Blue-ECG + + + - - - - - 
1200HR + + + + + + + + 
1200S + + + + + - - - 
1200 W + + + + + + - - 
NR-1207-E + + + + + - - - 
NR-1207-3 + + + + + - - - 
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 Avvertenze e  precauzioni di sicurezza 

 
AVVERTENZA 

• ELETTROCHIRURGIA: sussiste il rischio di ustioni e lesioni al paziente. Se si utilizza un dispositivo per 
elettrochirurgia, scollegare il cavo ECG dal dispositivo. 

• CAVI: i cavi presentano un possibile pericolo di strangolamento. Per evitare il rischio di strangolamento, far 
passare tutti i cavi lontano dalla gola del paziente. 

• CONDUTTIVITÀ: possono verificarsi scosse elettriche o malfunzionamenti del dispositivo se gli elettrodi 
entrano in contatto con materiali conduttivi. Tenere le parti conduttive degli elettrodi delle derivazioni e le 
parti associate lontane da altre parti conduttive, compresa la messa a terra. Assicurarsi inoltre che non vi sia 
contatto con altre parti conduttive se gli elettrodi si allentano durante la registrazione. 

• PERICOLO GENERALE PER IL PAZIENTE: le istruzioni elencate in questo manuale non sostituiscono in 
alcun modo le pratiche mediche consolidate riguardanti la cura del paziente. Adottare sempre le pratiche 
mediche stabilite. 

• RISCHIO DI ESPLOSIONE: non utilizzare in presenza di miscele anestetiche infiammabili con aria, 
ossigeno o protossido d'azoto. 

• DEFIBRILLAZIONE: il dispositivo è protetto da defibrillazione quando viene utilizzato il cavo paziente 
originale Norav Medical. Tuttavia, come precauzione di sicurezza, quando possibile, rimuovere gli elettrodi 
prima della defibrillazione. 

• PERICOLO GENERALE PER IL PAZIENTE: il dispositivo non è progettato per l'applicazione cardiaca 
diretta. 

• RISCHIO DI INFEZIONE: il riutilizzo di parti monouso che entrano in contatto con i pazienti può 
rappresentare un rischio di infezione per i pazienti. Non riutilizzare parti monouso che sono state a diretto 
contatto con il paziente, come gli elettrodi ECG. 

• PERICOLO DI INTERPRETAZIONE: l'interpretazione computerizzata è significativa solo se utilizzata in 
combinazione con i risultati clinici. Un medico qualificato deve leggere più volte tutte le tracce generate dal 
computer. 

• INTERFERENZA MAGNETICA ED ELETTRICA: 
i campi magnetici ed elettrici sono in grado di interferire con il corretto funzionamento del dispositivo. 
Assicurarsi pertanto che tutti i dispositivi esterni utilizzati in prossimità del dispositivo siano conformi ai 
requisiti EMC pertinenti. Le apparecchiature a raggi X o i dispositivi per RM sono possibili fonti di 
interferenza poiché possono emettere livelli più elevati di radiazioni elettromagnetiche. 

• OPERATORE: le apparecchiature tecniche mediche come questo sistema devono essere utilizzate solo da 
personale qualificato e addestrato. 
 
SICUREZZA DEL PAZIENTE 

• Un paziente sottoposto a esame deve trovarsi a una distanza di almeno (solo per i modelli cablati): 
 1,5 metri dal computer, dalla stampante e da altre periferiche e 
 2,5 metri dal soffitto. 

• Se tali condizioni non possono essere soddisfatte, l'intero sistema deve essere collegato all'alimentazione CA 
tramite un trasformatore di isolamento conforme allo standard IEC/EN 60601-1. 

• Prima di aprire il vano batteria per l'installazione o la sostituzione della batteria, assicurarsi che il dispositivo 
non sia collegato al paziente tramite cavo ECG o fili delle derivazioni. 
 
FUNZIONAMENTO CON ALTRI DISPOSITIVI 

• Gli altri dispositivi che fanno parte del sistema devono soddisfare i requisiti dello standard per le 
apparecchiature informatiche (IEC/EN 60950-1) e dello standard per i dispositivi medici elettrici (IEC/EN 
60601-1) 

• Il personal computer deve essere approvato ai sensi dello standard di sicurezza appropriato per le 
apparecchiature elettriche non medicali (IEC/EN 60950-1 o le relative varianti nazionali). Inoltre, l'uso di 
un'ulteriore messa a terra di protezione o di un trasformatore di isolamento è necessario per il circuito di 
alimentazione elettrica a cui il sistema PC-ECG 1200 è collegato al fine di soddisfare lo standard di 
sicurezza IEC/EN 60601-1. 

• I computer e le stampanti utilizzati con i dispositivi medici devono essere valutati in base agli standard 
IEC/EN 60950-1, IEC/EN 60601-1 o allo standard di sicurezza equivalente per mantenere la sicurezza dei 
dispositivi medici. 

• Le apparecchiature accessorie collegate alle interfacce analogiche e digitali devono essere certificate in base 
ai rispettivi standard IEC/EN (ad esempio IEC/EN 60950-1 per le apparecchiature di elaborazione dati e 
IEC/EN 60601-1 per le apparecchiature mediche). Inoltre, tutte le configurazioni devono essere conformi 
alla versione dello standard IEC/EN 60601-1 in vigore. 

Pertanto chiunque colleghi apparecchiature aggiuntive all'ingresso o al connettore di uscita del segnale per 
configurare un sistema medicale deve assicurarsi che sia conforme allo standard. 

• PC-ECG 1200 controlla le macchine per l'esercizio. 
Un tapis roulant utilizzato con PC-ECG 1200 deve contenere un comando manuale che consenta all'utente di 
interromperne il funzionamento in caso di emergenza. 

• Quando PC-ECG 1200 viene utilizzato insieme ad altre apparecchiature, rivolgersi a un tecnico 
dell'assistenza qualificato per la gestione corretta. 

! 
• DANNI AL DISPOSITIVO A CAUSA DI PERDITE DALLA BATTERIA: se lasciate all'interno di un 

dispositivo inutilizzato per periodi prolungati, le batterie potrebbero perdere liquido. Se si desidera 
conservare il dispositivo per più di una settimana, rimuovere la batteria. 

• DANNI AI CAVI: il cavo potrebbe danneggiarsi quando viene piegato o arrotolato. Durante il 
collegamento e l'applicazione del cavo ECG, assicurarsi di non piegarlo eccessivamente. Evitare di 
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Attenzione 
 

 

avvolgere il cavo ECG intorno al dispositivo per non danneggiarlo. 
• DANNI AL DISPOSITIVO: è possibile aprire solo il vano batterie del registratore. Non esercitare forza 

quando si usa il registratore. 
• SICUREZZA SOLO CON ACCESSORI APPROVATI: la sicurezza e 

il funzionamento affidabile del dispositivo sono garantiti solo quando si utilizzano gli accessori approvati 
forniti in dotazione. 

• DIFFICOLTÀ A INDIVIDUARE LE CAUSE DEI MALFUNZIONAMENTI: per 
individuare e riparare un malfunzionamento sono necessari sia il dispositivo sia il cavo ECG. Ricordare di 
includere il cavo ECG quando il dispositivo viene restituito per attività di assistenza o riparazione. (Non 
avvolgere il cavo ECG intorno al dispositivo per non danneggiarlo.) Utilizzare sempre lo stesso cavo ECG 
con un dispositivo. Se un istituto dispone di diversi dispositivi e cavi ECG, verificare che ciascuno sia 
utilizzato con uno specifico cavo ECG. Ciò consente di isolare ed eliminare più rapidamente i guasti dei 
cavi o dei registratori. 
In caso di cambiamenti evidenti nelle prestazioni del dispositivo, interromperne immediatamente l'uso. 
Non riprendere l'uso finché il dispositivo non è stato approvato dal produttore o da un rappresentante del 
produttore. 

• DANNI AL DISPOSITIVO E AGLI ACCESSORI: il personale 
non autorizzato non ha la formazione adeguata per riparare il dispositivo. Le riparazioni eseguite da 
personale non autorizzato possono danneggiare il dispositivo o gli accessori. Se si rileva o si sospetta un 
malfunzionamento, inviare il dispositivo per l'ispezione a una struttura autorizzata. Aggiungere una 
descrizione dettagliata del malfunzionamento osservato. 

• DANNI AL DISPOSITIVO: fare attenzione a evitare che sostanze chimiche o liquidi penetrino nei 
connettori o nella parte interna del dispositivo. 
 

• PACEMAKER: si consiglia di mantenere una distanza minima di 15 cm tra i modelli wireless Blue-
ECG/NR-1207-E/NR-1207-3/1200 W e un pacemaker per evitare potenziali interferenze. Alcuni studi 
hanno dimostrato che i dispositivi wireless possono interferire con i pacemaker cardiaci impiantati se 
utilizzati entro una distanza di circa 10 cm. Gli utilizzatori di pacemaker devono evitare di posizionare o 
utilizzare un dispositivo wireless vicino al pacemaker. Indicazioni per i pazienti portatori di pacemaker: 

 L'unità wireless Blue-ECG/NR-1207-E/NR- 1207-3 deve sempre trovarsi ad almeno 30 cm dal 
pacemaker quando l'unità ECG è accesa. 

 Non trasportare il dispositivo Blue-ECG/NR-1207-e/NR-1207-3 nel taschino sul petto. 
In caso di sospetta interferenza, spegnere immediatamente l'ECG. 
 

• Se l'audio viene riprodotto sul PC, l'ECG mostra interferenze. Non eseguire un CD audio sul PC mentre un 
esame ECG viene eseguito tramite collegamento USB. 

• Utilizzare l'unità solo presso cliniche e ospedali. Non utilizzare l'unità a casa. 
 

• Alimentazione: PC-ECG 1200 utilizza l'alimentazione di rete (se non è collegato tramite la porta USB). Il 
trasmettitore PC-ECG wireless da 1200 W utilizza l'alimentazione a batteria. Il ricevitore PC-ECG 1200WR 
utilizza l'alimentazione tramite porta USB. I dispositivi wireless Blue-ECG, NR-1207-E e NR- 1207-3 
utilizzano l'alimentazione a batteria. 
Utilizzare solo il tipo di batteria consigliato, come indicato nelle specifiche tecniche, per il funzionamento 
dei modelli 1200 W, Blue-ECG, NR-1207-E e NR-1207-3 (batterie alcaline AA o ricaricabili NiMH). 
Non utilizzare batterie scadute. 
Rimuovere le batterie dall'unità (1200 W/Blue-ECG/NR-1207-E/NR-1207-3) quando non è in uso. 
 

• Per il dispositivo 1200 W: quando il dispositivo è collegato al paziente tramite cavo ECG o fili delle 
derivazioni, deve essere posizionato sul paziente utilizzando la cinghia. 

• Per i dispositivi della serie NR: quando il dispositivo è collegato al paziente tramite cavo ECG o fili delle 
derivazioni, deve essere posizionato sul paziente utilizzando il relativo supporto o astuccio. 

• Quando il dispositivo è collegato al paziente tramite cavo ECG o fili delle derivazioni, il vano batteria deve 
rimanere chiuso. 

 

 

 

 
Nota 

Il dispositivo (1200 W/Blue-ECG/NR-1207-E/NR-1207-3) è conforme alla Parte 15 delle regole FCC. 
Il suo funzionamento è soggetto alle seguenti condizioni: 

1. Il dispositivo non deve causare interferenze dannose e 
2. Il dispositivo deve accettare qualsiasi interferenza ricevuta, comprese quelle che possono causare un 

funzionamento indesiderato. 
 

 
Nota 

Il produttore non è responsabile per eventuali interferenze radio o TV causate da modifiche non autorizzate apportate 
all'apparecchiatura che potrebbero inoltre invalidare il diritto dell'utente a utilizzare l'apparecchiatura. 
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Nota 

Installare l'hardware solo dopo aver installato il software. 
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Classificazione dell'apparecchiatura 
• In base al tipo di protezione contro le scosse elettriche: CLASSE II 

oppure 
APPARECCHIATURA ALIMENTATA INTERNAMENTE (1200W, Blue-ECG, NR-1207-E e NR-1207-3) 

• In base al grado di protezione contro le scosse elettriche: PARTE APPLICATA DI TIPO CF 
oppure 
PARTE APPLICATA DI TIPO BF (NR-1207-E e NR-1207-3) 

• In base al grado di protezione contro l'ingresso di acqua: APPARECCHIATURA ORDINARIA 
oppure 
IPX2 (NR-1207-E e NR-1207-3) 

• In base al grado di sicurezza dell'applicazione in presenza di miscele anestetiche infiammabili con aria o ossido d'azoto: 
APPARECCHIATURA NON ADATTA ALL'USO IN PRESENZA DI MISCELE ANESTETICHE INFIAMMABILI 
CON ARIA, OSSIGENO O OSSIDO DI AZOTO. 

• In base alla modalità di funzionamento: FUNZIONAMENTO CONTINUO 
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Specifiche EMC in conformità allo standard IEC 60601-1-2 
 

Test delle emissioni Conformità Ambiente elettromagnetico - Linee guida 
Questo dispositivo è destinato all'uso nell'ambiente elettromagnetico specificato di seguito. 
Il cliente e/o l'utente di questo dispositivo devono assicurarsi che venga utilizzato in tale ambiente. 
Emissioni RF 
CISPR 11 

Gruppo 2 Il dispositivo, per poter eseguire le funzioni previste, deve emettere energia 
elettromagnetica. Il funzionamento delle apparecchiature elettroniche vicine 
può risultare compromesso. 

Emissioni RF 
CISPR 11 

Classe B Questo dispositivo è adatto per l'uso in tutti gli ambienti, compresi quelli 
domestici e quelli direttamente collegati alla rete elettrica pubblica a bassa 
tensione fornita agli edifici per uso domestico. Emissioni armoniche  

IEC 61000-3-2 
N/D < 75 
W 

Fluttuazioni di tensione/emissioni 
flicker IEC 61000-3-3 

Conforme 

Tabella 1: Emissioni elettromagnetiche 
 

Test di immunità Livello di test IEC 60601 Livello di conformità Ambiente elettromagnetico - Linee 
guida 

Questo dispositivo è destinato all'uso nell'ambiente elettromagnetico specificato di seguito. 
Il cliente e/o l'utente di questo dispositivo devono assicurarsi che venga utilizzato in tale ambiente. 
Scarica elettrostatica 
(ESD) IEC 61000-4-2 

±6 kV contatto 
±8 kV aria 

±6 kV contatto 
±8 kV aria 

I pavimenti devono essere in legno, 
cemento o piastrelle di ceramica. Se i 
pavimenti sono ricoperti di materiale 
sintetico, l'umidità relativa deve essere 
almeno del 30%. 

Transitori elettrici 
veloci/burst IEC 
61000-4-4 

±2 kV per le linee di 
alimentazione elettrica 
±1 kV per le linee di 
ingresso/uscita 

±2 kV per le linee di 
alimentazione elettrica 
±1 kV per le linee di 
ingresso/uscita 

La qualità dell'alimentazione di rete 
deve essere quella di un tipico ambiente 
commerciale o ospedaliero. 

Sovratensione 
IEC 61000-4-5 

±1 kV modalità differenziale 
±2 kV modalità comune 

±1 kV modalità differenziale 
±2 kV modalità comune 

La qualità dell'alimentazione di rete 
deve essere quella di un tipico ambiente 
commerciale o ospedaliero. 

Cali di tensione, brevi 
interruzioni e 
variazioni di tensione 
sulle linee di ingresso 
dell'alimentazione 
IEC 61000-4-11 

±5% UT (95% calo in UT) 
per 0,5 cicli 
±40% UT (> 60% calo in 
UT) per 5 cicli 
±70% UT (> 30% calo in 
UT) per 25 cicli 
< 5% UT (> 95% calo in 
UT) per 5 sec. 

±5% UT (95% calo in UT) per 
0,5 cicli 
±40% UT (> 60% calo in UT) 
per 5 cicli 
±70% UT (> 30% calo in UT) 
per 25 cicli 
< 5% UT (> 95% calo in UT) 
per 5 sec. 

La qualità dell'alimentazione di rete 
deve essere quella di un tipico ambiente 
commerciale o ospedaliero. 

Frequenza di 
alimentazione 
(50/60 Hz) campo 
magnetico IEC 61000-
4-8 

3 A/m 3 A/m I campi magnetici a frequenza di rete 
devono essere ai livelli caratteristici di 
un ambiente commerciale o ospedaliero 
tipico. 

NOTA: UT è la tensione di rete CA prima dell'applicazione del livello di test. 
Tabella 2: Immunità elettromagnetica 
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Test di 
immunità 

Livello di test 
IEC 60601 

Livello di 
conformità 

Ambiente elettromagnetico - Linee guida 

Questo dispositivo è destinato all'uso nell'ambiente elettromagnetico specificato di seguito. 
Il cliente e/o l'utente di questo dispositivo devono assicurarsi che venga utilizzato in tale ambiente. 
Le apparecchiature di comunicazione RF portatili e mobili non devono essere utilizzate a una distanza da qualsiasi parte del 
dispositivo, compresi i cavi, inferiore alla distanza di separazione consigliata, calcolata in base all'equazione applicabile alla 
frequenza del trasmettitore. 
 
RF condotte 

 
3 Vrms 

 
3 Vrms 

Distanza di separazione consigliata 
 

 
 

 80 MHz - 800 MHz 
 

 800 MHz - 2,5 GHz 
 
Dove P è la potenza nominale massima di uscita del trasmettitore in watt 
(W), secondo le indicazioni del produttore, e d è la distanza di sicurezza 
consigliata in metri (m). 
 
Le intensità di campo provenienti dai trasmettitori RF fissi, in base a quanto 
stabilito da un sopralluogo elettromagnetico del sitoͣ, 
devono essere inferiori al livello di conformità in ogni intervallo di 
frequenzaᵇ. 
 
Possono verificarsi interferenze in prossimità di apparecchiature 
contrassegnate con il seguente simbolo: 

 
 

IEC 61000-4-6 Da 150 kHz a 
80 MHz 

 

RF irradiate 3 V/m 3 V/m 

IEC 61000-4-3 Da 80 MHz a 
2,5 GHz 

 

a. Le intensità di campo provenienti da trasmettitori fissi, quali stazioni base per radiotelefoni (cellulari/cordless) e radio 
portatili per utilizzo a terra, apparecchi per radioamatori, trasmissioni radio in AM e FM e trasmissioni TV, non 
possono essere previste teoricamente in modo accurato. Per valutare l'ambiente elettromagnetico generato da 
trasmettitori RF fissi, è necessario prendere in considerazione un'indagine elettromagnetica del sito. Se l'intensità di 
campo misurata nel luogo in cui viene utilizzato il dispositivo supera il livello di conformità RF applicabile indicato in 
precedenza, è necessario verificare il normale funzionamento del dispositivo. Se si osservano prestazioni anomale, 
potrebbe essere necessario adottare misure supplementari, ad esempio cambiare l'orientamento o la posizione del 
dispositivo. 

b. Oltre l'intervallo di frequenza da 150 kHz a 80 MHz, le intensità di campo devono essere inferiori a [3] V/m. 

NOTE: 

• A 80 MHz e 800 MHz, si applica l'intervallo di frequenza più alto. 
• Queste linee guida potrebbero non essere applicabili in tutte le situazioni. La propagazione elettromagnetica è influenzata 

dall'assorbimento e dalla riflessione da parte di strutture, oggetti e persone. 

Tabella 3: Linee guida e dichiarazione del produttore - Immunità elettromagnetica 

La tabella che segue illustra le distanze di separazione consigliate tra apparecchiature di comunicazione RF portatili e mobili e il 
registratore NR. 

Questo dispositivo è destinato all'uso in un ambiente elettromagnetico in cui i disturbi da RF irradiate sono controllati. Gli utenti 
possono contribuire a prevenire le interferenze elettromagnetiche mantenendo una distanza minima tra le apparecchiature di 
comunicazione RF portatili e mobili (trasmettitori) e il dispositivo come consigliato di seguito, in base alla potenza massima di uscita 
dell'apparecchiatura di comunicazione. 

 Distanza di separazione in base alla frequenza del trasmettitore (m) 

Potenza nominale massima di uscita 
del trasmettitore 

150 kHz - 80 MHz 

 

80 MHz - 800 MHz 

 

800 MHz a 2,5 GHz 
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W 

 

 

  

0,01 0,12 0,12 0,23 

0,1 0,37 0,37 0,74 

1 1,2 1,2 2,3 

10 3,7 3,7 7,4 

100 12 12 23 

Per i trasmettitori con una potenza nominale di uscita massima non inclusa nell'elenco precedente, la distanza di separazione consigliata 
d in metri (m) può essere calcolata utilizzando l'equazione applicabile alla frequenza del trasmettitore, dove P è la potenza nominale 
massima di uscita del trasmettitore in watt (W) indicata dal produttore del trasmettitore. 

NOTE: 

• A 80 MHz e 800 MHz, si applica l'intervallo di frequenza più alto. 
• Queste linee guida potrebbero non essere applicabili in tutte le situazioni. La propagazione elettromagnetica è influenzata 

dall'assorbimento e dalla riflessione da parte di strutture, oggetti e persone. 

Tabella 4: Distanze di separazione consigliate 
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MANUTENZIONE 

! 
Attenzione 

 
 

• Il dispositivo  non è impermeabile. Non immergere mai alcuna parte dell'apparecchiatura, inclusi 
dispositivi, i cavi o le derivazioni, in alcun liquido. Conservare in un luogo asciutto. 

• RISCHIO ELETTRICO: una gestione impropria durante l'ispezione o la pulizia può provocare scosse 
elettriche. Per evitare il rischio di scosse elettriche, attenersi sempre alle seguenti linee guida: 
o Prima di ispezionare o pulire il sistema, spegnerlo e scollegarlo dall'alimentazione CA e rimuovere la 

batteria. 
o Non versare o spruzzare liquidi direttamente sui cavi o sulle derivazioni e non permettere che 

liquidi penetrino attraverso i collegamenti o le aperture. 
o Non utilizzare mai soluzioni conduttive, soluzioni che contengono cloruri, cera o composti di cera 

per pulire dispositivi, cavi o derivazioni. 
o Non sterilizzare mai cavi o derivazioni in autoclave o a vapore. 
o Non utilizzare mai soluzioni o prodotti che contengono quanto segue: 

- Qualsiasi tipo di cloruro di ammonio, a titolo esemplificativo ma non esaustivo: 
• Cloruro di dimetilbenzil-ammonio 
• Soluzioni di cloruro di ammonio quaternario 

- Detergenti abrasivi o solventi di qualsiasi tipo 
- Acetone 
- Chetone 
- Betadine 
- Sali di sodio 

• Prodotti per la pulizia da evitare, a titolo esemplificativo ma non esaustivo: 
o Salviette Sani-Cloth®  
o Salviette Ascepti®  
o Salviette HB Quat 
o Clorox®  (non contengono candeggina). 
o Detergenti da banco (ad esempio Fantastic®, Tilex®, etc.). 
o Prodotti che contengono ingredienti attivi simili a quelli sopra elencati. 

• Impatto/effetti di prodotti e processi di pulizia non adeguati: 
o Scolorimento del prodotto 
o Corrosione delle parti metalliche 
o Cavi fragili 
o Connettori fragili e spaccati 
o Durata ridotta dei cavi e delle derivazioni 
o Malfunzionamento dell'unità 
o Annullamento della validità della garanzia 

 
Eseguire un'ispezione visiva ogni giorno, preferibilmente prima del primo utilizzo dell'apparecchiatura. Durante l'ispezione, verificare 
che il dispositivo soddisfi le seguenti condizioni minime: 

• La custodia del dispositivo non presenta incrinature e altri danni. 
• Tutte le spine, i cavi, i fili e i connettori non sono attorcigliati, sfilacciati e non presentano altri danni. 
• Tutti i cavi e i connettori siano fissati saldamente. 
• Tutti i tasti e i comandi funzionano correttamente. 

In caso di componenti che necessitano di riparazione, richiedere l'intervento di un addetto del servizio di assistenza autorizzato. 
Interrompere l'uso del dispositivo fino a quando non è possibile ripararlo in modo adeguato. 

 
Nota 

Se il liquido penetra nel dispositivo, ad esempio durante la pulizia o l'utilizzo, potrebbe interferire con il corretto 
funzionamento. Spegnere il dispositivo e rimuovere la batteria. Lasciare il dispositivo in un ambiente caldo e 
asciutto con lo sportello della batteria aperto per 48 ore. Se il problema persiste, contattare l'assistenza clienti. 

 

  



ND:  NV-100.5988.050|Rev.260224 PC-ECG 1200 Istruzioni per l'uso Pagina 23 di 129 

 

Pulizia e disinfezione del dispositivo 
Pulire la superficie esterna del dispositivo una volta al mese o più frequentemente, se necessario. 
UTILIZZARE i seguenti materiali per pulire il dispositivo: 

• Detergente enzimatico neutro/a pH neutro 
• Panno morbido e pulito 
• Acqua 

NON UTILIZZARE nessuno dei seguenti materiali per pulire il dispositivo, in quanto il loro utilizzo può danneggiarne le superfici. 
• Solventi organici 
• Solventi a base di ammoniaca 
• Detergenti abrasivi 
• Virex 
• Sani-Master 

Procedura di pulizia manuale 
Procedere alla pulizia delle superfici del dispositivo come indicato di seguito. 

1. Indossare guanti monouso. 
2. Utilizzare un panno morbido non abrasivo inumidito con acqua di rubinetto, pulire il dispositivo per almeno 30 secondi, 

ripetere l'operazione se necessario o fino all'eliminazione dei residui di sporco. 
3. Preparare un detergente enzimatico a pH neutro seguendo le istruzioni del produttore (nelle concentrazioni minime 

raccomandate). 
4. Immergere un panno morbido non abrasivo inumidito con il detergente preparato, quindi passarlo sul dispositivo per almeno 

30 secondi. Ripetere se necessario o fino all'eliminazione dei residui di sporco. 
5. Lasciare asciugare il dispositivo per almeno 10 minuti. 

Procedura di disinfezione superficiale 
Dopo la pulizia, procedere alla disinfezione come segue: 

1. Utilizzare salviette imbevute di isopropanolo al 70% per disinfettare il dispositivo per almeno 3 minuti. Se necessario, ripetere 
l'operazione. 

2. Lasciare asciugare il dispositivo per almeno 10 minuti. 

Pulizia e disinfezione dei cavi e delle derivazioni ECG 
• Rimuovere i cavi e le derivazioni dal dispositivo Norav prima della pulizia. 
• Prestare attenzione durante la pulizia delle derivazioni per evitare di tirare i cavi lunghi dalle estremità del connettore. I 

collegamenti metallici possono essere allontanati dai connettori. 
• Per la pulizia generale di cavi e derivazioni, utilizzare un panno leggermente inumidito con una soluzione di acqua e sapone 

neutro. Quindi asciugare all'aria. 
• Per disinfettare i cavi e le derivazioni, pulire la parte esterna con un panno morbido privo di lanugine, utilizzando la seguente 

soluzione come raccomandato nelle linee guida APIC per la selezione e l'uso dei disinfettanti (1996): 
o Ipoclorito di sodio (candeggina per uso domestico al 5,2%): diluizione minima 1:500 (minimo 100 ppm di cloro 

libero) e diluizione massima 1:10. 
o È possibile utilizzare qualsiasi salvietta con ipoclorito di sodio che soddisfi le linee guida sopra riportate. 

 
Nota 

Strizzare il disinfettante in eccesso dalla salvietta prima dell'uso. 

 

 
Nota 

Qualsiasi contatto di soluzioni disinfettanti con parti metalliche può causare corrosione. 

 

• Non immergere le estremità di un cavo o di un connettore delle derivazioni. L'immersione delle estremità del connettore può 
corrodere le estremità di contatto in metallo e compromettere la qualità del segnale. 

• Pulire le soluzioni detergenti con un panno pulito, leggermente inumidito. 
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• Asciugare accuratamente con un panno asciutto privo di lanugine e lasciare asciugare all'aria per almeno 30 minuti. 

 
Nota 

I tempi di asciugatura possono variare in base alle condizioni ambientali. 

• Prestare attenzione a non far "accumulare" il liquido intorno ai perni di collegamento. Se ciò dovesse accadere, asciugare con 
un panno morbido privo di lanugine. 

• Non utilizzare tecniche di asciugatura eccessive, come forno, calore forzato o esposizione al sole. 

Sterilizzazione 

 
Nota 

La sterilizzazione con ossido di etilene non è CONSIGLIATA, ma potrebbe essere necessaria per cavi e 
derivazioni. La sterilizzazione frequente riduce la vita utile di cavi e derivazioni. 

Sterilizzare con ossido di etilene (EtO) a una temperatura massima di 50 °C/122 °F. Dopo la sterilizzazione con EtO, seguire le 
raccomandazioni del produttore dello sterilizzatore per l'aerazione richiesta. 

Calibrazione 
Il dispositivo non necessita di calibrazione. 
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INSTALLAZIONE DEL SOFTWARE 

Requisiti e prerequisiti di sistema 

 
Nota 

Installare il software prima di installare l'hardware. Se il dispositivo è collegato al PC, scollegarlo prima di 
installare il software. 

 

 
Nota 

L'applicazione per l'esame da sforzo con stampa in tempo reale richiede molte risorse. 
Per ottimizzare le prestazioni, si consiglia di disabilitare i programmi di avvio per liberare le risorse di sistema. Per 
istruzioni, consultare la guida di Windows. 

 

 
Nota 

Il PC non deve essere configurato per funzionare in condizioni di risparmio energetico. Non abilitare la modalità 
di sospensione del PC (Standby), né bloccare o attivare lo spegnimento del disco rigido durante l'esecuzione di un 
esame ECG. 

 Configurazione minima del PC 

Applicazione Prestazioni della 
CPU 

RAM  (GB) Spazio 
libero su 
disco (GB) 

Porte 
USB 
gratuite 
libere 
(*a) 

ECG a riposo Intel i3 o simile 2,0 2 2 (*b) 

 ECG di monitoraggio Intel i3 o simile 2,0 20 2 (*b) 

LP (PT) Intel i3 o simile 2,0 2 2 (*b) 

HRV (VFC) Intel i3 o uguale 2,0 2 2 (*b) 
 
 

ECG 
da 
sforz
o 

Solo dispositivo ECG  
 

Intel i5 o simile 

 
 

4,0 

 
 

20 

2 (*b) 

Tapis roulant/Ergometro +1(*c) 

Monitor pressione 
sanguigna 

+1(*c) 

Stampante termica MP 
200 

+1(*d) 

Tabella 5: Configurazione minima del computer 

*a: una porta per una stampante locale standard o per una stampante LAN non indicata nei calcoli delle porte libere richieste 
*b: il vecchio modello del dispositivo 1200M/S potrebbe richiedere un adattatore USB 1200 
*c: utilizzare un adattatore USB-COM standard o una porta RS232 diretta anziché la porta USB 
*d: utilizzare un adattatore USB-LPT o una porta diretta LPT anziché la porta USB 

 
Nota 

Il computer deve soddisfare i requisiti della norma per le apparecchiature informatiche (IEC/EN 60950-1) 

Stampanti 
Applicazione Tecnologia Memoria RAM 

(MB) 
Driver 

Resting ECG (ECG a 
riposo) 

LASER/INCHIOSTRO 2 Fornitore/MS 

Monitoring ECG (ECG di 
monitoraggio) 

LASER/INCHIOSTRO 2 Fornitore/MS 

LP (PT) LASER/INCHIOSTRO 2 Fornitore/MS 

HRV (VFC) LASER/INCHIOSTRO 2 Fornitore/MS 
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Stress ECG (ECG da 
sforzo) 

LASER veloce 8 Fornitore/MS 

Tabella 6: Requisiti di installazione delle stampanti 

Stampante termica 
Il driver della stampante termica viene installato separatamente dal programma PC-ECG 1200. 

Una stampante termica può essere fornita da Norav (MP200, 8 pollici). Questa stampante richiede un dongle con l'autorizzazione per 
la licenza P1. 

Il driver MP200 è disponibile sul supporto di installazione PC-ECG 1200. 

Installazione o aggiornamento del software PC-ECG 1200 
Il pacchetto software funziona con i sistemi operativi Microsoft Windows: Windows 10/11. 

Installazione di PC-ECG 1200 
• Inserire il supporto di installazione nello slot USB. Se l'installazione non si avvia automaticamente, eseguire il programma 

 dalla directory principale del disco di installazione. 
• Seguire le istruzioni visualizzate sullo schermo. 
• La procedura di installazione prevede la scelta del livello di sicurezza di accesso al software. Le opzioni disponibili sono Basic 

(Base) o Elevated (Elevata). 
o Se si sceglie il livello di sicurezza (Basic) Base, all'avvio dell'applicazione ECG non verrà richiesta alcuna password. 
o Se si sceglie invece il livello di sicurezza Elevated (Elevata), l'operatore sarà costretto a immettere nome utente e 

password all'avvio dell'applicazione ECG. Il nome utente richiesto è ecguser e la password è login. Inoltre, è 
disponibile una password diversa per il pannello di impostazione della configurazione. La password di protezione 
dell'impostazione della configurazione è norav. 

Al termine dell'installazione, sul desktop viene aggiunta un'icona di gruppo denominata PC-ECG 1200. Fare doppio clic sull'icona del 
gruppo per visualizzare le seguenti icone dei programmi. 

Icona Spiegazione 

 

 

 

Heart Rate Variability (Variabilità della frequenza cardiaca) 

 

 

 

Late Potential (Media segnale dei potenziali tardivi) 

 

 

 

Monitoring ECG (ECG di monitoraggio) 

 

 

 

Resting ECG (ECG a riposo) 

 

 

 
Stress ECG (ECG da sforzo) 

Tabella 7: Icone del programma 
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L'ECG a riposo è il pacchetto software di base. Non richiede una chiave software. I seguenti sono opzionali e richiedono le chiavi del 
software: 

◊ Funzioni di misurazione e interpretazione per l'ECG a riposo 

◊ Variabilità della frequenza cardiaca 

◊ Potenziale tardivo 

◊ Monitoring ECG (ECG di monitoraggio) 

◊ Stress ECG (ECG da sforzo) 
È possibile attivare pacchetti opzionali senza chiave selezionando Simulator (Simulatore) in Setup (Configurazione). 

Se è stata acquistata l' opzione S2 Advanced Stress (Sforzo avanzato S2) e si desidera utilizzare la visualizzazione remota, installare li 
programma Remote View (Vista remota) dalla directory Remote View (Vista remota) sul CD. Questo programma abilita un 
visualizzatore remoto per un esame ECG. L'immagine viene visualizzata in formato JPEG. 

Disinstallazione di PC-ECG 1200 
Nuova versione in sostituzione della vecchia versione 
Non è necessario rimuovere l'installazione precedente. La configurazione esistente rimarrà per la nuova versione. 
Se la nuova versione software non funziona correttamente, disinstallare la vecchia installazione e ripetere l'installazione della nuova 
versione. 
 

Versione precedente che sostituisce la nuova versione 
Disinstallare la versione esistente come segue: 
My Computer > Control Panel > Add/Remove Programs > PC-ECG 1200 >Add/Remove > OK (Risorse del computer > Pannello 
di controllo > Aggiungi/Rimuovi programmi > PC-ECG 1200 >Aggiungi/Rimuovi > OK) 
 

Per liberare spazio su disco e garantire un funzionamento normale 
Windows fornisce delle utility per eliminare i file superflui e deframmentare il disco. Fare riferimento alla guida in linea di Windows per 
istruzioni sulla pulizia e la deframmentazione del disco. 
 

Backup e ripristino delle impostazioni e dei protocolli 
Quando si reinstalla o aggiorna PC-ECG 1200, il programma sovrascrive le configurazioni e i protocolli esistenti. Per salvare i dati di 
configurazione per l'applicazione per l'esame da sforzo, seguire queste procedure. 

Per salvare la configurazione dell'impostazione del software 

• Avviare l'applicazione dell'esame ECG da sforzo. 

• Fare clic su View (Visualizza)\Save Setup (Salva configurazione). 

 
Figura 1: Salvataggio della configurazione dell'impostazione del software 

 
• Assegnare un nome al file. Fornire una posizione in cui salvare il file e fare clic su OK. 

Per caricare la configurazione dell'impostazione del software 
• Avviare l'applicazione dell'esame ECG da sforzo. 
• Fare clic su View (Visualizza)/Load Setup (Carica configurazione). 
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• Fare clic su Browse (Sfoglia) e individuare la posizione in cui è salvato il file. 
• Selezionare il file (con il nome assegnato e il suffisso "INI") e fare clic su OK. 

Per salvare i protocolli per l'esame da sforzo 
• Creare una nuova directory in Documents (Documenti) del computer, con un nome simile a PcBackup (Backup PC). 
• Copiare il file StWorked.mdb dalla cartella delle impostazioni PC-ECG (di solito in C:\ProgramData\Norav 

Medical\Settings\ (C:\Programmi\Norav Medical\Impostazioni\)). 
• Incollarlo in una directory di backup (ad esempio Documents\PcBackup (Documenti\Backup PC)). 

Per caricare i protocolli per l'esame da sforzo 
• Copiare il file StWorked.mdb dalla directory in cui è stato salvato (ad esempio Documents\PcBackup (Documenti\Backup 

PC)). 
• Incollarlo nella cartella delle impostazioni di PC-ECG (di solito in C:\ProgramData\Norav Medical\Settings\ 

(C:\Programmi\Norav Medical\Impostazioni\)). 
• Viene visualizzata una finestra che chiede se si desidera sostituire il file esistente. Fare clic su Yes (Sì). 

Per impostare le preferenze 
• Dopo aver installato il pacchetto PC-ECG 1200 e prima dell'uso, fare clic su Setup (Configurazione) per personalizzare le 

proprie preferenze. 
• Iniziare con Environment (Ambiente) per configurare l'hardware. 
• Continuare con le altre schede in qualsiasi ordine. 
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INSTALLAZIONE DELL'HARDWARE 

Installazione del modello 1200S e del modello 1200M 
I kit PC-ECG 1200S e PC-ECG 1200M contengono i seguenti elementi: 

◊ Scatola di acquisizione 

◊ Cavo paziente 

◊ Cavo USB 

◊ Pacchetto di installazione del software PC-ECG 1200 su CD o unità flash USB. 

◊ Chiave di licenza software (se è incluso il software opzionale) 
 

Figura 2: PC-ECG 1200S / PC-ECG 1200M 
 

 
Figura 3: Cavo paziente 
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Figura 4: Cavo USB 
 
Procedura di collegamento tramite USB 

• Collegare il connettore di tipo A del cavo USB al PC. 
• Collegare il connettore di tipo B del cavo USB all'ingresso dell'unità 1200M/1200S. 
• Potrebbe essere visualizzata una procedura guidata per l'installazione di un nuovo driver hardware. Attendere che il driver sia 

installato e che la spia verde si illumini sull'unità 1200M/1200S. 
• Verificare che la spia sia accesa sul dispositivo 1200M/1200S. 
• Collegare il cavo paziente alla spina a 15 pin sul lato del dispositivo 1200M/1200S. 
• Se la chiave software opzionale è inclusa, collegarla al computer. 
• Se è collegata una stampante, inserire il cavo della stampante nella chiave. 
• Collegare le derivazioni degli elettrodi al paziente, iniziando dalla gamba destra. 

 
Per verificare le connessioni 

• Eseguire l'applicazione per l'esame ECG a riposo. 
• Premere F1 per un nuovo esame. 
• Inserire i dettagli del paziente nella finestra di dialogo, quindi fare clic su OK. 
• Verificare che i tracciati siano acquisiti e visualizzati sullo schermo. 

 

Installazione del modello 1200HR 
Il kit PC-ECG 1200HR contiene i seguenti elementi: 

◊ Scatola di acquisizione 

◊ Derivazioni paziente 

◊ Cavo USB integrato 

◊ Pacchetto di installazione del software PC-ECG 1200 su CD o unità flash USB. 

◊ Chiave di licenza software (se è incluso il software opzionale). 
 

Figura 5: PC-ECG 1200HR (con cavo USB integrato) 
 
Procedura di collegamento tramite USB 

• Collegare il connettore USB di tipo A del cavo USB al PC. 

• Se la chiave software opzionale è inclusa, collegarla al computer. 
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• Attendere che il driver sia installato e che la spia verde si illumini sul dispositivo 1200HR. 

• Collegare il cavo paziente alla spina a 15 pin del PC-ECG 1200HR. 
 
Per connettersi al paziente e  al computer 

• Verificare che il LED di indicazione sia acceso sulla parte anteriore del PC-ECG 1200HR. 
• Collegare i cavi degli elettrodi al paziente, iniziando dalla gamba destra. 

 
Per verificare le connessioni 

• Eseguire l'applicazione per l'esame ECG a riposo. 
• Premere il tasto F1 della tastiera per un nuovo esame. 
• Inserire i dettagli del paziente nella finestra di dialogo, quindi fare clic su OK. 
• Verificare che i tracciati siano acquisiti e visualizzati sullo schermo. 

 

Installazione del modello 1200W 
Il kit PC-ECG 1200W contiene i seguenti elementi: 

◊ Scatola di acquisizione 

◊ Derivazioni paziente 

◊ Cavo USB 

◊ Antenna 

◊ Ricevitore 1200WR 

◊ Pacchetto di installazione del software PC-ECG 1200 su CD o unità flash USB. 

◊ Chiave di licenza software (se è incluso il software opzionale). 

Figura 6: PC-ECG 1200W 
 

Figura 7: Cavo USB 
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Installazione delle batterie nel modello 1200W 

 

Fase 1 
 
Inserire la prima 
batteria e farla scorrere 
verso destra. 

 

Fase 1 
 
Aprire il coperchio del 
vano batterie. Prendere 
nota dell'etichetta della 
polarità della batteria. 
 

 

Fase 2 
 
Inserire la seconda 
batteria e spingerla 
verso sinistra e verso il 
basso con un unico 
movimento.  

Fase 2 
 
Inserire la batteria e 
spingerla verso destra e 
verso il basso con un 
unico movimento. 

 

Fase 3 
 
Installare il coperchio 
della batteria. 

 

Fase 3 
 
Fissare il coperchio della 
batteria spingendolo con 
un'angolazione verso 
sinistra in modo che le 
due linguette scattino in 
posizione. 

 

Fase 4 
 
Premere il coperchio 
della batteria verso il 
basso finché non scatta 
in posizione. 

 

Fase 4 
 
Premere il coperchio 
della batteria verso il 
basso finché non scatta 
in posizione. 

Figura 8: Installazione delle batterie nel modello 1200W 
 
Procedura di collegamento tramite USB 

• Collegare l'antenna al connettore sul ricevitore 1200WR. 
• Collegare il connettore di tipo A del cavo USB al PC. 
• Collegare il connettore di tipo B del cavo USB alla porta USB del ricevitore 1200WR. 
• Attendere che il driver sia installato e che la spia verde si illumini sul ricevitore 1200WR. 
• Collegare le 10 derivazioni paziente al PC-ECG 1200W sulla base delle etichette presenti sulle prese delle derivazioni. 
• Inserire 2 batterie alcaline o ricaricabili AA (o 1 AA per unità V3 da 1200 W) nel vano batterie dell'unità PC-ECG 1200W. 
• Accendere PC-ECG 1200W e verificare che la spia ON sia accesa. 
• Se la chiave software opzionale è inclusa, collegarla al computer. 
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• Collegare l'hardware esterno tramite i cavi appropriati a uno o più connettori BNC sul ricevitore 1200W (valido per l'opzione 
S2 Advanced Stress (Sforzo avanzato S2)): uscita attivazione TTL per la sincronizzazione del monitor della pressione 
sanguigna, accoppiamento di uscite analogiche mediante la derivazione ECG, la frequenza cardiaca o per l'azionamento del 
tapis roulant/dell'ergometro a controllo analogico. 

Figura 9: ricevitore 1200WR 
Per verificare le connessioni 

• Fissare il dispositivo PC-ECG 1200W al corpo del paziente con una cintura. 
• Collegare i cavi degli elettrodi al paziente, iniziando dalla gamba destra. 
• Eseguire l'applicazione per l'esame ECG a riposo. 
• Premere il tasto F1 della tastiera per un nuovo esame. 
• Inserire i dettagli del paziente nella finestra di dialogo, quindi fare clic su OK. 
• Verificare che i tracciati siano acquisiti e visualizzati sullo schermo. 

 

Installazione del modello Blue-ECG 
Il kit PC-ECG 1200 Blue-ECG contiene i seguenti elementi: 

◊ Scatola di acquisizione 

◊ Cavo paziente 

◊ Due batterie alcaline AA (opzionali) 

◊ Adattatore USB Bluetooth 

◊ Prolunga USB 

◊ Pacchetto di installazione del software PC-ECG 1200 su CD o unità flash USB. 

◊ Chiave di licenza software (se è incluso il software opzionale). 
 

Figura 10: PC-ECG 1200 Blue-ECG 
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Per installare il dispositivo Blue-ECG 
Installazione dell'adattatore Bluetooth 

Se il PC non dispone di un dispositivo Bluetooth integrato, collegare l'adattatore Bluetooth alla porta USB del computer e verificare 
che sia installato correttamente. 

 
Nota 

Utilizzare l'adattatore Bluetooth in dotazione su un computer che non dispone di un proprio modulo Bluetooth o 
quando è richiesta la copertura di una distanza più lunga. Prima di installare l'adattatore Bluetooth in dotazione, 
disabilitare il modulo Bluetooth integrato. 

Collegare l'adattatore Bluetooth alla porta USB. Viene identificato il nuovo hardware. Dopo aver installato il driver, viene visualizzata 
un'icona Bluetooth sulla barra delle applicazioni 

 

Figura 11: Icona Bluetooth sulla barra delle applicazioni Accensione del dispositivo Blue-ECG 

Accensione del dispositivo Blue-ECG 

 
Nota 

Utilizzare solo batterie ricaricabili NiMH o alcaline. Sebbene le batterie zinco-carbone e NiCd ricaricabili 
mostrino una tensione adeguata nel test della batteria, l'uscita è spesso insufficiente per eseguire il monitoraggio. 

1. Collegare il cavo paziente al connettore rotondo sulla parte superiore del dispositivo Blue-ECG. 
2. Inserire le batterie rispettando la polarità dei terminali ("+"o "-"). 
3. Premere il pulsante sulla parte anteriore del dispositivo Blue-ECG per accenderlo. 

Aggiunta di Blue-ECG all'elenco dei dispositivi Bluetooth 

1. Fare doppio clic sull'icona Bluetooth sulla barra delle applicazioni. Fare clic su Add Bluetooth  or other device (Aggiungi 
Bluetooth o altro dispositivo), quindi selezionare Bluetooth. 

2. Selezionare il nome del dispositivo "ECGBT8-XXX". 
3. Immettere 12345 come passkey e fare clic su Connect (Connetti). 
4. Dopo aver associato il dispositivo, fare clic su Done (Fine). 

Installazione della chiave di licenza software (opzionale) 

Collegare il dongle HASP alla porta USB. Viene identificato il nuovo hardware. Dopo aver installato il driver, sul dongle HASP viene 
visualizzata una spia rossa. 

Registrazione del dispositivo Blue-ECG nell'applicazione del software ECG a riposo 

1. Eseguire l'applicazione software ECG a riposo dalla cartella PC-ECG 1200 sul desktop. 
2. Fare clic sul pulsante del menu principale Setup (Configurazione). 
3. Aprire la cartella Environment (Ambiente), quindi selezionare l'opzione del dispositivo Bluetooth. 
4. Fare clic sul pulsante OK per applicare le modifiche, quindi chiudere l'applicazione ECG a riposo. 

Verifica dei collegamenti 

1. Eseguire nuovamente l'applicazione ECG a riposo e verificare che l'icona  venga visualizzata sul lato destro. 

2. Avviare il nuovo esame facendo clic sul pulsante  o premendo il tasto F1 della tastiera. 

3. Verificare che i tracciati siano acquisiti e visualizzati sullo schermo, quindi fare clic su . 
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Installazione dei modelli NR-1207-E e NR-1207-3 
Il kit PC-ECG NR-1207-E contiene i seguenti elementi: 

◊ Scatola di acquisizione 

◊ Cavo paziente 

◊ Batteria alcalina AA (opzionale) 

◊ Scheda di memoria SD (solo per il modello NR-1207-3) 

◊ Adattatore USB Bluetooth 

◊ Prolunga USB 

◊ Pacchetto di installazione del software PC-ECG 1200 su CD o unità flash USB. 

◊ Chiave di licenza software (se è incluso il software opzionale). 

 

Figura 12: PC-ECG NR-1207-E/NR-1207-3 

 

Collegamento del cavo paziente 

Collegamento: 

Inserire il connettore del cavo ECG nello slot sulla parte superiore dell'unità NR-1207-E o 
NR-1207-3. 

Assicurarsi di inserire il connettore del cavo finché entrambi i fermi del connettore del cavo 
non sono bloccati sull'unità. 

Scollegamento: 

Rimuovere il connettore del cavo ECG premendo i due fermi laterali sulla testa del connettore 
del cavo e allontanandolo dalla presa del connettore. 

 

 

Figura 13: Collegamento del cavo paziente NR-1207-E / NR-1207-3 
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Inserimento della scheda di memoria (solo per i modelli NR-1207-3) 

 

Aprire il coperchio del vano batteria spostando il sistema di chiusura del coperchio verso 
sinistra e verso l'alto. 

  

 

Verificare che non ci sia alcuna batteria nel vano batteria. La batteria deve essere rimossa 
prima di inserire o rimuovere la scheda di memoria. 
 
Spingere la scheda di memoria nell'alloggiamento finché non si blocca in posizione. Per 
rimuovere la scheda di memoria, spingere la scheda di 1-2 mm nell'alloggiamento per 
rilasciare il fermo di bloccaggio. 

Figura 14: Inserimento della scheda di memoria NR-1207-3 

 Installazione della batteria 

 

Aprire il coperchio del vano batteria spostando il sistema di chiusura del coperchio verso 
sinistra e verso l'alto. 

  

 

Inserire una batteria AA nuova. Inserire prima il terminale negativo. 
Assicurarsi che il nastro di rimozione della batteria sia posizionato dietro la batteria. 

  

 

Chiudere il coperchio del vano batterie e premerlo finché non si blocca nella base. 
Assicurarsi che il nastro sia completamente nascosto sotto la copertura. 

Figura 15: Installazione della batteria NR-1207-E/NR-1207-3 

 

Per montare il dispositivo NR-1207-E o NR-1207-3 
Installazione dell'adattatore Bluetooth 

Se il PC non dispone di un dispositivo Bluetooth integrato, collegare l'adattatore Bluetooth alla porta USB del computer e verificare 
che sia installato correttamente. 

 
Nota 

Utilizzare l'adattatore Bluetooth in dotazione su un computer che non dispone di un proprio modulo Bluetooth o 
quando è richiesta la copertura di una distanza più lunga. Prima di installare l'adattatore Bluetooth in dotazione, 
disabilitare il modulo Bluetooth integrato. 
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Collegare l'adattatore Bluetooth alla porta USB. Viene identificato il nuovo hardware. Dopo aver installato il driver, viene visualizzata 
un'icona Bluetooth sulla barra delle applicazioni 

 

Figura 16: Icona Bluetooth sulla barra delle applicazioni Accensione del dispositivo NR-1207-E/NR-1207-3 

Accensione del dispositivo NR-1207-E / NR-1207-3 

 
Nota 

Utilizzare l'adattatore Bluetooth in dotazione su un computer che non dispone di un proprio modulo Bluetooth o 
quando è richiesta la copertura di una distanza più lunga. Prima di installare l'adattatore Bluetooth in dotazione, 
disabilitare il modulo Bluetooth integrato. 

1. Collegare il cavo paziente al connettore sulla parte superiore NR-1207-E/NR-1207-3. 
2. Inserire la batteria rispettando la polarità dei terminali ("+"o "-"). 
3. Premere il pulsante sulla parte anteriore di NR-1207-E/NR-1207-3 per accenderlo. 

 
Aggiunta di  NR-1207-E / NR-1207-3 all'elenco dei dispositivi Bluetooth  

1. Fare doppio clic sull'icona Bluetooth sulla barra delle applicazioni. Fare clic su Add Bluetooth  or other device (Aggiungi 
Bluetooth o altro dispositivo), quindi selezionare Bluetooth. 

2. Selezionare il nome del dispositivo, che può essere "NR-1207-E-xxxx", "NR-1207-3" oppure, per alcune modifiche, "NR 
Recorder" (Registratore NR). 

3. Immettere 12345 come passkey e fare clic su Connect (Connetti). 
4. Dopo aver associato il dispositivo, fare clic su Done (Fine). 

 
Installazione della chiave di licenza del software (opzionale) 
Collegare il dongle HASP alla porta USB. Viene identificato il nuovo hardware. Dopo aver installato il driver, sul dongle HASP viene 
visualizzata una spia rossa. 
 
Registrazione del dispositivo NR-1207-E / NR-1207-3 nell'applicazione software ECG a riposo 

1. Eseguire l'applicazione software ECG a riposo dalla cartella PC-ECG 1200 sul desktop. 
2. Fare clic sul pulsante del menu principale Setup (Configurazione). 
3. Aprire la cartella Environment (Ambiente), quindi selezionare l'opzione del dispositivo Bluetooth. 
4. Fare clic sul pulsante OK per applicare le modifiche, quindi chiudere l'applicazione ECG a riposo. 

 
Verifica dei collegamenti 

1. Eseguire nuovamente l'applicazione ECG a riposo e verificare che l'icona  venga visualizzata sul lato destro. 

2. Avviare il nuovo esame facendo clic sul pulsante  o premendo il tasto F1 della tastiera. 

3. Verificare che i tracciati siano acquisiti e visualizzati sullo schermo, quindi fare clic su . 
 

Collegamento di un dispositivo per l'esercizio fisico 
È possibile collegare al computer un tapis roulant e/o un ergometro controllato da PC tramite USB, RS232 o interfaccia di controllo 
analogica. 

Per collegare un tapis roulant/ergometro controllato tramite RS232 
• Collegare il tapis roulant/l'ergometro tramite il cavo RS232 alla porta COM libera del computer. 
• Configurare il software per l'esame ECG da sforzo (nella scheda Environment (Ambiente) della configurazione): 

o Selezionare il numero della porta COM collegata. 
o Selezionare il protocollo di comunicazione del dispositivo per l'esercizio nell'elenco Type (Tipo). 

Per collegare un tapis roulant/ergometro controllato tramite USB 
• Collegare il tapis roulant/ergometro tramite cavo USB alla porta USB libera del computer. Il computer genererà 

automaticamente una porta COM virtuale per questo collegamento. 
• Configurare il software per l'esame ECG da sforzo (nella scheda Environment (Ambiente) della configurazione): 

o Selezionare il numero della porta COM collegata. 
o Selezionare il protocollo di comunicazione del dispositivo per l'esercizio nell'elenco Type (Tipo). 
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Per collegare un tapis roulant/ergometro controllato analogicamente 
Per il modello 1200W con il ricevitore 1200WR dotato di 3 connettori di uscita BNC 

• Collegare i cavi del tapis roulant/dell'ergometro controllato analogicamente ai connettori dell'opzione Analog Out 1 (Uscita 
analogica 1) e 

• dell'opzione Analog Out 2 (Uscita analogica 2) sulla scatola 1200WR. 
• Configurare il software dell'esame ECG da sforzo (nella scheda Environment/Advance (Ambiente/Avanzate)): 

Per il tapis roulant 
o Nell'opzione Analog out 1 (Uscita analogica 1), selezionare Analog Control (Controllo analogico), quindi 

scegliere l'opzione Speed (Velocità). Regolare l'intervallo della tensione di controllo in Settings (Impostazioni). 
o Nell'opzione Analog out 2 (Uscita analogica 2), selezionare Analog Control (Controllo analogico), quindi 

scegliere l'opzione Grade (Livello). Regolare l'intervallo della tensione di controllo in Settings (Impostazioni). 
Per l'ergometro 

o nell'opzione Analog out 1 (Uscita analogica 1), selezionare Analog Control (Controllo analogico), quindi 
scegliere l'opzione Watts (Watt). Regolare l'intervallo della tensione di controllo in Settings (Impostazioni). 

 
Per il controllo tramite scheda PCI convertitore D/A 

• Collegare il tapis roulant/l'ergometro tramite il cavo dedicato all'uscita della scheda D/A. 
• Configurare il software dell'esame ECG da sforzo (nella scheda Environment/Advance (Ambiente/Avanzate)): 

o Nel pannello Cards (Schede), selezionare l'opzione Analog Control (Controllo analogico). Regolare l'intervallo 
della tensione di controllo in Settings (Impostazioni). 

 

Cablaggio 
I cavi di collegamento possono essere acquistati presso i distributori Norav Medical. 
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INSTALLAZIONE DEGLI ACCESSORI 

Installazione dell'unità BP automatica Tango M2 

Verificare che i cavi siano corretti 
Collegamento al computer 
Utilizzato per comunicare con il sistema per l'esame da sforzo. Questo collegamento consente al sistema per l'esame da sforzo di 
richiedere a Tango M2 quando è necessaria una misurazione della pressione sanguigna e consente di trasferire la lettura della pressione 
sanguigna di Tango M2 al display e ai referti del sistema per l'esame da sforzo. 
Opzioni di collegamento USB o RS232 disponibili. 
Cavo USB numero parte C-USB-AB3 
Cavo RS232 numero parte RS232-C-FF 
Lato computer Lato Tango M2 
9 pin femmina 9 pin femmina 

    
Figura 17: Lato computer Figura 18: Lato Tango M2 
 
Collegamento attivazione ECG 
Fornisce il segnale ECG dal sistema per l'esame da sforzo a Tango M2 
Cavo di attivazione ECG numero parte C-BNC 

   
Figura 19: Lato ECG da sforzo  Figura 20: Lato Tango M2 
 

Figura 21: Lato posteriore del monitor Tango M2 
 

Collegamento del cavo di collegamento del computer (USB o RS232) 
Per utilizzare il collegamento RS232: 
collegare il cavo RS232-C-FF tra il connettore RS-232 sul pannello posteriore del monitor Tango M2 alla porta COM sul retro del PC 
del sistema per l'esame da sforzo. 
Per utilizzare il collegamento USB: 
collegare il cavo C-USB-AB3 tra il connettore di tipo B USB sul pannello posteriore del monitor Tango M2 e a una porta USB sul 
retro del PC del sistema per l'esame da sforzo. 
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Collegamento del cavo di attivazione ECG 
Da: collegamento ECG esterno BNC sul pannello posteriore di Tango M2. 
A: collegamento BNC sull'adattatore USB-A 1200 dell'ECG da sforzo Norav. 

Configurazione del monitor Tango M2 
1. Quando viene visualizzata la schermata operativa, premere una volta il pulsante SELECT (SELEZIONA). Viene 

visualizzata la schermata del menu principale. 
2. Utilizzando le frecce SU o GIÙ, evidenziare MONITOR SET UP (CONFIGURAZIONE MONITOR) e premere il 

pulsante SELECT (SELEZIONA). 
3. Utilizzando le frecce SU o GIÙ, evidenziare STRESS SYSTEM (SISTEMA DA SFORZO) e premere il pulsante 

SELECT (SELEZIONA). 
4. Utilizzando le frecce SU o GIÙ, evidenziare NORAV e premere il pulsante SELECT (SELEZIONA). 
5. Utilizzando le frecce SU o GIÙ, selezionare EXIT (ESCI) per tornare alla schermata del menu principale. 
6. Utilizzando le frecce SU o GIÙ, selezionare EXIT (ESCI) per tornare alla schermata operativa. 

Configurazione del sistema per l'esame ECG da sforzo Norav 
• Nel software per l'esame ECG da sforzo, accedere a Setup -> Environment (Configurazione -> Ambiente) 
• Aprire la casella di scorrimento della porta automatica BP COM e scegliere la porta di comunicazione del computer alla 

quale è stato collegato il dispositivo Tango M2. 
• Selezionare l'opzione Measure BP by automatic device (Misura BP tramite dispositivo automatico). 
• Fare clic su Advance (Avanzate), selezionare l'opzione R-wave Trigger/Rising (Attivazione/Aumento onde R) sul 

pannello USB. 
• Fare clic su OK per chiudere la finestra di dialogo di configurazione. 
• Per verificare la funzionalità, avviare un nuovo esame da sforzo e, quando si fa clic sull'opzione Measure BP (Misura BP) 

nel menu principale Test (Esame), Tango M2 esegue una misurazione. 
 

Domande frequenti per Tango M2 
D. Tango M2 visualizza un messaggio di stato.  Cosa significa e cosa devo fare?  
R. Per informazioni sul messaggio di stato e sulla soluzione, consultare la guida di configurazione rapida (fornita con il sistema Tango 
M2) o la sezione Risoluzione dei problemi della Guida per l'utente. 
 
D. Il monitor Tango M2 restituisce il risultato 0/0 dopo le misurazioni della pressione sanguigna. Cosa devo fare per 
ottenere una lettura della pressione sanguigna? 
R. Sono presenti alcune condizioni di rumore che non consentono a Tango M2 di misurare accuratamente la PA. In queste situazioni, 
Tango M2 restituisce un valore di 0/0. Il posizionamento del microfono collegato al bracciale è fondamentale per un funzionamento 
affidabile di Tango M2. Per il corretto posizionamento del microfono, seguire le istruzioni riportate nel Cuff Tutorial (Tutorial 
bracciale per la pressione) (disponibile sul sito Web di SunTech Medical in Products-> Tango M2 (Prodotti -> Tango M2)). Seguire 
i punti 1 e 2 delle procedura per eseguire l'esame da sforzo contenuta nella Guida per l'utente per creare le condizioni migliori per 
ottenere una misurazione. 
 
D. Posso utilizzare un simulatore di frequenza cardiaca o pressione sanguigna per verificare se il sistema TangoM2 
funziona correttamente con il mio sistema per l'esame da sforzo? 
R. Non è possibile utilizzare un simulatore di frequenza cardiaca o di pressione sanguigna per verificare se Tango M2 funziona con il 
sistema per l'esame da sforzo. Il monitor Tango M2 richiede che il segnale ECG e i suoni Korotkoff, raccolti dal microfono del 
bracciale, provengano dalla stessa sorgente, ovvero dal paziente. 
 
D. Non riesco a vedere chiaramente il display di Tango M2. Come posso risolvere il problema? 
R. Se non è possibile leggere chiaramente Tango M2, regolare il contrasto del display seguendo questa procedura: 

1. Quando viene visualizzata la schermata operativa, premere il pulsante SELECT (SELEZIONA). Viene visualizzata la 
schermata del menu principale. 

2. Utilizzando le frecce SU o GIÙ, evidenziare MONITOR SET UP (CONFIGURAZIONE MONITOR) e premere il 
pulsante SELECT (SELEZIONA). 

3. Utilizzando le frecce SU o GIÙ, evidenziare BRIGHTNESS (LIMINOSITÀ) e premere il pulsante SELECT 
(SELEZIONA). 

4. Utilizzando le frecce SU o GIÙ, selezionare EXIT (ESCI) per tornare alla schermata del menu principale. 
5. Utilizzando le frecce SU o GIÙ, selezionare EXIT (ESCI) per tornare alla schermata operativa. 
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D. Il mio Tango M2 visualizza il messaggio, "Please VERIFY CALIBRATION" (VERIFICARE CALIBRAZIONE) o 
"Equipment Maintenance and Calibration Required" (Manutenzione e calibrazione del dispositivo richieste). Cosa devo 
fare? 
R. Verificare la calibrazione della pressione. 
Attrezzatura richiesta: 
Manometro elettronico calibrato o uno strumento equivalente. 
Volume di 500 ml o il bracciale Orbit-K Adult Plus avvolti in un oggetto resistente alla rottura (non di vetro). 
Bulbo di gonfiaggio a mano con valvola. 
Tubi, raccordi a T e connettori vari. È possibile ordinare il kit tubi a T (codice SunTech 98-0030-00). 
Procedura: 

1. Quando viene visualizzata la schermata operativa, premere 2 volte il pulsante SELECT (SELEZIONA). Viene visualizzata 
la schermata del menu principale. 

2. Utilizzando le frecce SU o GIÙ, evidenziare MONITOR SET UP (CONFIGURAZIONE MONITOR) e premere il 
pulsante SELECT (SELEZIONA). 

3. Utilizzando le frecce SU o GIÙ, evidenziare l'opzione VERIFY CALIBRATION (VERIFICA CALIBRAZIONE) e 
premere il pulsante SELECT (SELEZIONA). Il monitor chiuderà le valvole e visualizzerà sullo schermo la pressione 
applicata al connettore del tubo del paziente. 

4. Verificare la calibrazione di Tango M2 gonfiando manualmente e controllando il manometro con la lettura della pressione sul 
display Tango M2. 

5. Al termine della calibrazione, utilizzare le frecce SU o GIÙ per selezionare due volte EXIT (ESCI) e tornare alla schermata 
operativa. 
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PREPARAZIONE DEL PAZIENTE 
La qualità dei tracciati ECG dipende molto dalla stabilità e dalla conduttività degli elettrodi durante l'esame, soprattutto durante gli 
esami cardiaci da sforzo, quando i movimenti del paziente possono causare artefatti. Di seguito sono riportate alcune regole di base per 
garantire un buon contatto elettrico: 

◊ Rasare i peli dall'area in cui devono essere applicati gli elettrodi. 

◊ Levigare queste aree con carta o tampone abrasivi. 

◊ Pulire accuratamente l'area degli elettrodi con alcol. 

◊ Lasciare asciugare prima di applicare gli elettrodi. 

Elettrodi ECG 

 
Nota 

È possibile utilizzare diversi elettrodi adesivi per ECG. Poiché gli elettrodi ECG di produttori diversi hanno 
proprietà elettriche diverse, la loro scelta può influire notevolmente sui risultati e sulla qualità della misurazione. 
Assicurarsi di utilizzare solo elettrodi di alta qualità. È consigliato l'utilizzo di elettrodi con gel. Fare sempre 
riferimento allo standard ANSI/AAMI EC12:2000 per i requisiti di sicurezza, prestazioni ed etichettatura per gli 
elettrodi monouso e per le linee guida per garantire un collegamento adeguato al paziente. 

 

ECG A RIPOSO 

 

Figura 22: Schermata principale dell'ECG a riposo 
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Avvio rapido 

Per eseguire un nuovo esame 
1. Collegamento degli elettrodi al paziente 

a. Preparare la cute 
b. Collegare gli elettrodi 

Questa applicazione utilizza i cavi standard a 10 elettrodi con tutti i moduli ECG Norav oppure il cavo opzionale a 14 elettrodi con il 
modulo 1200HR per l'acquisizione dell'ECG a 15/16 derivazioni oppure il cavo opzionale a 5 elettrodi con i moduli NR-1207-E/NR-
1207-3 per l'acquisizione dell'ECG a 12 derivazioni. 

Collegamento con cavo a 10 elettrodi 
Gli elettrodi dei cavi possono presentare l'etichetta AAMI o IEC. 
Il metodo abituale consiste nel posizionare le derivazioni nelle posizioni standard, come illustrato di seguito. 

 
 
Elettrodo Derivazi

one 
Posizionamento degli elettrodi 

AAMI IEC 
RA R RA avambraccio o polso destro 
LA L LA avambraccio o polso sinistro 
LL F LL parte inferiore della gamba sinistra, vicino alla caviglia 
RL N RL parte inferiore della gamba destra, vicino alla caviglia 
V1 C1 V1 4° spazio intercostale, bordo destro dello sterno 
V2 C2 V2 4° spazio intercostale, bordo sinistro dello sterno 
V3 C3 V3 A metà tra V2 e V4 
V4 C4 V4 5° spazio intercostale, linea medioclavicolare 
V5 C5 V5 Linea ascellare anteriore in linea retta con V4 
V6 C6 V6 Linea medio-ascellare in linea retta con V4 e V5 

Figura 23: Posizionamento standard degli elettrodi a 12 derivazioni per un ECG a riposo 
 
Con il metodo di posizionamento delle derivazioni indicato in precedenza, le 12 derivazioni standard sono registrate e visualizzate sullo 
schermo del PC e sui referti stampati: 

• 3 derivazioni bipolari: I, II, III 
• 3 derivazioni aumentate: AVR, aVL, aVF 
• 6 derivazioni unipolari: V1...V6 

 
Inoltre, è possibile posizionare le derivazioni sul paziente in un altro schema di collegamento, ad esempio posteriore (V7-V9), lato 
destro (V3R-V6R) o per uso pediatrico (V7, V3R, V4R). 
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Elettrodo Derivazi
one 

Posizionamento degli elettrodi 
AAMI IEC 
RA R RA avambraccio o polso destro 
LA L LA avambraccio o polso sinistro 
LL F LL parte inferiore della gamba sinistra, vicino alla caviglia 
RL N RL parte inferiore della gamba destra, vicino alla caviglia 
V1 C1 V1 4° spazio intercostale, bordo destro dello sterno 
V2 C2 V2 4° spazio intercostale, bordo sinistro dello sterno 
V3 C3 V3 A metà tra V2 e V4 
V4 C4 V7 linea ascellare posteriore sinistra, allo stesso livello di V6 
V5 C5 V8 sotto la linea medioscapolare sinistra, allo stesso livello di V6 
V6 C6 V9 bordo paraspinale sinistro, allo stesso livello di V6 

Figura 24: Posizionamento posteriore delle derivazioni con cavo a 10 elettrodi 
 
 

 
Elettrodo Derivazi

one 
Posizionamento degli elettrodi 

AAMI IEC 
RA R RA avambraccio o polso destro 
LA L LA avambraccio o polso sinistro 
LL F LL parte inferiore della gamba sinistra, vicino alla caviglia 
RL N RL parte inferiore della gamba destra, vicino alla caviglia 
V1 C1 V1 4° spazio intercostale, bordo destro dello sterno 
V2 C2 V2 4° spazio intercostale, bordo sinistro dello sterno 
V3 C3 V3R a metà tra V1 e V4R, lato destro del torace 
V4 C4 V4R linea medioclavicolare nel quinto spazio intercostale, lato destro del 

torace 
V5 C5 V5R linea ascellare anteriore in linea retta con V4R, lato destro del torace 
V6 C6 V6R linea medioascellare in linea retta con V4R e V5R, lato destro del 

torace 
Figura 25: Posizionamento delle derivazioni sul lato destro con cavo a 10 elettrodi 

 

 
Elettrodo Derivazi

one 
Posizionamento degli elettrodi 

AAMI IEC 
RA R RA avambraccio o polso destro 
LA L LA avambraccio o polso sinistro 
LL F LL parte inferiore della gamba sinistra, vicino alla caviglia 
RL N RL parte inferiore della gamba destra, vicino alla caviglia 
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V1 C1 V7 linea ascellare posteriore sinistra, allo stesso livello di V6 
V2 C2 V3R a metà tra V1 e V4R, lato destro del torace 
V3 C3 V4R linea medioclavicolare nel quinto spazio intercostale, lato destro del 

torace 
V4 C4 V4 5° spazio intercostale, linea medioclavicolare 
V5 C5 V5 Linea ascellare anteriore in linea retta con V4 
V6 C6 V6 Linea medio-ascellare in linea retta con V4 e V5 

Figura 26: Posizionamento delle derivazioni per uso pediatrico con cavo a 10 elettrodi 
 

Collegamento con cavo a 14 elettrodi 
Il cavo a 14 elettrodi contiene 10 elettrodi standard contrassegnati dall'etichetta dello standard AAMI o IEC, più quattro elettrodi 
aggiuntivi contrassegnati con H, M, I ed E. Gli schemi di posizionamento delle derivazioni supportati sono indicati nelle tabelle 
seguenti. 
 
 
 
 
 
 
 
 
 
 
 
 
 
Elettrodo Derivazi

one 
Posizionamento degli elettrodi 

AAMI IEC 
RA R RA avambraccio o polso destro 
LA L LA avambraccio o polso sinistro 
LL F LL parte inferiore della gamba sinistra, vicino alla caviglia 
RL N RL parte inferiore della gamba destra, vicino alla caviglia 
V1 C1 V1 4° spazio intercostale, bordo destro dello sterno 
V2 C2 V2 4° spazio intercostale, bordo sinistro dello sterno 
V3 C3 V3 A metà tra V2 e V4 
V4 C4 V4 5° spazio intercostale, linea medioclavicolare 
V5 C5 V5 Linea ascellare anteriore in linea retta con V4 
V6 C6 V6 Linea medio-ascellare in linea retta con V4 e V5 
H H V9 bordo paraspinale sinistro, allo stesso livello di V6 
M M V4R linea medioclavicolare nel quinto spazio intercostale, lato destro del 

torace 
I I nessuno non collegato 
E E V8 sotto la linea medioscapolare sinistra, allo stesso livello di V6 

Figura 27: Posizionamento standard in presenza di 15 derivazioni con cavo a 14 elettrodi 
 

 
 
Elettrodo Derivazi

one 
Posizionamento degli elettrodi 

AAMI IEC 
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RA R RA avambraccio o polso destro 
LA L LA avambraccio o polso sinistro 
LL F LL parte inferiore della gamba sinistra, vicino alla caviglia 
RL N RL parte inferiore della gamba destra, vicino alla caviglia 
V1 C1 V1 4° spazio intercostale, bordo destro dello sterno 
V2 C2 V2 4° spazio intercostale, bordo sinistro dello sterno 
V3 C3 V3 A metà tra V2 e V4 
V4 C4 V4 5° spazio intercostale, linea medioclavicolare 
V5 C5 V5 Linea ascellare anteriore in linea retta con V4 
V6 C6 V6 Linea medio-ascellare in linea retta con V4 e V5 
H H V3R a metà tra V1 e V4R, lato destro del torace 
M M V4R linea medioclavicolare nel quinto spazio intercostale, lato destro del 

torace 
I I V7 linea ascellare posteriore sinistra, allo stesso livello di V6 
E E V8 sotto la linea medioscapolare sinistra, allo stesso livello di V6 

Figura 28: Posizionamento in caso di 16 derivazioni con cavo a 14 elettrodi con pazienti adulti 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Elettrodo Derivazi

one 
Posizionamento degli elettrodi 

AAMI IEC 
RA R RA avambraccio o polso destro 
LA L LA avambraccio o polso sinistro 
LL F LL parte inferiore della gamba sinistra, vicino alla caviglia 
RL N RL parte inferiore della gamba destra, vicino alla caviglia 
V1 C1 V1 4° spazio intercostale, bordo destro dello sterno 
V2 C2 V2 4° spazio intercostale, bordo sinistro dello sterno 
V3 C3 V3 A metà tra V2 e V4 
V4 C4 V4 5° spazio intercostale, linea medioclavicolare 
V5 C5 V5 Linea ascellare anteriore in linea retta con V4 
V6 C6 V6 Linea medio-ascellare in linea retta con V4 e V5 
H H V9 bordo paraspinale sinistro, allo stesso livello di V6 
M M nessuno non collegato 
I I V7 linea ascellare posteriore sinistra, allo stesso livello di V6 
E E V8 sotto la linea medioscapolare sinistra, allo stesso livello di V6 

Figura 29: Posizionamento posteriore in caso di 15 derivazioni con cavo a 14 elettrodi 
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Elettrodo Derivazi

one 
Posizionamento degli elettrodi 

AAMI IEC 
RA R RA avambraccio o polso destro 
LA L LA avambraccio o polso sinistro 
LL F LL parte inferiore della gamba sinistra, vicino alla caviglia 
RL N RL parte inferiore della gamba destra, vicino alla caviglia 
V1 C1 V1 4° spazio intercostale, bordo destro dello sterno 
V2 C2 V2 4° spazio intercostale, bordo sinistro dello sterno 
V3 C3 V3 A metà tra V2 e V4 
V4 C4 V4 5° spazio intercostale, linea medioclavicolare 
V5 C5 V5 Linea ascellare anteriore in linea retta con V4 
V6 C6 V6 Linea medio-ascellare in linea retta con V4 e V5 
H H V3R a metà tra V1 e V4R, lato destro del torace 
M M V4R linea medioclavicolare nel quinto spazio intercostale, lato destro del 

torace 
I I V7 linea ascellare posteriore sinistra, allo stesso livello di V6 
E E nessuno non collegato 

Figura 30: Posizionamento in caso di 15 derivazioni con cavo a 14 elettrodi con pazienti pediatrici 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Elettrodo Derivazi

one 
Posizionamento degli elettrodi 

AAMI IEC 
RA R RA avambraccio o polso destro 
LA L LA avambraccio o polso sinistro 
LL F LL parte inferiore della gamba sinistra, vicino alla caviglia 
RL N RL parte inferiore della gamba destra, vicino alla caviglia 
V1 C1 V1 4° spazio intercostale, bordo destro dello sterno 
V2 C2 V2 4° spazio intercostale, bordo sinistro dello sterno 
V3 C3 V3 A metà tra V2 e V4 
V4 C4 V4 5° spazio intercostale, linea medioclavicolare 
V5 C5 V5 Linea ascellare anteriore in linea retta con V4 
V6 C6 V6 Linea medio-ascellare in linea retta con V4 e V5 
H H H parte posteriore del collo 
M M M colonna vertebrale 
I I I medio-ascellare a destra 
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E E E sullo sterno 
Figura 31: Posizionamento delle derivazioni di Frank XYZ con cavo a 14 elettrodi 

 

 
 
Elettrodo Derivazi

one 
Posizionamento degli elettrodi 

AAMI IEC 
RA R RA avambraccio o polso destro 
LA L LA avambraccio o polso sinistro 
LL F LL parte inferiore della gamba sinistra, vicino alla caviglia 
RL N RL parte inferiore della gamba destra, vicino alla caviglia 
V1 C1 V1 4° spazio intercostale, bordo destro dello sterno 
V2 C2 V2 4° spazio intercostale, bordo sinistro dello sterno 
V3 C3 V3 A metà tra V2 e V4 
V4 C4 V4 5° spazio intercostale, linea medioclavicolare 
V5 C5 V5 Linea ascellare anteriore in linea retta con V4 
V6 C6 V6 Linea medio-ascellare in linea retta con V4 e V5 
H H Y- sul manubrio 
M M Z- bordo paraspinale sinistro, allo stesso livello di V6 
I I X- 5ª linea intercostale medioascellare destra 
E E X+ 5ª linea intercostale medioascellare sinistra 

Figura 32: Posizionamento delle derivazioni XYZ bipolari con cavo a 14 elettrodi 
 
 

 
Elettrodo Derivazi

one 
Posizionamento degli elettrodi 

AAMI IEC 
RA R RA avambraccio o polso destro 
LA L LA avambraccio o polso sinistro 
LL F LL parte inferiore della gamba sinistra, vicino alla caviglia 
RL N RL parte inferiore della gamba destra, vicino alla caviglia 
V1 C1 V1 4° spazio intercostale, bordo destro dello sterno 
V2 C2 V2 4° spazio intercostale, bordo sinistro dello sterno 
V3 C3 V3 A metà tra V2 e V4 
V4 C4 V4 5° spazio intercostale, linea medioclavicolare 
V5 C5 V5 Linea ascellare anteriore in linea retta con V4 
V6 C6 V6 Linea medio-ascellare in linea retta con V4 e V5 
H H nessuno non collegato 
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M M nessuno non collegato 
I I Nax sito di proiezione dell'apice cardiaco sulla linea ascellare sinistra 
E E Nst base sternale destra della seconda costola 

Figura 33: Posizionamento delle derivazioni Nehb con cavo a 14 elettrodi 
 

Collegamento con cavo a 5 elettrodi 
Utilizzato per l'acquisizione dell'ECG derivato a 12 derivazioni. Il cavo contiene 5 elettrodi contrassegnati dalle etichette AAMI o IEC. 
Lo schema di posizionamento delle derivazioni è riportato nella tabella seguente. 

 
Elettrodo Posizionamento degli elettrodi 
AAMI IEC 
RA R nel medio-ascellare destro 
LA L nel medio-ascellare sinistro 
LL F sul manubrio dello sterno 
RL N sul bordo inferiore destro della gabbia toracica 
V C all'altezza del quinto dello sterno inferiore 

Figura 34: Posizionamento delle derivazioni in caso di ECG derivato a 12 derivazioni con cavo a 5 elettrodi 
 

 
Nota 

Derivati dagli ECG a 12 derivazioni con cavo a 5 elettrodi e le relative misurazioni sono approssimazioni degli 
ECG a 12 derivazioni convenzionali e non devono essere utilizzati per interpretazioni diagnostiche. 

 
 

1. Avvio di un nuovo esame 

Eseguire l'applicazione per l'esame ECG a riposo. Aprire il pannello dei dettagli del paziente facendo clic sull'icona  
nella barra degli strumenti superiore o premendo il tasto F1 della tastiera. 
Inserire i dettagli del paziente, quindi fare clic sul pulsante OK o premere il tasto Invio sulla tastiera. 

2. Verifica della qualità del collegamento degli elettrodi applicati 

Fare clic sul pulsante  per visualizzare l'immagine schematica del tronco che consente di verificare la 
qualità del collegamento degli elettrodi applicati e lo stato delle derivazioni staccate. 

3. Acquisizione di un ECG 
Verificare che tutti i tracciati ECG siano stati acquisiti e siano visualizzati correttamente sullo schermo. 

Bloccare l'ECG facendo clic sul pulsante  (dopo almeno 10 secondi) o premendo il tasto F2 della tastiera. 
4. Creazione di un referto 

Per scrivere il referto: aprire il pannello del menu principale Remarks (Annotazioni). 

Per stampare il referto: fare clic sul pulsante  o premere il tasto F6 della tastiera. Per un esempio di 
referto stampato, vedere l'Appendice C. 

Funzionamento con tasti funzione e tasti di scelta rapida 
F1 Nuova registrazione 

F2 Avvia/Arresta ECG 

F3 Acquisisci un ECG di 10 secondi 
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F6 Stampa 

F11 Apri l'elenco degli esami salvati 

Ctrl "+" / Ctrl "-" 
Oppure Ctrl e rotellina del mouse 

Zoom avanti/Zoom indietro dei tracciati ECG 

Ctrl "0" o fare doppio clic con il 
tasto destro del mouse sui tracciati 

ECG 

Reimposta zoom 

Tabella 8: Utilizzo dei tasti funzione 
 

 
Nota 

Prima di utilizzare l'applicazione per l'esame ECG a riposo, definire i parametri preferiti in Setup 
(Configurazione). In caso contrario, il programma funzionerà in base alle impostazioni di fabbrica. 

 

Barre degli strumenti e pannelli 

Panoramica della barra degli strumenti 
 

 
Per questa azione 

Fare clic su 
questa icona 

Oppure 
utilizzare 

questo tasto 
di scelta 
rapida 

Oppure 
selezionare 

questo menu 

 
Descrizione 

 
Avviare/Interrom
pere la 
registrazione 
ECG 

 
 

 

 
F2 

  
Consente di avviare/interrompere l'acquisizione 
ECG 

Informazioni sul 
paziente  

 
F1 

  
Consente di visualizzare le informazioni del 
paziente. 

Stampare la 
pagina dell'ECG 

 

 

F6  Consente di stampare l'ECG a 12 derivazioni 

Salvare il ritmo 
ECG 

 

 

  Consente di memorizzare il ritmo dell'ECG su 
base continua 

Immettere la 
pressione 
sanguigna 

 
 

  Comando di immissione per immettere i valori 
della pressione sanguigna 

Diagnosi/Annota
zioni   

  Consente di accedere alla diagnosi e alle 
annotazioni dell'ECG 

Configurazione e 
filtri 

 

  Consente di regolare il layout dello schermo, i filtri 
ECG e la configurazione del sistema 

Informazioni sul 
programma  

  Consente di visualizzare la versione del software, le 
informazioni sulla licenza e i dettagli di contatto 
Norav 

 
Controllare le 
derivazioni 

 

 

  Consente di visualizzare l'immagine schematica del 
tronco per verificare la qualità del collegamento 
degli elettrodi applicati e lo stato di derivazioni 
staccate. 

 
 
Sistema 
derivazioni  

   
 
Definisce il posizionamento degli elettrodi sul 
paziente. 

Archivio dati 

 

  Consente di aprire un esame esistente dalla cartella 
locale o dal database NEMS. 
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Uscire 
dall'applicazione  

  Termina la sessione ECG, salva i dati ed esce dal 
programma per l'esame ECG a riposo 

Tabella 9: Comandi della barra degli strumenti per l'ECG a riposo 
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Pannello di visualizzazione della schermata ECG e filtri 

Il pannello di visualizzazione della schermata si apre facendo clic sul pulsante . 

 
 

Figura 35: Pannello di visualizzazione dell'ECG a riposo e filtri 

Pannello delle informazioni sul paziente 

Per immettere i dettagli del paziente, aprire il pannello delle informazioni sul paziente facendo clic sull'icona . 
 

 
Figura 36: Pannello delle informazioni del paziente nell'ECG a riposo 
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Configurazione del sistema ECG a riposo 

Per accedere alla configurazione del sistema, fare clic sul pulsante  su una barra degli strumenti principale, quindi fare clic su 
Scheda Opzione Descrizione 

 
 
 
 
 
 
Leads 
(Derivazioni) 

Lead Systems (Sistemi di 
derivazioni) 

Definire il sistema di derivazioni da utilizzare in base al cavo del paziente e allo 
schema di posizionamento degli elettrodi. 

Default 3 leads (3 
derivazioni predefinite) 

Definire le 3 derivazioni da visualizzare come predefinite quando si utilizza il 
formato di visualizzazione 3x1. 

Default 6 leads (6 
derivazioni predefinite) 

Definire le 6 derivazioni da visualizzare come predefinite quando si utilizza il 
formato di visualizzazione 6x1. 

Strip Lead (Derivazione 
del tracciato) 

La derivazione da 10 sec viene visualizzata nei formati di visualizzazione 4x3, 
4x4, 3x5, 6x2, 6+9 e 6+10. 
Nota: la derivazione del tracciato può essere definita in modo diverso per ciascun sistema di 
derivazioni. 

15 Leads (15 derivazioni) Definire le opzioni di posizionamento delle 15 derivazioni, con il cavo ECG a 
14 elettrodi (solo nei modelli 1500HR). 

Derived 12 Lead 
5-electrode Placement 
(Posiz. 5 elettrodi 12 
derivazioni der.) 

Definire la modalità opzionale "Derived 12 Lead" (12 derivazioni der.) per i 
dispositivi NR-1207-E e NR-1207-3 con cavo ECG a 5 elettrodi. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
ECG 
Recording 
(Registrazione 
ECG) 

Filter 50/60Hz (Filtro 
50/60 Hz) 

Impostazione predefinita: opzione deselezionata. Se questa opzione è 
selezionata, lo stato predefinito del filtro 50/60 Hz è attivo (in base alla 
frequenza controllata 50 o 60). 

 
EMG Filter (Filtro 
EMG) 

Impostazione predefinita: opzione deselezionata. Se l'opzione è selezionata, lo 
stato predefinito del filtro EMG è attivo. L'utente può anche selezionare la 
frequenza limite necessaria per il filtro EMG: 20 Hz, 35 Hz, 40 Hz o 100 Hz. 
Valore predefinito: 35 Hz. 

Baseline Filter (Filtro 
linea di base) 

Impostazione predefinita: opzione deselezionata. Se l'opzione è selezionata, lo 
stato del filtro della linea di base è attivo. 

 
Save options (Salva 
opzioni) 

Se è attiva l'opzione Auto Save (Salvataggio auto), il salvataggio automatico è 
attivo, il file di registrazione viene memorizzato in base alle convenzioni di 
denominazione selezionate nel riquadro Set File Name by (Imposta nome 
file per). 
Se l'opzione Auto Save (Salvataggio auto) è invece disattivata, il salvataggio 
automatico è disattivato, l'utente richiede di immettere un nome file. 

Auto stop after 10 sec 
(Arresto auto dopo 10 
secondi) 

Se l'opzione è deselezionata (impostazione predefinita), la registrazione viene 
eseguita fino a quando non viene interrotta dall'utente. 
Se questa opzione è selezionata, la registrazione viene interrotta 
automaticamente dopo 10 secondi. 

 
Auto Print (Stampa auto) 

Utilizzare questa opzione per la stampa automatica dell'ECG a 12 derivazioni al 
termine dell'esame. Se nella rete sono definite più stampanti, selezionare quella 
appropriata dall'elenco. 

 
Simulator ECG (ECG 
simulatore) 

Se l'opzione è deselezionata (impostazione predefinita), la registrazione ECG è 
eseguita dall'unità PC-ECG. 
Se invece è selezionata, la registrazione ECG è eseguita dal file demo incluso nel 
pacchetto software. In questo caso, l'unità di registrazione non è necessaria. 

Longest ECG recording 
time (Tempo 
registrazione ECG più 
lungo) 

Impostare il limite massimo per il tempo di registrazione ECG in modalità 
Rhythm (Ritmo). 

Minimum Test Time 
(Durata minima esame) 

Impostare la durata minima di qualsiasi esame (in secondi). Durante questo 
periodo di tempo, il pulsante Stop (Arresta) 
(F2) sarà disabilitato e l'esame non può essere interrotto. 

Data Directory 
(Directory dati) 

Consente all'utente di definire una directory per le registrazioni ECG salvate (se 
il database ECG) 
non è utilizzato). Utilizzare un disco rigido secondario, se disponibile. 
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Use ECG Database (Usa 
database ECG) 

Selezionare questa opzione per connettersi al database ECG opzionale (NEMS). 

 
Backup Data directory in 
AutoSave mode 
(Directory dati di backup 
in modalità salvataggio 
auto) 

Quando si seleziona l'opzione di salvataggio automatico, l'utente può definire un 
percorso locale per una directory di backup. La directory di backup è utile 
quando la directory dei dati o il database non si trova sullo stesso computer. In 
tal caso, potrebbe non essere possibile salvare il file ECG a causa di un errore di 
connessione. 

Validate Patient data 
(Convalida dati paziente) 

I dati paziente obbligatori devono essere immessi all'inizio del nuovo esame. 

Input Range (0-9) 
(Intervallo input (0-9)) 

Consente di immettere solo valori numerici nel campo dell'ID paziente. 
Impostazione predefinita: opzione deselezionata. 

 
Prevent Multi Instance 
session (Impedisci 
sessione multi-istanza) 

Protegge dall'acquisizione simultanea di dispositivi ECG da diverse sessioni di 
accesso sullo stesso computer. Selezionare questa opzione quando PC ECG è 
installato sul computer di un'organizzazione in cui è abilitata la funzione di 
accesso Switch User (Cambia utente). Impostazione predefinita: opzione 
deselezionata. 

 Sample Rate 
(Frequenza di 
campionamento) 

Consente all'utente di scegliere la velocità di campionamento dell'acquisizione 
ECG. 

Auto Start Acquisition 
(Acquisizione avvio 
auto) 

Se questa opzione è selezionata, l'acquisizione dell'ECG si avvia 
automaticamente quando viene eseguito il programma ECG a riposo. 
L'impostazione predefinita è selezionata. 

 
 
 
 
 
 
 

 
Diagnosis 
(Diagnosi) 

 Alcune funzioni sono opzionali, attive solo se l'opzione (I1/I3) è installata. 

ST after J (ST dopo J) Definisce il punto ST relativo al punto J. 

 
Default "Confirm 
Diagnosis" status (Stato 
"Conferma diagnosi" 
predefinito) 

Si riferisce allo stato della casella di controllo Confirm Diagnosis 
(Conferma diagnosi) nella finestra di dialogo Remarks (Annotazioni) 
delle interpretazioni Se l'opzione è selezionata, il valore predefinito della 
casella di controllo nella finestra di dialogo Remarks (Annotazioni) sarà 
selezionato. Se non è selezionata, la casella di controllo nella finestra di 
dialogo sarà deselezionata. 

Print Options (Opzioni 
di stampa) 

Consente di definire se le misurazioni e/o le interpretazioni devono essere 
aggiunte alle stampe e al file XML FDA. Le opzioni sono Never (Mai), After 
Confirmation (Dopo la conferma), o Always (Sempre). 

Display Options 
(Opzioni di 
visualizzazione) 

Consente di definire se le misurazioni e/o le interpretazioni devono essere 
visualizzate sul display.  

Enable the ECG 
Measurements tool 
(Abilita strumento 
misurazioni ECG) 

Se l'opzione è selezionata, l'utente può aprire lo strumento delle misurazioni 
ECG facendo clic sull'area delle misurazioni nella barra degli strumenti 
superiore. 

 
QTc Calculation 
(Calcolo QTc) 

Consente di selezionare le formule utilizzate per il calcolo dell'intervallo QT 
corretto. Opzioni disponibili: Bazett, Fridericia, Framingham, Hodges. 
Impostazione predefinita: metodo 1 Bazett, metodo  2 “none (nessuno)” 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Draw over lead 
borders 
(Traccia sui 
bordi delle 
derivazioni) 

Se l'opzione è selezionata (impostazione predefinita), non limita il superamento 
dei bordi degli impulsi ECG di ampiezza estremamente alta. Se l'opzione è 
deselezionata, gli impulsi vengono scalati ai bordi. 

View calibration pulse 
1 mV (Visualizza 
impulso di 
calibrazione 1 mV) 

Se l'opzione è deselezionata (impostazione predefinita), l'impulso da 1 mV 
viene visualizzato solo durante la stampa. Se l'opzione è selezionata, sullo 
schermo è visualizzato anche l'impulso da 1 mV. 

 
Leads Base line shift 
(Spostamento linea 
base derivazioni) 

Se l'opzione è deselezionata (impostazione predefinita), la linea di base di 
ciascuna derivazione si trova esattamente al centro dell'area della derivazione. 
Se l'opzione è selezionata, a ciascuna derivazione viene aggiunto uno 
spostamento speciale per visualizzarne il massimo. Ad esempio: la derivazione 
V6, essendo a impulsi positivi, ottiene uno spostamento negativo. 

Separate Leads 
(Derivazioni separate) 

Se l'opzione è selezionata, le derivazioni vengono visualizzate con un 
fotogramma e sono separate l' una dall'altra. 
Se l'opzione è deselezionata, le derivazioni non vengono separate. 
L'impostazione predefinita è selezionata. 
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View 
(Visualizza) Draw Grid (Disegna 

griglia) 

Se l'opzione è selezionata, visualizza le linee della griglia quando l'applicazione 
è aperta. 
Se l'opzione è deselezionata, l'applicazione viene aperta senza linee della griglia. 
L'impostazione predefinita è selezionata. 

1 mm Se l'opzione è selezionata, la griglia sullo schermo viene visualizzata con una 
dimensione delle celle di 1 mm. Quando invece non è 
selezionata, la dimensione delle celle della griglia è di 5 mm. È selezionata 
come impostazione predefinita. 

Open in Tile mode 
(Apri in modalità 
Affianca) 

Selezionare la modalità Tile (Affianca) per impostare la modalità (orizzontale o 
verticale) di visualizzazione di 2 o più 
esami aperti. 

Horizontal Scale (Scala 
orizzontale) 

Imposta il valore predefinito per la finestra della scala orizzontale sullo 
schermo (mm/sec). 

Vertical Scale (Scala 
verticale) 

Imposta il valore predefinito per la finestra della scala verticale sullo schermo 
(mm/mV). 

 
Draw Pacer (Disegna 
pacemaker) 

Se l'opzione è abilitata, un contrassegno artificiale (linea verticale tratteggiata) 
sostituisce il picco del pacemaker rilevato sul tracciato ECG sullo schermo e 
sulla stampa. 
Se l'opzione non è abilitata (impostazione predefinita), il picco del 
pacemaker viene visualizzato così com'è. Nota: questo contrassegno 
artificiale è relativo al tempo, ma non è rappresentativo dell'ampiezza, della 
polarità o della larghezza reali dell'impulso del pacemaker. 

Color selection 
(Selezione colore) 

Consente all'utente di scegliere i colori dello schermo per l'applicazione ECG a 
riposo per sfondo, tracciati, griglia e testo. 

Restore Defaults 
(Ripristina impostazioni 
predefinite) 

Se l'opzione è attivata, ripristina i colori predefiniti di fabbrica. 

 
Default ECG View 
(Visualizzazione ECG 
predefinita) 

Selezionare la visualizzazione predefinita delle derivazioni sullo schermo 
dall'elenco nella casella combinata. Per questo parametro sono disponibili 
due impostazioni di configurazione. La prima è per la modalità di 
registrazione a 12 derivazioni e l'altra (disponibile solo per il modello 
1200HR) è per la modalità di registrazione estesa a 15 derivazioni/16 
derivazioni. 

Smooth ECG Trace 
(Tracciato ECG 
uniforme) 

Selezionare questa opzione per visualizzare sullo schermo un tracciato ECG 
uniforme. 

 
Close previous ECG 
(Chiudi ECG 
precedente) 

Consente di chiudere il record dell'ECG aperto all'avvio di un nuovo esame. 
Se questa opzione è deselezionata, tutte le registrazioni ECG riviste o create 
rimangono aperte in background fino all'uscita dal programma. L'opzione è 
attivata per impostazione predefinita. 

 
Show the worklist 
(Mostra worklist) 

Se l'opzione è abilitata, all'avvio di un nuovo esame, il pannello Worklist viene 
visualizzato più in alto rispetto al pannello dei dettagli paziente. 

Calculate Body 
Surface Area 
(Calcola area 
superficie 
corporea) 

Impostazione predefinita: opzione disabilitata. Visualizza l'area della 
superficie corporea stimata del paziente sullo schermo e nella stampa. 
Selezionare una di queste cinque formule: Mosteller(impostazione 
predefinita), DuBois, Haycock, Gehan, Boyd. 

Show Rhythm (Mostra 
ritmo) 

Consente di mostrare/nascondere il pulsante Rhythm (Ritmo). Impostazione 
predefinita: opzione selezionata. 

 

 
Default Zoom (Zoom 
predefinito) 

Definisce la scala di zoom predefinita dei tracciati ECG sullo schermo. 
In tempo reale la scala di zoom può essere modificata con i tasti di 
scelta rapida Ctrl "+" (Ingrandisci) Ctrl "-" (Riduci) o utilizzando la 
rotellina del mouse insieme al tasto Ctrl della tastiera. Per ripristinare 
lo zoom al 100%, utilizzare il tasto di scelta rapida Ctrl "0" o fare 
doppio clic con il pulsante destro del mouse in qualsiasi punto dei 
tracciati ECG. Per disattivare la scala di zoom, selezionare il pulsante <-
none-> (<-nessuno->) e utilizzare lo zoom predefinito. 

 
Screen Mode (Modalità 
schermo) 

Consente di cambiare la visualizzazione dello schermo dalla modalità PC-
ECG normale (impostazione predefinita) alla vista Transport Monitor 
(Monitor trasporto), mostrando parametri aggiuntivi quali SpO2, frequenza 
respiratoria, temperatura corporea e livello di EtCO2. 

 
 
 

 Consente di salvare il nome, l'indirizzo, il logotipo e il nome della workstation 
(modalità). Questi dati sono visualizzati sulla stampa e sul referto in formato 
PDF. 
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Installation 
(Installazione) 

Supervising Physician 
(Medico supervisore) 

Aggiungere/Modificare il nome, la password e il timbro della firma personale 
di un medico responsabile. Selezionare dall'elenco e impostare come medico 
curante predefinito. 

Technician (Tecnico) Consente di aggiungere/modificare il nome di un tecnico nell'elenco. 
Selezionare dall'elenco e impostare come tecnico predefinito. 

Referring Physician 
(Medico curante) 

Consente di aggiungere/modificare il nome del medico curante nell'elenco. 

Measurement 
Standard 
(Standard di 
misurazione) 

Consente di definire se le misurazioni verranno calcolate in base al sistema 
metrico o allo standard USA. Impostazione predefinita: sistema metrico. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
Environment 
(Ambiente) 

ECG Device 
Connection 
(Collegamento del 
dispositivo ECG) 

Consente di scegliere la porta per l'interfaccia con il dispositivo ECG. Opzioni 
disponibili: 
COM Port (Porta COM), USB (impostazione predefinita) e Bluetooth. 

 
Display Size 
(Dimensioni del 
display) 

Questa impostazione è necessaria per visualizzare l'ECG e la griglia nella scala 
corretta. L'utente può definire manualmente le dimensioni del display del PC o 
selezionare l'opzione Auto detect (Rilevamento auto) per rilevare 
automaticamente le dimensioni del display del PC. 

Graph paper (Carta per 
grafici) 

Se l'opzione è abilitata, stampa i quadrati da 1 mm e 5 mm sulle stampe. 
L'opzione Regular Grid (Griglia standard) è garantita per qualsiasi 
stampante. 
L'opzione Improved Grid (Griglia migliorata) mostra una griglia sottile ma 
potrebbe non funzionare su alcune stampanti. 

Paper Size (Formato 
carta) 

Consente di scegliere la stampante tradizionale A4/Letter o la stampante 
termica da 4 pollici. 

Use large fonts for 
remarks (Caratteri 
grandi per annotazioni) 

Abilita i caratteri di grandi dimensioni per il testo libero immesso dall'utente. 

Color Printout (Stampa 
a colori) 

Selezionare questa opzione per avere stampe a colori. 

Shadow/Frame For 
Area of Interest 
(Ombra/Cornice 
per l'area di 
interesse) 

Consente di scegliere tra ombra e cornice per evidenziare l'area di 
interesse. 

 
 
 

 
Leads Print (Stampa 
derivazioni) 

Simultaneous (Simultanei) (impostazione predefinita): stampa i segmenti 
simultanei dei dati ECG per ciascuna derivazione sincronizzata con punto 
temporale del fotogramma su un tracciato inferiore completo di 10 secondi. 
L'aggettivo "simultanei" si riferisce al fatto che i dati presentati per ogni 
derivazione sono stati acquisiti esattamente nello stesso momento. 
Successive (Successivi) Il referto mostra un campione sequenziale di dati 
ECG da ciascuno dei 12 canali. Ogni canale successivo ha la zona temporale 
successiva dei dati ECG per un totale di 10 secondi di dati. L'inizio di ciascun 
canale è contrassegnato da una linea verticale e dall'identificatore del canale 
con le lettere in grassetto. Il tracciato inferiore sul grafico presenta dieci 
secondi di dati. Inoltre, funge da indicatore di data e ora per l'intero referto. 
Ogni complesso QRS in questo tracciato è lo stesso presente negli altri 
tracciati visualizzati in alto. 

Print Scale Format 
and Print Page 
Format (Formato 
scala stampa e 
formato pagina 
stampa) 

Consente di configurare la visualizzazione della pagina per i referti ECG. Può 
essere impostato sullo stesso layout visualizzato sulla schermata del software 
ECG con velocità, ampiezza e set di derivazioni definiti in modo statico. 

 
 

Default Reports 
(Referti predefiniti) 

Selettore referti finali. Opzioni disponibili: 
- ECG Traces (Tracciati ECG) (stampa ECG a 12 derivazioni standard). 
- Measurements and Vector Loop (Misurazioni e loop vettoriale) 

(referto completo che include la matrice delle misurazioni per tutti e 12 i 
canali e i cerchi del loop vettoriale). 

- Tabular Summary (Riepilogo tabellare) (solo per i record acquisiti in 
modalità Transport Monitor (Monitor trasporto)). 

 
Enable real-time print 
(Abilita stampa in 
tempo reale) 

Consente di mostrare/nascondere il pulsante Rhythm (Ritmo) per la 
registrazione continua del tracciato ECG per la durata massima definita dal 
parametro Longest ECG Recording time (Tempo di registrazione ECG più 
lungo) della scheda ECG Recording setup (Configurazione registrazione 
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ECG). 

Check NET Key 
(Controlla chiave NET) 

Selezionare questa opzione se la licenza software è installata in rete 
(NetHASP). 

 
BP Device (Dispositivo 
BP) 

Consente di configurare l'interfaccia con il monitoraggio automatico della 
pressione sanguigna opzionale (SunTech "Aura"). Applicabile solo ai 
registratori NR-1207-3 con il modulo hardware appropriato all'interno. 

 
 
 

 
Picture 
Format 
(Forma
to 
immagi
ne) 

AutoSave ECG in 
Picture Format 
(Salvataggio auto ECG 
in formato immagine) 

Selezionare l'opzione per salvare automaticamente l'esame come immagine 
JPEG. 

Set File Name By 
(Imposta nome file per) 

Consente di denominare i file in modo da includere il cognome o l'ID 
paziente. Controllare la data e/o l'ora per includerle nel nome del file. 

Picture Format 
(Formato immagine) 

Consente di selezionare la risoluzione dell'immagine (normale o alta 
risoluzione). 

Picture File Type (Tipo 
file immagine) 

Selezionare l'opzione JPG/TIF/Both (JPG/TIF/Entrambi) come tipo di file 
per l'immagine. 

Pictures Directory 
(Directory immagini) 

Consente di impostare la directory delle immagini salvate. Il percorso 
predefinito è C:\ProgramData\NoravMedical\PCECG\Data\ 
(C:\Programmi\NoravMedical\PCECG\Dati\). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
External 
Interface 
(Interfaccia 
esterna) 

GDT/BDT Format 
(Formato GDT/BDT) 

Consente di configurare l'interfaccia GDT/BDT. 

Save test in 
GDT/BDT (Salva 
esame in 
GDT/BDT) 

Se l'opzione è selezionata, l'esame viene salvato automaticamente nel formato 
GDT/BDT. 

Import from 
GDT/BDT 
(Importa da 
GDT/BDT) 

Se l'opzione è selezionata, il sistema importa automaticamente gli esami nel 
formato GDT/BDT. 

File Format 
(Formato file) 

Consente di selezionare il formato del file: GDT o BDT. 

Import/Export 
Codepage 437 
(Importa/Esporta 
Codepage 437) 

Selezionare l'opzione per importare/esportare Codepage 437. 

Edit Labels 
(Modifica etichette) 

Fare clic su questo pulsante per aprire una finestra di dialogo con un elenco 
modificabile delle etichette dei campi utilizzato nei file GDT e BDT. 

GDT/BDT Data 
Directory 
(Directory dati 
GDT/BDT) 

Specifica il percorso della directory in cui conservare i file GDT/BDT. 

Token for PCECG 
(Token per PCECG) 

Valore predefinito: PEKG. 

Token for Practice 
EDP (Token per 
Practice EDP) 

Valore predefinito: EDV1. 

Validate Mandatory 
Entries (Convalida 
voci obbligatorie) 

Impostazione predefinita: opzione deselezionata. 
Se l'opzione è selezionata, il programma convalida il comando GDT in 
ingresso per i dati esistenti nelle voci contrassegnate come obbligatorie nella 
scheda ECG Recording (Registrazione ECG). 

Notifications 
(Notifiche) 

Consente di configurare il protocollo di notifica con il software esterno. 

Disabled 
(Disabilitato) 

No notifications (Nessuna notifica) 

Infocom Abilita l'interfaccia di notifica del socket TCP con il sistema Infocom. 

IP Address (Indirizzo 
IP) 

L'indirizzo IP di rete del sistema Infocom di destinazione. 

Port (Porta) Numero di porta TCP del sistema Infocom di destinazione. 
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ENWA Abilita l'interfaccia di notifica dello scambio file con il sistema ENWA. 

Command Directory 
(Directory dei 
comandi) 

Impostare la directory di scambio per le notifiche e i file dei comandi per la 
comunicazione del sistema ENWA. 

Start Filename (Nome 
file avvio) 

Specifica il nome file per la notifica START CAPTURE (AVVIA 
ACQUISIZIONE) 

 Stop Filename (Nome 
file arresto) 

Specifica il nome file per la notifica STOP CAPTURE (ARRESTA 
ACQUISIZIONE) 

Event Filename (Nome 
file evento) 

Specifica il nome file del comando in ingresso  USER EVENT (EVENTO 
UTENTE) 

 
 
 
 

 
TXT/CSV 

Auto Save test Data in 
Text/CSV file 
(Salvataggio auto dati 
esame in file di 
TXT/CSV) 

Selezionare l'opzione per salvare automaticamente i dati dell'esame in un file 
di testo/CSV alla fine dell'esame a riposo. 

Set Text file Name by 
(Imposta nome file di 
testo per) 

Impostare il nome del file di testo/CSV in base al nome del file dell'esame o ai 
campi Patient ID (ID paziente) e/o Patient Last Name (Cognome paziente). 

Text/CSV File Data 
Directory (Directory 
dati file TXT/CSV) 

Impostare il percorso della directory per mantenere i file di testo/CSV con dati 
ECG. 
La posizione predefinita è C:\ProgramData\NoravMedical\PCECG\Data\ 
(C:\Programmi\NoravMedical\PCECG\Dati\). 

Values (Valori) 
Consente di definire i valori dei dati nel file CSV: Events only (Solo eventi), Every 1 
minute (Ogni minuto) o All (Tutti)). Questa opzione è pertinente solo per la 
modalità di visualizzazione Transport Monitor (Minitor trasporto). 

Conversion TOOL 
(Strumenti di 
conversione) 

Impostazioni di configurazione per la modalità quando l'applicazione viene 
utilizzata per convertire i file di dati ECG RAW in formato Excel, TXT o 
XML. 

 
 
 
 
 
 
 

 
FDA XML \ 
SCP\Mckess
on  \MFER\ 
Raw Data 
format 
(Formato 
FDA 
XML\SCP\M
ckesson\MFE
R\Dati non 
elaborati) 

FDA XML format 
(Formato FDA XML) 

Impostare le opzioni di salvataggio XML FDA, l'ID principale e la directory. 

Auto Save in FDA 
XML format 
(Salvataggio auto in 
formato FDA XML) 

Selezionare l'opzione per salvare automaticamente i dati dell'esame in un file 
FDA/XML alla fine dell'esame a riposo. 

 
Annotations for leads 
(Annotazioni per 
derivazioni) 

Selezionare questa opzione per impostare le annotazioni per le derivazioni. 
Selezionare le derivazioni da annotare. Se l'opzione non è selezionata, le 
derivazioni sono disabilitate e non verrà salvata alcuna annotazione nel file 
XML FDA. 

File Data directory 
(Directory dati file) 

Impostare il percorso della directory per mantenere i file FDA XML con i dati 
dell'ECG. La posizione predefinita è 
C:\ProgramData\NoravMedical\PCECG\Data\ 
(C:\Programmi\NoravMedical\PCECG\Dati\). 

Parameters (Parametri) Inserire la radice ID per il file XML FDA. 

SCP format (Formato 
SCP) 

Impostare l'opzione di salvataggio automatico per il formato SCP e la directory 
dei file SCP. La posizione predefinita è 
C:\ProgramData\NoravMedical\PCECG\Data\ 
(C:\Programmi\NoravMedical\PCECG\Dati\). 

Mckesson format 
(Formato McKesson) 

Impostare l'opzione di salvataggio automatico per il formato McKesson e la 
directory dei file McKesson. La posizione predefinita è 
C:\ProgramData\NoravMedical\PCECG\Data\ 
(C:\Programmi\NoravMedical\PCECG\Dati\). 

MFER format 
(Formato MFER) 

Impostare l'opzione di salvataggio automatico per il formato MFER e la 
directory dei file MFER. La posizione predefinita è 
C:\ProgramData\NoravMedical\PCECG\Data\ 
(C:\Programmi\NoravMedical\PCECG\Dati\). 

Raw Data format 
(Formato dati non 
elaborati) 

Impostare l'opzione di salvataggio automatico per il formato dei dati non 
elaborati e la directory dei file di dati non elaborati. La posizione predefinita è 
C:\ProgramData\NoravMedical\PCECG\Data\ 
(C:\Programmi\NoravMedical\PCECG\Dati\). 

 
 
 
 

Auto Save test Data in 
PDF format 
(Salvataggio auto dati 
esame in formato 

Selezionare l'opzione per salvare automaticamente i dati dell'esame come file 
PDF alla fine dell'esame a riposo. 
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PDF/HL7 
File/DICOM 
ECG (File 
PDF/HL7/DIC
OM ECG) 

PDF). 

Open PDF after 
recording (Apri PDF 
dopo la registrazione) 

Consente di visualizzare automaticamente sullo schermo i file PDF creati (è 
necessario un software di visualizzazione dei PDF esterno). 

Set PDF file name by 
(Imposta il nome del 
file PDF per) 

Consente di impostare il nome del file PDF in base al nome del file 
dell'esame o al campo selezionato. 

PDF File Data 
Directory (Directory 
dati file PDF) 

Consente di impostare il percorso della directory per mantenere i file dei referti 
PDF. La posizione predefinita è 
C:\ProgramData\NoravMedical\PCECG\PDF\ 
(C:\Programmi\NoravMedical\PCECG\PDF\). 

Auto Save test Data in 
HL7 format 
(Salvataggio auto dati 
esame in formato HL7) 

Selezionare questa opzione per salvare automaticamente i dati del referto 
dell'esame come file HL7 alla fine dell'esame a riposo. 

With PDF report 
included (Con referto 
PDF incluso) 

Selezionare questa opzione per includere il referto PDF come immagine 
codificata Base64 nel file HL7. 

Configuration 
(Configurazione) 

Impostare i valori predefiniti per i campi configurabili del file del referto HL7. 

HL7 File Data 
Directory (Directory 
dati file HL7) 

Impostare il percorso della directory per mantenere i file dei referti HL7. La 
posizione predefinita è C:\ProgramData\NoravMedical\PCECG\HL7\ 
(C:\Programmi\NoravMedical\PCECG\HL7\). 

Set HL7 filename by 
(Imposta nome file 
HL7 per) 

Consente di definire il formato del nome del file HL7 in base al nome del file 
del record ECG o formattato in base al numero d'ordine+informazioni di data 
e ora. 

Auto Save test Data in 
DICOM ECG 
(Salvataggio auto dati 
esame in formato 
DICOM ECG) 

Consente di generare il file del formato della forma d'onda (*DCM) ECG a 12 
derivazioni DICOM. 

Scheda Opzione Descrizione 

 Auto Save test Data in 
DICOM Encapsulated 
PDF (Salvataggio auto 
dati esame in formato 
PDF DICOM 
incapsulato) 

 
Consente di generare il file del referto PDF incapsulato DICOM (*DCM). 

Auto Save test Data in 
DICOM Secondary 
Capture Image 
(Salvataggio auto dati 
esame nell'immagine di 
acquisizione secondaria 
DICOM) 

 
Consente di generare il file del referto dell'immagine di acquisizione secondaria 
DICOM (*.DCM). 

DICOM File Data 
Directory (Directory 
dati file DICOM) 

Consente di impostare la directory di destinazione per i file DICOM (*.DCM). 

Validate patient in 
MWL (Convalida 
paziente in MWL) 

Se l'opzione è selezionata, i campi del nome e dell'ID paziente non compilati 
nel referto DICOM verranno aggiornati secondo la worklist della modalità 
DICOM. 

Update DCM files 
(Aggiorna file DCM) 

Se l'opzione è selezionata, aggiornerà il referto DICOM con dati aggiuntivi 
contenuti nella worklist modalità DICOM. 

Store in PACS 
(Archivia in PACS) 

Se questa opzione è selezionata, i file del referto DICOM (*.DCM) generati 
saranno inviati immediatamente al server PACS. 

Resend Files (Reinvia 
file) 

Fare clic su questo pulsante per inviare di nuovo i file DICOM manualmente 
presenti nella cartella 
FileDataDirectory\Outbox (Directory dati file\Outbox) al server PACS. 

PACS Server IP, Port, 
AE Title (IP server 
PACS/Porta/Titolo 

Impostazioni della connessione al server SCP dell'archivio PACS. 
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AE) 

Station AE Title (Titolo 
AE postazione) 

Nome logico della workstation per identificarla sul server PACS SCP. 

 
 
 

Worklist 

External INI file (File 
INI esterno) 

Impostare il percorso per il file di dati della worklist generata dall'HIS. Il 
percorso predefinito è: 
C:\ProgramData\NoravMedical\PCECG\Worklist\PatientFile.ini 
(C:\Programmi\NoravMedical\PCECG\Worklist\PatientFile.ini). 

Query DICOM MWL 
(Interroga MWL 
DICOM) 

Abilitare l'opzione e configurare la connessione con il server della worklist 
della modalità DICOM. 

Local Copy (Copia 
locale) 

Impostare il percorso della directory per la copia di backup del file della 
worklist da utilizzare durante gli errori di connessione del sistema 
dell'origine HIS. 

Tabella 10: Opzioni di configurazione dell'ECG a riposo 
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ECG DA SFORZO 
(Questa opzione è disponibile con licenze S1 e S2) 

 
Figura 37: Schermata ECG da sforzo 

 

Per personalizzare la visualizzazione 
Fare clic e trascinare la barra di separazione tra due sezioni con il cursore del mouse. 
 

Per bloccare i bordi delle finestre dello schermo 
Se si desidera mantenere la visualizzazione nel formato attuale:  

1. Fare clic sulla scheda Setup > View (Configurazione > Visualizza). 
2. Controllare l'opzione Lock Splitter (Blocca visualizzazione). 
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Avvio rapido 

Per eseguire un nuovo esame 
1. Collegamento degli elettrodi al paziente 

a. Preparare la cute 
b. Collegare gli elettrodi 

Questa applicazione utilizza i cavi a 10 contatti standard. Contiene quattro contatti per gli arti (RA, LA, LL e RL) e sei contatti per il 
torace (V1-V6). Vengono registrate e visualizzate 12 derivazioni: 

• 3 derivazioni bipolari: I, II, III 
• 3 derivazioni aumentate: AVR, aVL, aVF 
• 6 derivazioni unipolari: V1-V6 

È possibile utilizzare un cavo più semplice con quattro contatti (solo arti). Produce solo sei derivazioni: tre bipolari e tre aumentate. 
È possibile posizionare le derivazioni sul paziente in vari modi. Il metodo abituale consiste nell'utilizzare le posizioni standard sul 
torace (V1-V6). 
Collegare le derivazioni come mostrato di seguito. 

 
RA: appena sotto la clavicola destra 
LA: appena sotto la clavicola sinistra 
LL: sul bordo inferiore sinistro della gabbia toracica 
RL: sul bordo inferiore destro della gabbia toracica  
V1: 4° spazio intercostale, bordo destro dello sterno  
V2: 4° spazio intercostale, bordo sinistro dello sterno  
V3: a metà tra V2 e V4 
V4: 5° spazio intercostale, linea medioclavicolare 
V5: linea ascellare anteriore in linea retta con V4 
V6: linea medio-ascellare in linea retta con V4 e V5 

 
 

2. Avvio di un nuovo esame 
a. Eseguire l'applicazione per l'esame ECG da sforzo. 
b. Avviare un nuovo esame facendo clic sul pulsante del menu principale New (Nuovo) o premendo il tasto F1 della 

tastiera. 
c. Inserire i dettagli del paziente, quindi fare clic sul pulsante OK o premere il tasto Invio sulla tastiera. 
d. Viene avviata la fase di pre-esame. 

3. Avviare la fase di esercizio: fare clic su F3 (o sul pulsante Exercise (Esercizio)). 
4. Eseguire l'esame. 
5. Per iniziare la fase di recupero, fare clic sul tasto F5 o sul pulsante Recovery (Recupero). 
6. Per interrompere l'esame, fare clic sul tasto F4 o sul pulsante Test End (Fine esame). 

Per stampare un ECG 
• Selezionare Print ECG (Stampa ECG) dal menu File. 
• Selezionare Current Stage (Fase corrente)\Entire Study (Intero studio) dal menu secondario Print ECG (Stampa 

ECG). 
• Selezionare la stampante dalla finestra di dialogo Print (Stampa). 
• Fare clic su OK per chiudere la finestra di dialogo e avviare la stampa. 

Per stampare un referto 
• Fare clic su Print (Stampa) nella barra degli strumenti. 
• Selezionare i referti da stampare. 
• Fare clic su OK per avviare la stampa sulla stampante predefinita. oppure 
• Selezionare la voce Print Reports (Stampa referti) dal menu File. 
• Selezionare il referto. 
• Definire la stampante nella finestra di dialogo Print (Stampa). 
• Fare clic su OK per avviare la stampa del referto. 

 
Per un esempio di referto stampato, vedere l'Appendice C. 

Figura 38: Posizionamento delle derivazioni dell'ECG da sforzo con cavo a 10 
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Utilizzo dei tasti funzione 
F1 Nuova registrazione 

F2 Eseguire/Arrestare il monitoraggio nella fase di pre-
esame 

F3 Iniziare la fase di esercizio dell'esame 

F4 Interrompere l'esame 

F5 Iniziare la fase di recupero 

F6 Impostare/Stampare evento 

F7 Fase di mantenimento 

F8 Fase successiva 

F9 Revisione 

F10 Fase precedente 

F11 Aprire lo studio salvato 

F12 Arrestare il tapis roulant in caso di emergenza 

Tabella 11: Tasti funzione da sforzo 

 
Nota 

Prima di utilizzare il pacchetto per l'esame da sforzo, definire i parametri preferiti in Setup (Configurazione). In 
caso contrario, il programma funzionerà in base alle impostazioni di fabbrica. 

 

Panoramica della barra degli strumenti 

Barra degli strumenti principale 
Questa barra degli strumenti viene visualizzata durante la fase di avvio. Utilizzare questa opzione per aprire un esame esistente o per 
iniziarne uno nuovo. 

 
Figura 39: Barra degli strumenti principale per l'esame da sforzo 

 
Per questa azione Fare clic su 

questa icona 
Oppure 

premere un 
 tasto della 

tastiera 

Oppure 
selezionare 

questo menu 

Descrizione 

Avviare un nuovo 
esame 

 

 

F1 File > New (File 
> Nuovo) 

Crea un nuovo esame 

Aprire un esame 
esistente 

 

 

 
F11 

 
File > Open (File 
> Apri) 

 
Apre un esame esistente 

Configurare una 
stampante 

  File > Print Setup 
(File > 
Configurazione 
stampa) 

Impostare la stampante attiva e regolare 
le impostazioni della stampante. 
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Recuperare i 
tracciati dell'ECG 

  File > Recovery 
File to Monitoring 
Format (File > 
Recupera file nel 
formato 
monitoraggio) 

Consente di salvare i dati ECG in caso di arresto anomalo 
dell'applicazione per gli esami da sforzo. Nella finestra di 
dialogo, immettere un nome e un percorso per il file 
(StrXXX*.TMP). Per visualizzare l'ECG, aprire questo file con 
l'applicazione dell'ECG di monitoraggio. 

Importare i dati 
anagrafici 
da EHR a PC-
ECG 

  File > Format 
DT/BDT 
(File > Formato 
DT/BDT) 

Per avviare un nuovo esame con il nome del paziente 
selezionato nel sistema EHR. Per ulteriori informazioni, vedere 
Import from GDT/BDT (Importa da GDT/BDT) 

Modificare il 
 medico 
supervisore 

  View->Change 
Supervising 
Physician 
(Visualizza-> 
Modifica medico 
supervisore) 

Apre una finestra di dialogo con un elenco di medici definiti per 
consentire la modifica del medico supervisore. 

Selezionare un 
protocollo 
di esercizio 

  View > Change 
current 
protocol 
(Visualizza > 
Modifica 
protocollo 
corrente) 

Modifica il protocollo di esercizio o cambia tra il tapis roulant e 
un ergometro. 

Impostare le 
preferenze  

Ctrl+T. View > Setup 
(Visualizza > 
Configurazione) 

Visualizza la finestra di dialogo Setup (Configurazione). 

Visualizzare le 
informazioni 

 

 

 Help > About 
Stress… (Guida > 
Informazioni 
sullo sforzo) 

Visualizza le informazioni su programma, numero di versione 
e copyright. 

Tabella 12: Barra degli strumenti e menu principali dell'esame da sforzo 
 

Comandi per l'esame da sforzo 
Questa barra degli strumenti viene visualizzata all'inizio di un nuovo esame. 

 
Figura 40: Barra degli strumenti dei comandi per l'esame da sforzo 

 
 

Per questa azione 
Fare clic su 
questa icona 

Oppure 
utilizzare 

questo tasto 

Oppure 
selezionare 

questo menu 

 
Descrizione 
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di scelta 
rapida 

Avviare/Interrom
pere la 
registrazione 
ECG 

 F2  Per annullare o riavviare la registrazione dell'ECG durante la 
fase di pre-esame. 

Informazioni sul 
paziente 

 

 

  Consente di visualizzare le informazioni del paziente. 

Modificare il 
protocollo di 
esercizio 

 

 

  Per selezionare il protocollo di esercizio e definire la frequenza 
cardiaca target e gli allarmi. 

Avviare la fase di 
esercizio  

F3  Avvia la fase di esercizio 

Avviare la fase di 
recupero  

F5  Avvia la fase di recupero 

Interrompere 
l'esame/la fase di 
recupero 

 

 

F4  Termina l'esame da sforzo o la fase di recupero 

Aggiungere 
evento  

F6  Imposta l'evento e stampa in base alle opzioni 

Stampare la 
pagina dell'ECG  

  Stampa la schermata dell'ECG in base alle opzioni 

Stampare una 
pagina di pulizia 
tracciato 

 

 

  Stampa la schermata dell'ECG con la mediana della pulizia del 
tracciato 

Stampare il ritmo 
dell'ECG 

 

 

  Stampa continua dei tracciati ECG su carta con piegatura a Z. 
(È richiesta la licenza software P1 e una stampante termica.) 

Misurare la 
pressione 
sanguigna 

 

  Salva i valori della pressione sanguigna immessi sullo schermo 
o attiva il monitor della pressione sanguigna 

Bloccare la fase 
corrente 

 

 

 
F7 

 Blocca la fase corrente nel protocollo. Fare nuovamente clic 
per rilasciare la fase e continuare con il protocollo. 

Tornare alla   
fase del 
protocollo 

 
F7 

 
Ritorna all'automazione del protocollo. 

Tornare alla fase 
precedente 

 

 
F10 

 
Torna alla fase precedente del protocollo. 

Passare alla fase 
successiva 

 

 
F8 

 
Passa alla fase successiva del protocollo. 

Rallentare la 
velocità  

  Riduce la velocità del nastro del tapis roulant. Imposta la 
modalità del carico di lavoro manuale. 

 Aumentare la 
velocità  

  Aumenta la velocità del nastro del tapis roulant. Imposta la 
modalità del carico di lavoro manuale. 

Inclinazione 
verso il basso  

  Riduce l'inclinazione del tapis roulant. Imposta la modalità del 
carico di lavoro manuale. 

Inclinazione 
verso l'alto  

  Aumenta l'inclinazione del tapis roulant. Imposta la modalità 
del carico di lavoro manuale. 

Spegnimento  
 

 

  Riduce il carico di lavoro dell'ergometro. Imposta la modalità 
del carico di lavoro manuale. 

Accensione 
 

 

  Aumenta il carico di lavoro dell'ergometro. Imposta la modalità 
del carico di lavoro manuale. 

Arrestare il  
nastro 

 

 F12  Arresto di emergenza del tapis roulant. 



ND:  NV-100.5988.050|Rev.260224 PC-ECG 1200 Istruzioni per l'uso Pagina 66 di 129 

Avviare il  nastro 
 

 F12  Avvia il nastro del tapis roulant. 

Configurazione 
 

 
Ctrl+T. 

 Consente di regolare il layout dello schermo e la 
configurazione del sistema. 

Riprodurre i 
tracciati ECG  

Tasto 
barra 

spaziatrice 

 Consente di visualizzare e scorrere all'indietro in una finestra 
separata i tracciati ECG registrati dall'inizio dell'esame 
corrente. Gli utenti possono scegliere se avviare la 
riproduzione dall'evento più recente o dal punto ECG più 
recente. La nuova opzione "Show recent event" (Mostra 
evento recente) avvia la riproduzione dall'ultimo evento 
registrato. 

Cambiare la   
derivazione di 
sincronizzazion
e QRS 

 

  Consente di cambiare la derivazione ECG per l'uscita di 
attivazione/BNC. 

Controllo 
della qualità 
dell'elettrodo 
applicato 

 
Ctrl + 
Barra 

spaziatrice 

 Visualizza l'immagine schematica del tronco per verificare la 
qualità del collegamento degli elettrodi applicati e lo stato di 
derivazione staccata. 

Annotazioni 
 

Ctrl+R  Consente di immettere annotazioni e commenti sull'esame. 

Tabella 13: Comandi per l'esame da sforzo 
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Pannello di visualizzazione della schermata ECG e filtri 
Per aprire il pannello di visualizzazione della schermata, fare clic sul pulsante Setup (Configurazione). 

 
Figura 41: Pannello delle viste e dei filtri dell'ECG da sforzo 

 

Impostazioni del visualizzatore delle medie 
Il menu visualizzato premendo il pulsante destro del mouse include le diverse viste disponibili per il pannello del visualizzatore delle 
medie. 

 
Figura 42: Menu di impostazione della schermata Stress ECG Average Viewer (Visualizzatore medie ECG da sforzo) 

 

Barra degli strumenti delle opzioni di post-elaborazione 
Al termine dell'esame, è possibile esaminarlo utilizzando la barra degli strumenti Post Processing Options (Opzioni post-elaborazione). 

 
Figura 43: Barra degli strumenti della schermata Stress ECG Post Processing (Post-elaborazione degli ECG da sforzo) 
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Per questa azione Pulsante Scelta 

rapida 
Opzione di menu 

Visualizzare i risultati dei 
trend ST a 12 derivazioni 

 

 

 View > 12 Leads ST (Visualizza > ST 12 derivazioni) 

Visualizzare i risultati dei 
trend ST a 3 derivazioni 

 

 

 View > 3 Leads ST (Visualizza > ST 3 derivazioni) 

Visualizzare la tripletta dei 
trend ST successiva  

 

 

 View > Next ST Leads (Visualizza > Derivazioni ST 
successive) 

Visualizzare i risultati 
numerici 

 

 

Ctrl+V View > Properties (Visualizza > Proprietà) 

Annullare l'ultima azione  

 

Ctrl+Z  

Visualizzare 10 secondi di 
dati ECG 

 

 

Invio View > Open ECG Data (Visualizza > Apri dati ECG) 
(richiede licenza I1 o I2). 

Spostare il contrassegno 
all'evento precedente 

 

 

Ctrl+ View > Event > Previous Event (Visualizza > Evento > 
Evento precedente) 

Spostare il contrassegno a 
sinistra per 10 secondi 

 

 

 View > Event > Left (Visualizza > Evento > Sinistra) 

Riprodurre i risultati  

 

 View > Play ECG Data (Visualizza > Riproduci dati ECG) 

Spostare il contrassegno a 
destra per 10 secondi 

 

 

 View > Event > Right (Visualizza > Evento > Destra) 

Spostare il contrassegno 
all'evento successivo 

 

 

Ctrl+ View > Event > Next Event (Visualizza > Evento > Prossimo 
evento) 

Aggiungere (creare) un 
nuovo evento 

 

 

 View > Add New Event (Visualizza > Aggiungi nuovo evento) 

Eliminare l'evento corrente  

 

 View > Delete Current Event (Visualizza > Elimina evento 
corrente) 

Impostare le preferenze  

 

Ctrl+T. View > Setup (Visualizza > Configurazione) 

Stampare l'esame  File/Print 
ECG 
(File/Stampa 
ECG) 

Consente di stampare l'intero esame o una singola fase 

Posizionare il contrassegno 
ST 

 View/Recalc
ulate ST 
(Visualizza/R
icalcola ST) 

Consente di posizionare il contrassegno ST per l'intero esame 

Tabella 14: Barra degli strumenti e menu di post-elaborazione 
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Configurazione del sistema per l'esame ECG da sforzo 
Definizione della stampante: 
La definizione della stampante è molto importante a causa dell'elevata velocità di trasferimento dei dati durante la stampa in tempo 
reale. Se la stampante ha circa 8-10 MB di RAM, impostare la risoluzione grafica su 600 dpi. Se la stampante ha circa 2 MB di RAM, 
ridurre la risoluzione a 300 dpi. 
Fare clic su Setup (Configurazione) sulla barra degli strumenti per accedere ai seguenti parametri: 
 
Scheda e Scheda 
secondaria 

Opzione Descrizione 

 
 
 
 
 
 
 
 
 
 
 
 
ECG Recording 
(Registrazione 
ECG) 

Default filters (Filtri 
predefiniti) 

Definisce lo stato iniziale del filtro nella registrazione ECG. 

 
Save 
Options 
(Salva 
opzioni) 

Save Format (Salva 
formato) 

Definisce la quantità di dati da salvare sul disco. 

Auto Save 
(Salvataggio auto) 

Impostare questa opzione per salvare automaticamente il file dell'ECG al 
termine dell'esame. 

Set File Name By 
(Imposta nome file 
per) 

Per salvare il nome del file di registrazione in base all'ID paziente o al 
cognome del paziente. 

 
 
Simulator ECG (ECG 
simulatore) 

Se l'opzione è deselezionata (impostazione predefinita), l'acquisizione 
dell'ECG viene eseguita dall'unità PC-ECG. Se l'opzione è selezionata, la 
registrazione ECG viene eseguita dalle forme d'onda demo incluse nel 
pacchetto software. In questo caso, l'unità di registrazione non è necessaria. 
Sul display delle derivazioni (e sui referti) viene visualizzata la parola 
"Simulator" (Simulatore). 

Alert signal OFF (Segnale 
avviso OFF) 

Viene emesso un avviso (segnale acustico) quando la frequenza cardiaca 
raggiunge il valore massimo o quello target. Se questa opzione è selezionata, 
non viene generato alcun avviso. 

Beep on QRS (Segnale 
acustico su QRS) 

Se l'opzione è selezionata, viene emesso un segnale acustico a ogni rilevazione 
di QRS. 

 
ECG Leads (Derivazioni 
ECG) 

Quando si utilizza il cavo paziente standard a 12 derivazioni, selezionare 
l'opzione 12 Leads (12 derivazioni) per leggere e visualizzare fino a 12 
derivazioni (impostazione predefinita). Quando si utilizza un cavo a 6 
derivazioni ("Derivazioni ARTI"), selezionare l'opzione 6 Leads (6 
derivazioni). 

Sample Rate (Frequenza di 
campionamento) 

Consente all'utente di scegliere la velocità di campionamento dell'acquisizione 
ECG. 

Use ECG Database (Usa 
database ECG) 

Selezionare questa opzione per connettersi al database NEMS (opzionale). 

Data Directory (Directory dati) Definire una directory per le registrazioni ECG salvate (se non si utilizza il 
database NEMS, altrimenti la directory dei dati viene definita nel sistema 
NEMS). 

 
 
Leads (Derivazioni) 

Default 3 leads (3 derivazioni 
predefinite) 

Specifica le 3 derivazioni visualizzate come predefinite quando si utilizza il 
formato di visualizzazione 3x1. 

Default 6 leads (6 derivazioni 
predefinite) 

Specifica le 6 derivazioni visualizzate come predefinite quando si utilizza il 
formato di visualizzazione 6x1 o 3x2. 

Strip Lead (Derivazione del 
tracciato) 

La derivazione da 10 sec viene visualizzata nei formati 4x3 e 6x2. 

 
 
 
 
 
 
 
 
View (Visualizza) 

Screen Colors (Colori 
schermo) 

Consente di specificare i colori dello schermo per sfondo, tracce ECG, grafici 
e testo. Fare clic sul pulsante appropriato e selezionare il colore dalla 
tavolozza. 

Default ECG View 
(Visualizzazione ECG 
predefinita) 

Selezionare il valore predefinito nella visualizzazione delle derivazioni sullo 
schermo dall'elenco nella casella combinata. Configura separatamente la 
schermata ECG principale e la finestra 
Playback (Riproduci). La nuova opzione in Playback (Riproduci), "Show 
recent event" (Mostra evento recente), avvia la riproduzione dall'ultimo evento 
registrato. 

Horizontal scale (Scala 
orizzontale) 

Imposta il valore predefinito per la finestra della scala orizzontale sullo 
schermo (mm/sec). 
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Vertical scale (Scala verticale) Imposta il valore predefinito per la finestra della scala verticale sullo schermo 
(mm/mV). 

 
 
Real Time Average QRS (QRS 
medio in tempo reale) 

Selezionare l'opzione Static (Statico), Dynamic (Dinamico) (caso peggiore 
ST) o ST/HR Index (Indice ST/FC) per visualizzare il valore medio QRS. Se è 
selezionata l'opzione Static (Statico), il valore medio QRS visualizzato è 
quello del canale del tracciato predefinito selezionato nell'impostazione. Se è 
selezionata l'opzione Dynamic (Dinamico), il canale del valore QRS medio 
visualizzato cambia dinamicamente in base al canale con il valore ST del caso 
peggiore. Se è selezionata l'opzione ST/HR Index (Indice ST/FC), il canale 
del valore QRS medio visualizzato cambia dinamicamente in base al canale 
con l'indice ST/FC peggiore (ovvero il più alto). L'indice ST/FC viene 
calcolato dividendo l'abbassamento ST più profondo misurato per la 
differenza tra la frequenza cardiaca corrente e la frequenza cardiaca di base (a 
riposo): 
Indice ST/FC = Abbassamento ST più profondo ÷ (FC corrente – FC basale) 
Questo indice è disponibile solo quando sono soddisfatte due condizioni: è 
presente un abbassamento di ST e la frequenza cardiaca è aumentata di oltre 
10 battiti al minuto rispetto alla linea di base a riposo. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

View (Visualizza) 

Show Baseline QRS (Mostra 
QRS linea di base) 

Selezionare l'opzione per mantenere sullo schermo il valore QRS medio della 
linea di base durante l'intero esame, incluse le fasi di pre-esame, esercizio e 
recupero. 

Legend (Legenda) Selezionare questa opzione per visualizzare la legenda nel visualizzatore delle 
medie. Deselezionare questa opzione per nascondere la legenda e aumentare 
la dimensione del carattere dei valori relativi a ST. 

Separate Leads (Derivazioni 
separate) 

Selezionare l'opzione per separare le derivazioni dai bordi. 

Draw over lead borders 
(Traccia sui bordi delle 
derivazioni) 

Selezionare l'opzione per non tagliare i segnali alti che superano la 
visualizzazione del canale tracciato oltre il bordo della derivazione. 

Draw Grid (Disegna griglia) Selezionare l'opzione per visualizzare le linee della griglia. Deselezionare 
l'opzione per nascondere le linee della griglia. 

1 mm Grid (Griglia da 1 mm) Selezionare l'opzione per visualizzare la griglia con risoluzione di 1 mm. In 
caso contrario, la risoluzione delle celle della griglia sarà di 5 mm. 

Cabrera display 
(Visualizzazione Cabrera) 

Selezionare l'opzione quando si utilizza un layout Cabrera delle derivazioni 
ECG. Quando si utilizza il sistema di derivazioni standard, deselezionare 
questa opzione. 

 
Lock Splitter (Blocco 
visualizzazione) 

Quando questa opzione è selezionata, non è possibile spostare i ripartitori 
della finestra e non è possibile ridimensionare le sezioni nel visualizzatore. 
Per ridimensionare le diverse sezioni nel visualizzatore, deselezionare 
l'opzione. 

Smooth ECG Trace 
(Tracciato ECG uniforme) 

Selezionare questa opzione per visualizzare sullo schermo un tracciato ECG 
uniforme. 
Impostazione predefinita: opzione attivata. 

 
Clock count up (Conteggio 
tempo da) 

Selezionare questa opzione per impostare il tempo dall'inizio della fase 
corrente (conteggio incrementale). Se l'opzione non è selezionata, il tempo 
visualizzato è quello rimanente fino alla fine della fase corrente (conto alla 
rovescia).  Impostazione predefinita: opzione non selezionata. 

Monitoring-only the first 
stage Pretest (Monitoraggio 
solo della prima fase di pre-
esame) 

Se l'opzione è attivata, la prima fase nel pre-esame è suggerita per il 
controllo dei collegamenti e non è visualizzata nel referto tabellare. 

Count Recovery time 
separately (Conteggio del 
tempo di recupero 
separatamente) 

Selezionare l'opzione per definire timer separati per le fasi di esercizio e 
recupero. 
Se l'opzione non è selezionata, il tempo visualizzato sullo schermo in Real 
time (Tempo reale) e in Review (Revisione) è quello complessivo, 
comprese la fase di esercizio e la fase di recupero. 

Show the worklist (Mostra 
worklist) 

Se l'opzione è abilitata, all'avvio di un nuovo esame, la worklist viene 
visualizzata più in alto rispetto al pannello dei dati paziente. 

Calculate Body Surface Area 
(Calcola area superficie 
corporea) 

Visualizza l'area della superficie corporea stimata. Metodi disponibili: 
Mosteller, DuBois, Haycock, Gehan, Boyd. 
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Draw Pacer (Disegna 
pacemaker) 

Se l'opzione è abilitata, un contrassegno artificiale (linea verticale 
tratteggiata) sostituisce il picco del pacemaker rilevato sul tracciato ECG 
sullo schermo e sulla stampa. 
Se l'opzione non è abilitata (impostazione predefinita), il picco del pacemaker 
viene visualizzato così com'è. 
Nota: questo contrassegno artificiale è relativo al tempo, ma non è 
rappresentativo dell'ampiezza, della polarità o della larghezza reali 
dell'impulso del pacemaker. 

View 1 mV calibration pulse 
(Visualizza impulso di 
calibrazione di 1 mV) 

Se l'opzione è deselezionata, l'impulso di 1 mV viene visualizzato solo sulla 
stampa. 
Se l'opzione è selezionata, sullo schermo è visualizzato anche l'impulso da 1 
mV. 

Enable Lead OFF Alarm 
(Abilita allarme Cavo 
scollegato) 

Abilita gli allarmi in caso di scollegamento degli elettrodi ECG. 

Audible Lead OFF Alarm 
(Allarme acustico Cavo 
scollegato) 

Abilita gli allarmi acustici per gli allarmi in caso di scollegamento della 
derivazione. 

Easy Toolbar mode (Modalità 
barra degli strumenti 
semplice) 

Selezionare questa opzione per visualizzare un minor numero di icone nella 
schermata Review (Revisione). 

Text Labels (Etichette di 
testo) 

Visualizza le etichette di testo sui pulsanti della barra degli strumenti nella 
schermata Review (Revisione). 

 
Vital Signs (Segni vitali) 

Selezionare altri parametri da visualizzare in tempo reale: Max. predicted 
HR (FC max prevista) o Target HR (FC target); SpO2 (SpO2); 
Speed/Power/Dose (Velocità/Potenza/Dose); Protocol name 
(Nome protocollo); RPP (RPP); ST/HR Index (ST/Indice FC); 
METS (METS); Borg Score (Punteggio Borg); PWC (PWC); 
Distance (Distanza); Target-Watt max (Target-Watt max)(con 
l'opzione  Interpolated (Interpolazione)). Personalizzare il colore di 
visualizzazione di ciascun parametro dei segni vitali facendo clic sulla 
relativa casella dei colori. Fare clic su Restore Defaults (Ripristina 
impostazioni predefinite) per ripristinare le impostazioni predefinite del 
colore. 

Ergometer METS/Watt 
(METS/Watt ergometro) 

Si applica all'esame con l'ergometro. Le unità selezionate (METS o WATT) 
sono visualizzate per il carico di lavoro nella schermata Review (Revisione) 
e sulla stampa. 

Summary Review Mode 
(Modalità di revisione 
riepilogo) 

Selezionare la casella di controllo appropriata per visualizzare 
automaticamente le annotazioni, la tabella dei risultati e l'anteprima 
dell'ECG all'apertura del record per la revisione. 

 
 
 
 
 
 

Installation 
(Installazione) 

 Consente di salvare il nome, l'indirizzo, il logotipo e il nome della 
workstation (modalità). Questi dati sono visualizzati sulla stampa e sul referto 
in formato PDF. 

 
Supervising Physician 
(Medico supervisore) 

Consente di aggiungere/modificare/rimuove il nome, la password e il timbro 
della firma personale di un medico responsabile nell'elenco. Selezionare 
dall'elenco e impostare come medico curante predefinito. 

Technician (Tecnico) Consente di aggiungere/modificare/rimuovere il nome di un tecnico 
nell'elenco. Selezionare dall'elenco e impostare come tecnico predefinito. 

Referring Physician (Medico 
curante) 

Consente di aggiungere/modificare/rimuovere il nome di un medico curante 
nell'elenco. 

Measurement Standard 
(Standard di misurazione) 

Consente di definire se le misurazioni verranno calcolate in base al sistema 
metrico o allo standard USA. Impostazione predefinita: sistema metrico. 

 
 
 
 
 
 
 
 

 

ECG Connection 
(Collegamento ECG) 

Selezionare una porta COM, USB o Bluetooth per per il dispositivo di 
acquisizione PC-ECG. 

Display Size (Dimensioni del 
display) 

Questa impostazione è necessaria per visualizzare l'ECG e la griglia nella 
scala corretta. 

 
Toolbar buttons (Pulsanti 
della barra degli strumenti) 

Regola le dimensioni dei pulsanti della barra degli strumenti. Scegliere 
l'opzione Small (Piccolo)  per 768 pixel, Medium (Medio) per fino a 1080, 
Big (Grande) per fino a 1200, e Huge (Grandissimo) per >1200 pixel di 
altezza della schermata del PC. 
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Environment 
(Ambiente) Measure BP by Automatic 

Device (Misura BP con 
dispositivo auto) 

Se si utilizza un dispositivo di monitoraggio della pressione sanguigna, 
consente di definire se le misurazioni automatiche devono essere eseguite in 
aggiunta alle misurazioni manuali. 

BP Measurement Mode 
(Modalità di misurazione BP) 

Impostare il metodo di misurazione della BP. Scegli tra le modalità Auto 
(Auto), Ausculatory (Auscult.) o Oscillometric (Oscillometr.). 

BP Port (Porta BP) Impostare la porta a cui è collegato il dispositivo per la pressione sanguigna 
(opzionale). 

SpO2 sensor (Sensore SpO2) Scegliere il dispositivo opzionale per le misurazioni SpO2. 

Check NET Key (Controlla 
chiave NET) 

Selezionare l'opzione se la licenza software è installata sulla chiave di rete 
(NetHASP). 

 
 
 
 
 
 

 
Profile (Profilo) 

 È possibile abilitare i profili dei test di esame, assegnare le porte COM e 
definire i protocolli per l'esame da sforzo. 

Exercise Device (Dispositivo 
per l'esercizio) 

Selezionare un modello di tapis roulant e di ergometro. Il tipo deve essere 
assegnato separatamente per il tapis roulant e per l'ergometro. 

 
Default protocol (Protocollo 
predefinito) 

Elenco dei protocolli per l'esame da sforzo. Scegliere uno dei protocolli 
disponibili o definire il proprio protocollo. Il protocollo predefinito deve 
essere assegnato separatamente per il tapis roulant, l'ergometro e il profilo 
farmacologico. 

Speed unit (Unità di velocità) Impostazione di MPH (Miglia/h) o KPH (Km/h). L'opzione si riferisce 
solo ai tapis roulant. 

 
Emergency STOP (Arresto di 
emergenza) 

Selezionare la procedura di arresto di emergenza del tapis roulant. 
Selezionare Immediately (Immediatamente) per l'arresto immediato del 
tapis roulant o Slow Down (Rallenta) per rallentare gradualmente la 
velocità fino all'arresto definitivo. 

Manual control step (Fase 
controllo manuale) 

Applicabile solo agli ergometri. Determina la fase di incremento del carico 
durante il controllo manuale dell'ergometro. 

 
 
 

 
Advance 
(Avanzamento) 

 
 
 

 QRS Sync Output (Uscita 
sincronizzazione QRS) 

Valido per l'opzione S2 Advanced Stress (Sforzo avanzato S2). 
Impostazioni per l'attivazione ECG per dispositivi con uscita analogica 
integrata (modelli 1200HR e 1200 W). 
- Controllare l'opzione R wave trigger (Attivazione onde R) quando si 

utilizza il collegamento USB con l'uscita di attivazione/BNC se viene 
adoperato un monitor per il monitoraggio della pressione sanguigna o se 
è necessaria una sincronizzazione esterna per l'imaging. Selezionare 
l'ampiezza di attivazione dell'onda R desiderata dall'elenco delle opzioni. 

- In alternativa, selezionare l'opzione ECG per il segnale ECG analogico. 
- Selezionare il cavo predefinito per l'uscita di attivazione/BNC. 
- Selezionare  l'opzione In-Test "Sync Lead" Selector (Selettore 

"Sincronizza derivazione" durante l'esame) per visualizzare il 
selettore delle derivazioni BNC sulla barra degli strumenti principale. 
Questa opzione consente di cambiare online la derivazione dell'uscita di 
attivazione/BNC durante l'esame. 

 

 
Analog Out 1/Analog Out 2 
(Uscita analogica 1/Uscita 
analogica 2) 

Configurazione delle uscite analogiche del dispositivo ECG 
wireless 1200 W. Valido per l'opzione S2 Advanced Stress 
(Sforzo avanzato S2). 
- Selezionare l'opzione ECG Lead (Derivazione ECG) per l'uscita ECG 

analogica. 
- Oppure selezionare l'opzione Heart Rate (Frequenza cardiaca) per il 

segnale analogico della frequenza cardiaca. 
- Oppure selezionare Analog Control (Controllo analogico) per 

l'ergometro/il tapis roulant controllato analogicamente. 
 

Cards (Schede) 
Configurazione della scheda D/A D1-T, utilizzata se è necessaria un'uscita di 
attivazione TTL o un'uscita analogica per dispositivi ECG senza uscita 
analogica incorporata (per i modelli 1200S, NR-1203-e 1207-3). 

 
 

Metabolic Interface 
(Interfaccia metabolica) 

Valido per l'opzione S2 Advanced Stress (Sforzo avanzato S2). 
Selezionare l'opzione per attivare il segnale "HR as Linear Analog 
Voltage" (FC come tensione analogica lineare) su un'uscita BNC 
secondaria. 
È necessario un adattatore 1200USB-A aggiuntivo. 

Use Transfer file “Trnsf.txf” 
(Utilizzare il file di 
trasferimento "Trnsf.txt") 

Selezionare l'opzione per esportare i dati dell'esercizio ECG in tempo reale, 
ad esempio FC, carico di lavoro e altro tramite il file Trnsf.txt. Leggere il 
capitolo dedicato al trasferimento file con Trnsf.txt per ulteriori 
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informazioni 

Use real time protocol 
export file (Usa file di 
esportazione del protocollo 
in tempo reale) 

Selezionare l'opzione per esportare i dati dell'esercizio ECG in tempo reale 
attraverso il file in formato ERGOSPIR.DAT. Applicabile alla 
comunicazione con un sistema CPET/CPX esterno o con un altro sistema 
compatibile. 
Se l'opzione è selezionata, il percorso e il nome del file devono 
essere definiti.  
(Percorso predefinito: C:\LAB5\DB\ERGOSPIR.DAT) 

Slave mode operation via 
external control file 
(Funzionamento in modalità 
slave tramite file di controllo 
esterno) 

Consente di abilitare la modalità operativa Slave. Applicabile insieme a un 
sistema CPET/CPX esterno o con un altro sistema compatibile. Se 
selezionato, il nome e il percorso del file di controllo devono essere definiti. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Printouts 
(Stampe) 

Auto Print Default Reports 
on End Test (Stampa auto 
referti predefiniti alla fine 
esame) 

Selezionare l'opzione per stampare automaticamente i referti predefiniti alla 
fine di ciascun esame. 

Default Reports (Referti 
predefiniti) 

Specifica l'insieme dei referti finali. 

ECG Pages (Pagine ECG) Specifica le stampe dell'ECG a 12 derivazioni da includere nell'insieme di 
referti. 

Use Large fonts for 
Remarks (Usa i 
caratteri grandi per le 
annotazioni) 

Consente di ingrandire il carattere per i commenti a testo libero immessi 
dall'utente. 

Shadow/Frame For Area of 
Interest (Ombra/Cornice per 
l'area di interesse) 

Consente di scegliere tra ombra e cornice per evidenziare l'area di interesse. 

Print Event Remarks (Stampa 
annotazioni evento) 

Raccoglie il testo di tutti i commenti degli eventi nel campo Conclusions 
(Conclusioni) del referto completo. 

CleanTrace Printout (Stampa 
CleanTrace) 

Selezionare l'opzione per applicare il filtro CleanTrace alle stampe dell'ECG a 
12 derivazioni inviate offline (nella schermata  Review (Revisione)). 

ECG Line (Linea ECG) Consente di definire la larghezza della linea nelle stampe, come normale o 
grassetto. 

 
 
 
 

 
Leads Print (Stampa 
derivazioni) 

Simultaneous (Simultanei) (impostazione predefinita): stampa i 
segmenti simultanei dei dati ECG per ciascuna derivazione sincronizzata 
con punto temporale del fotogramma su un tracciato inferiore completo di 
10 secondi. L'aggettivo "simultanei" si riferisce al fatto che i dati presentati 
per ogni derivazione sono stati acquisiti esattamente nello stesso momento. 
Successive (Successivi) Il referto mostra un campione sequenziale di dati 
ECG da ciascuno dei 12 canali. Ogni canale successivo ha la zona temporale 
successiva dei dati ECG per un totale di 10 secondi di dati. L'inizio di ciascun 
canale è contrassegnato da una linea verticale e dall'identificatore del canale 
con le lettere in grassetto. Il tracciato inferiore sul grafico presenta dieci 
secondi di dati. Inoltre, funge da indicatore di data e ora per l'intero referto. 
Ogni complesso QRS in questo tracciato è lo stesso presente in altri tracciati 
visualizzati in alto. 

Event Format (Formato 
evento) 

Impostare il formato dell'evento per la stampa nel formato a 3 derivazioni o 
a 12 derivazioni. 

 
Tabular Results (Risultati 
tabellari) 

Valori: selezionare l'opzione  Events only (Solo eventi), All (Tutti) o 
Every 1 minute (Ogni minuto) per stampare il formato dei risultati in 
formato tabellare. 
Formato: selezionare Remarks (Annotazioni) per stampare i commenti su 
questa pagina o selezionare l'opzione ST Values (Valori ST) per stampare 
invece la tabella delle misurazioni ST completa. 

Trends (Trend) Selezionare Remarks (Annotazioni) per stampare i commenti sul lato 
destro della pagina oppure selezionare l'opzione ST Values (Valori ST) per 
stampare invece i trend in quest'area. 

 
Graph paper (Carta per 
grafici) 

Se l'opzione è abilitata, stampa una griglia da 1 mm e 5 mm sulle stampe. 
L'opzione Regular Grid (Griglia regolare) funziona con qualsiasi 
stampante. L'opzione Improved Grid (Griglia migliorata) visualizza una 
griglia sottile, ma potrebbe non funzionare su alcune stampanti. 
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Color Printout (Stampa a 
colori) 

Selezionare questa opzione per stampare a colori. 

Blending out ST values 
(Escludi valori ST) 

Selezionare l'opzione per stampare i risultati senza valori ST. 

Rest Event (Evento di 
riposo) 

Selezionare  Interpretation (Interpretazione) e/o Measurements 
(Misurazioni) per visualizzare l'interpretazione e/o le misurazioni nella 
stampa della fase di risposo. 

 
 

Worklist 

 
Source System (Sistema di 
origine) 

Selezionare e configurare l'origine per la lettura delle voci della Worklist. 
Scegliere tra la connessione al server DICOM Modality Worklist (Worklist in 
modalità DICOM) o la lettura dei nomi dei pazienti dal file INI esterno. 

Local Copy (Copia locale) Consente di definire la directory locale in cui salvare la copia di backup delle 
voci della worklist. 

 
 
 
 

 
GDT/BDT 
Format 
(Formato 
GDT/BDT) 

Automatic Options (Opzioni 
automatiche) 

Configurare le opzioni automatiche per il salvataggio e/o l'importazione dei 
file in formato GDT/BDT. 

File Format (Formato file) Consente di selezionare il formato del file: GDT o BDT. 

Import Codepage 437 
(Importa Codepage 437) 

Selezionare l'opzione per importare la Codepage 437. 

Export Codepage 437 
(Esporta Codepage 437) 

Selezionare l'opzione per esportare la Codepage 437. 

Edit Labels (Modifica 
etichette) 

Fare clic su questo pulsante per aprire una finestra di dialogo con un elenco 
modificabile delle etichette dei campi utilizzato nei file GDT e BDT. 

GDT/BDT Data Directory 
(Directory dati GDT/BDT) 

Specifica il percorso della directory in cui conservare i file GDT/BDT. 

Token for PCECG (Token 
per PCECG) 

L' impostazione predefinita è PEKG. 

Token for Practice EDP 
(Token per Practice EDP) 

L'impostazione predefinita è EDV1. 

 
 
 

Text File (File di 
testo) 

Auto Save Test Data in Text 
File (Salvataggio auto dati 
esame in file di testo) 

Selezionare l'opzione per salvare automaticamente i dati dell'esame in un 
file di testo alla fine dell'esame (in base alla denominazione e alla directory 
definite in questa scheda). 

Set Text file Name by 
(Imposta nome file di testo 
per) 

Consente di definire la convenzione di denominazione del file di testo, 
creata automaticamente o su richiesta. 

Text File Data Directory 
(Directory dati file di testo) 

Consente di specificare la directory nella quale conservare i file di testo. 

 
 
 
 
 

 
PDF/XML 
/DICOM/RDT 

Salvataggio automatico dei 
dati dell'esame in formato 
PDF. 

Selezionare l'opzione per salvare automaticamente i dati dell'esame in un file 
PDF alla fine dell'esame (in base alla denominazione e alla directory definite 
in questa scheda). 

PDF Reports (Referti PDF) Consente di specificare le pagine da includere nel referto PDF. 

Salvataggio automatico dei 
dati dell'esame in formato 
XML. 

Selezionare l'opzione per salvare automaticamente i dati dell'esame in un 
file XML alla fine dell'esame. 

Set PDF/XML/RDT File 
Name by (Imposta nome file 
PDF/XML/RDT per) 

Consente di definire la convenzione di denominazione dei file PDF, XML 
ed RDT, creati automaticamente o su richiesta. 

Delimiter (Delimitatore) Selezionare il carattere del delimitatore tra i valori dei dati nel nome file 
formattato 
dei file PDF e XML. 

ECG Grid in PDF (Griglia 
ECG in PDF) 

Specificare il colore della griglia stampata nel referto PDF: bianco e nero o a 
colori. 

XML File Format (Formato 
file XML) 

Consente di definire il formato file come XML, Cardiology XML o Clinical 
Report (Referto clinico). 

PDF/XML File Data 
Directory (Directory dati file 
PDF/XML) 
 

Consente di specificare la directory in cui conservare i file PDF e XML. 

RAW DATA File Format 
(Formato file dati non 
elaborati) 

Consente di specificare i parametri dell'ECG da esportare nel formato file 
dati non elaborati. 
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DICOM Abilitare e configurare l'esportazione dei referti dell'esame nei sistemi abilitati 
DICOM 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Target 
HR/METS (FC 
target/METS) 

Max. predicted HR (FC 
prevista max) 

Consente di impostare la FC massima da utilizzare nel campo Max predicted 
HR (FC prevista max), che dipende dall'età e dal sesso del paziente. 
Configurare la formula Max predicted HR (FC prevista max) separatamente 
per tapis roulant ed ergometro. Se necessario, regolare i coefficienti 
dell'equazione, compresi i valori non interi. 

 
 

Target HR (%) (FC target 
(%)) 

Impostare la percentuale della frequenza cardiaca massima prevista per la 
frequenza cardiaca target. Al di sopra di questo livello, il trend della 
frequenza cardiaca viene visualizzato in un colore diverso. Se il valore 
percentuale viene raggiunto durante la prova ed è selezionata l'opzione 
Switch to Recovery when reaches Target HR (Passa al recupero 
quando è raggiunta la FC target), l'esame da sforzo viene interrotto 
automaticamente e inizia la fase di recupero. 

Audible HR Alarm (Allarme 
acustico FC) 

Abilitare l'allarme acustico per gli allarmi High HR (FC alta) e Low HR (FC 
bassa). 

 
Stop Stress and start 
Recovery (Arresta esame da 
sforzo e avvia recupero) 

Selezionare questa opzione per interrompere l'esame da sforzo quando la 
FC raggiunge il valore massimo previsto o target e cominciare la fase di 
recupero. Quando l'opzione Switch to Recovery when reaches (Passa al 
recupero quando raggiunge) non è selezionata, l'esame da sforzo 
continua come previsto dal protocollo utilizzato. 

Max HR lookup area (Area di 
ricerca FC max) 

Determinare le fasi per la ricerca del valore della frequenza cardiaca max. 
L'utente può escludere le fasi di pre-esame o di recupero dalla ricerca della 
frequenza cardiaca max. 

 
METS/VO2 Formula 
selection (Selezione della 
formula METS/VO2) 

Impostare la formula per calcolare i valori METS/VO2: 
- Per utilizzare una formula singola, selezionare l'opzione Single formula 

for any speed (Formula singola per qualsiasi velocità). 
- Per utilizzare una formula per velocità fino a 3,7 miglia/h e una 

seconda formula al di sopra di quella velocità, impostare l'opzione 
Two formulas (up to and from 3.7 mph) (Due formule/fino a e 
da 3,7 miglia/h). 

 
METS/VO2 Updating 
Method (Metodo di 
aggiornamento di 
METS/VO2) 

Selezionare il metodo per aggiornare i valori METS/VO2. I valori possono: 
- rimanere costanti per tutta la fase 
- passare al valore METS corrente 1 o 2 min dopo l'inizio della fase 
- variare durante la fase (a ogni trimestre della fase). 

Borg Scale (Scala Borg) 
Valutazione della scala di esercizio percepita. Selezionare la scala CR10 o 
RPE. 
Definire il valore di soglia anaerobica nella casella di scorrimento Target 
RPE (RPE target). 

Blood pressure limits (Limiti 
di pressione sanguigna) 

Abilitare gli allarmi della pressione sanguigna e definire le soglie di allarme. 

Risk Assessment (Valutazione 
del rischio) 

Abilitare la funzione di valutazione del rischio Duke Threadmill Score 
(Punteggio Duke) 

 
 
 
 
 

 
ST. VPB, SpO2 
Options (Opzioni 
ST. VPB, SpO2) 

ST Measurements After J 
(Misurazioni ST dopo J) 

Scegliere il numero di millisecondi dopo il punto J in cui viene misurato il 
tratto ST. La configurazione di fabbrica è 60 ms. 

Detect ST Event (Rileva 
evento ST) 

Consente di definire il livello mm per aumento e riduzione. Questa opzione 
consente inoltre all'utente di salvare solo episodi ST deteriorati. 

Worst case ST Report 
(Referto caso ST peggiore) 

Selezionare ST Elevation (Sopraslivellamento ST), ST Depression 
(Sottoslivellamento ST) o entrambi in modo che siano segnalati come caso 
ST peggiore. 

Lookup area (Area di ricerca) Determinare le fasi di ricerca del valore ST peggiore. L'utente può escludere 
le fasi di pre-esame o di recupero dalla ricerca dell'ST peggiore. 

 
Arrhythmia Detection 
(Riconoscimento aritmia) 

Selezionare i tipi di eventi di aritmia da rilevare e salvare. Selezionare 
l'opzione Store one event per stage only (Memorizza solo un evento 
per fase) o deselezionarla in modo da memorizzare tutti i tipi di evento 
selezionati. 

SpO2 Consente di abilitare e definire la soglia per il rilevamento di eventi SpO2 
bassa. 

 
Printing (Stampa) Impostare gli eventi per la stampa automatica (compresi fine fase, ST, 

aritmie, pressione cardiaca, SpO2 ed eventi a tempo). 
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Real Time 
(Tempo reale) 

Show Dialog (Mostra finestra 
di dialogo) 

Selezionare gli eventi per visualizzare una finestra di dialogo all'inizio. 
Cancellare gli eventi per impedire la visualizzazione della finestra di dialogo. 

Print Page Format (Formato 
pagina di stampa) 

Selezionare l'opzione richiesta per il formato di stampa. 

Scheda e scheda 
secondaria Opzione Descrizione 

 Enable Clean Trace (Attiva 
Clean Trace) 

Attiva l'opzione di stampa del ritmo ECG sintetizzato. 

Print Scale Format (Formato 
scala di stampa) 

Selezionare la scala per il formato di stampa. 

ST, Slope Printing (Stampa 
ST, pendenza) 

Selezionare questa opzione per impostare le stampe dei valori ST e pendenza 
ST. 

Enable Rhythm Print (Abilita 
stampa ritmo) 

Attiva il pulsante Rhythm (Ritmo) per l'opzione di stampa continua 
dell'ECG. 

Use last saved BP value 
during the stage (Usa 
l'ultimo valore BP salvato 
durante la fase) 

Selezionare questa opzione per continuare a utilizzare lo stesso valore della 
pressione sanguigna salvato l'ultima volta. Se l'opzione non è selezionata, 
l'ultimo valore della pressione sanguigna non verrà utilizzato. 

Switch to Review 
automatically (Passa 
automaticamente a 
Revisione) 

Selezionare questa opzione per passare automaticamente alla schermata 
Review (Revisione) al termine dell'esame. Quando l'opzione non è 
selezionata, la schermata in tempo reale rimane attiva. 

Constant Time BP measure 
(Misurazione della BP a 
tempo costante) 

Selezionare questa opzione per misurare automaticamente la pressione 
sanguigna a intervalli di tempo (timer separati per le fasi di pre-esame, 
esercizio e recupero). 

BP Alarm Time (Ora allarme 
BP) 

Impostare questo parametro per ricevere un promemoria per la misurazione 
della pressione sanguigna all'ora selezionata prima della fine di ogni momento 
della fase di esercizio dell'esame. 

End of stage Alert (Avviso di 
fine fase) 

Consente di specificare il tempo prima della fine della fase in cui l'avviso 
deve iniziare. 

 
Print User Event (Stampa 
evento utente) 

Selezionare 5 sec Prior and 5 sec Post Request (5 secondi prima e 5 
secondi dopo la richiesta) o 10 sec Prior (10 secondi prima) per 
impostare il tempo dell'ECG stampato in riferimento al tempo in cui viene 
selezionato il pulsante Print (Stampa). 

Remarks 
(Annotazioni) 

 Consente di definire le dichiarazioni che possono essere inserite durante 
l'esame e offline. 

 
Remote View 
(Visualizzazione 
remota) 

 Valido per l' opzione S2. Consente di visualizzare uno studio che ha luogo 
in una qualsiasi delle stazioni di rete, in tutta la rete. Consente a un medico 
di visualizzare uno studio da remoto. 

Tabella 15: Opzioni di configurazione dell'ECG da sforzo 
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Esecuzione dell'esame ECG da sforzo 
Avviare l'applicazione software dell'ECG da sforzo. Viene visualizzata la schermata iniziale. 
Per avviare un nuovo esame 

• Fare clic sul pulsante del menu principale  o premere il tasto F1 della tastiera. 
• Vengono visualizzate la schermata di lavoro per l'esame da sforzo e la schermata di immissione dei dati del paziente. 

Figura 44: Immissione dei dati paziente 
• Immettere i dati del paziente e fare clic su OK. Inizia il monitoraggio delle 12 derivazioni. Dopo circa 15 secondi viene 

visualizzato il valore QRS medio. 

• Utilizzare il pulsante  per verificare la qualità del collegamento degli elettrodi applicati. 

• Se necessario, fare clic sull'icona  per modificare il protocollo di esercizio, passare dal tapis roulant all'ergometro o 
regolare la frequenza cardiaca target e gli altri allarmi. 

Figura 45: Modifica del protocollo di esercizio 
• Immettere la pressione sanguigna. 

• È possibile stampare una pagina dell'ECG di base utilizzando l'icona . 

• Per avviare la sessione di esercizio, fare clic sull'icona  (F3). Il tempo di esercizio viene visualizzato nel pannello 
dei segni vitali sul lato destro. 

 
Durante la fase di esercizio sono disponibili le seguenti opzioni: 

◊ Define and print events (Definisci e stampa eventi). 

◊ Print the ECG screen and continuous Rhythm (Stampa schermata ECG e ritmo continuo). 

◊ Manual control of the treadmill/ergometer (Controllo manuale tapis roulant/ergometro). 

◊ Manage the protocol stages (Gestisci stadi protocollo): Hold stage (Mantieni fase), Advance stage (Avanza fase), Previous 
stage (Fase precedente). 

◊ Change the exercise protocol in the middle (Modifica il protocollo di esercizio al metà). 

◊ Go to Recovery phase (Passa alla fase di recupero). 
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Visualizzazione riproduzione 
Durante un esame da sforzo in tempo reale è possibile visualizzare 10 secondi dell'ECG registrato in una finestra separata. Questa 
opzione è abilitata 10 secondi dopo l'inizio dell'esame da sforzo (disponibile solo con l'opzione chiave software S2). 
 
Per definire il punto di partenza della finestra riproduzione ECG, selezionare Setup → View (Configurazione   Visualizza) e 
individuare la sezione della visualizzazione ECG predefinita. Nel menu a discesa Playback (Riproduzione), viene visualizzata l'opzione 
"Show recent event" (Mostra evento recente). L'attivazione di questa casella di controllo consente di impostare l'inizio della 
riproduzione dall'evento registrato più di recente anziché dall'ultimo punto temporale dell'ECG. Il comportamento predefinito 

(quando la casella di controllo è deselezionata) consiste nell'avviare la riproduzione dall'ora finale dell'intero record ECG. 
Figura 46: Finestra PlayBack (Riproduzione) 

1. Per aprire la finestra PlayBack (Riproduzione), premere  o selezionare la barra spaziatrice. 
2. Navigare con la barra di scorrimento o utilizzando i tasti freccia della tastiera fino all'ora richiesta. 

3. In alternativa, utilizzare i pulsanti  per spostarsi tra le aritmie rilevate e gli eventi utente. 

4. Fare clic sul pulsante  per definire un nuovo evento. 
5. Premere nuovamente su Playback (Riproduzione) o sul tasto della barra spaziatrice per chiudere la finestra PlayBack 

(Riproduzione). 
 

Per questa azione Fare clic su questa 
icona 

Descrizione 

Stampare la pagina 
dell'ECG 

 

 

Stampa la schermata ECG corrente (crea 
automaticamente un nuovo evento) 

Contrassegnare un 
nuovo evento 

 

 

Definisce il contrassegno di un nuovo evento 

Spostarsi tra eventi e 
stadi 

 

 

Consente di passare al contrassegno dell'evento 
precedente o successivo 

Impostare il layout 
dello schermo 

 

 

Consente di impostare il layout dei tracciati 
ECG 

Selezionare la 
derivazione del 
tracciato 

 
Consente di modificare la derivazione del 
tracciato 

Filtrare l'ECG 
 

Consente di attivare/disattivare i filtri dell'ECG 

Scalare 
orizzontalmente 

 

 

Consente di regolare la velocità dei tracciati 
ECG (velocità) 

Scalare verticalmente  

 

Consente di regolare il guadagno dei tracciati 
ECG (guadagno) 

Tabella 16: Barra degli strumenti della finestra PlayBack (Riproduzione) 
  



ND:  NV-100.5988.050|Rev.260224 PC-ECG 1200 Istruzioni per l'uso Pagina 79 di 129 

Fase di recupero 

Al termine della fase di esercizio, inizia automaticamente la fase di recupero. Premere l'icona  (F5) per passare alla fase di 
recupero in qualsiasi momento durante la fase di esercizio. Il tempo trascorso della fase di recupero viene conteggiato così come il 
tempo totale trascorso. 

Attendere il completamento della fase di recupero in base al protocollo o interromperla utilizzando l'icona  (F4). I tempi 
dell'esame e del recupero sono finalizzati. I dati non vengono più acquisiti per questo esame. 
Sono disponibili due opzioni per completare un esame da sforzo. 

• Visualizzare automaticamente la schermata dei dati di post-elaborazione (schermata Review (Revisione)) 

• Rimanere nella visualizzazione dell'ECG. 
 

Per visualizzare automaticamente la schermata Review (Revisione) 
In Setup (Configurazione), fare clic sulla scheda Real-Time (Tempo reale) e selezionare Switch to Review Automatically (Passa 
automaticamente alla revisione). 

Al termine del protocollo dell'esame o dopo aver fatto clic sull'icona  (F4), il display passa automaticamente alla schermata 
Review (Revisione) e vengono visualizzate le informazioni di post-elaborazione. 
 

Per visualizzare manualmente la schermata Review (Revisione) 
Se l'opzione Switch to Review Automatically (Passa automaticamente alla revisione) non è abilitata durante la configurazione, il 
segnale ECG continua a essere eseguito al termine dell'esame. 

• Per aprire la schermata Review (Revisione), premere F9. 
 

Visualizzazione dei risultati 
La visualizzazione dei risultati è disponibile nella schermata Review (Revisione) al termine dell'esame. 
La schermata Review (Revisione) viene visualizzata con i dati di post-elaborazione. Fornisce le seguenti opzioni: 

◊ Convalidare e modificare i risultati dell'esame quali FC, ST, PS, SpO2, ST/Indice, FC ecc. 

◊ Scrivere le conclusioni. 

◊ Visualizzare, salvare e stampare i tracciati ECG. 

◊ Stampare i referti. 

◊ Eseguire misurazioni ECG (opzionale). 

◊ Inviare via e-mail i risultati dell'esame. 

◊ Generare referti in formato PDF (opzionale). 

◊ Rianalizzare il tratto ST. 
 

Per salvare i risultati dell'esame 
• Fare clic su File > Save (File > Salva), definire il nome e il percorso del file e fare clic su OK. 

 

Informazioni sulla frequenza cardiaca target negli esami da sforzo 

Frequenza cardiaca a riposo 
Misurata durante la fase di riposo del paziente, in genere è compresa tra 60 e 100 bpm. 
 
Come misurare la frequenza cardiaca a riposo 

• Monitoraggio con dispositivo ECG nella fase di riposo dell'esame da sforzo. 
• Il valore può essere misurato manualmente. Contare il numero di battiti in un minuto, ovvero la FC a riposo. 

 

Frequenza cardiaca massima prevista 
La formula più comunemente utilizzata consiste nel sottrarre l'età da 220. 
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Frequenza cardiaca target 
Espressa in percentuale, di solito è definita tra il 50% e l'85% della frequenza cardiaca sicura massima prevista (vedere l'esempio di 
seguito). 
 
Esempio: Maschio di 58 anni 
Frequenza cardiaca MASSIMA prevista: 162 bpm (220 - 58) 
Il livello di esercizio del 50% sarebbe di 81 bpm (162 * 0,5=81) 
Il livello di esercizio dell'85% sarebbe di 138 bpm (162 * 0,85=138) 
La frequenza cardiaca target per una persona di 58 anni è compresa tra 81 e 138 battiti al minuto. 
 

Stima dell'equivalente metabolico (METS) 
Una funzionalità molto importante del software è la stima dell'equivalente metabolico (Metabolic Equivalency - METS). Il valore stima 
la quantità di ossigeno prodotta dal corpo per ogni kg di peso al minuto. I risultati sono mostrati in unità di METS o VO2 Max. 
(un'unità di VO2 è pari a 3,5 unità METS). 
1 MET corrisponde a una persona a riposo. 
Un MET più alto indica un livello di forma fisica più elevato. 
 

File di trasferimento "Trnsf.txt" 
Utilizzare questa opzione quando PC-ECG 1200 condivide lo stesso PC con un'altra applicazione in tempo reale. 

Per trasferire un file 
• Fare clic su Setup > Environment (Configurazione > Ambiente). 
• Fare clic sulla scheda Advance (Avanzate). 
• Selezionare l' opzione Use transfer file "Trnsf.txt" (Usa file di trasferimento "Trnsf.txt"). 

Un file di trasferimento viene creato nella directory contenente i dati del programma dell'applicazione per l'esame da sforzo. Il percorso 
predefinito è C:\ProgramData\NoravMedical\PCECG\ (C:\Programmi\NoravMedical\PCECG\). Il file di trasferimento riceve i 
dati in tempo reale dall'applicazione per l'esame da sforzo, come frequenza cardiaca corrente, carico di lavoro, velocità e pendenza, 
distanza di cammino, RPM, pressione sanguigna ed SpO2. È un file di testo, aggiornato ogni secondo, che 
presenta il seguente formato: ogni riga di testo inizia con un'intestazione descrittiva e un parametro che inizia sempre al numero di 
caratteri 13. Il valore di ciascun parametro può variare durante l'esame. 
 

Parametro Esempio di 
valore 

Intervallo Unità Annotazione 

System (Sistema): Treadmill (Tapis 
roulant) 

Treadmill (Tapis roulant), 
Ergometer (Ergometro) 

 Sistema per l'esame da sforzo 

Protocol (Protocollo): Modified 
(Modificato) 
Bruce 

  Nome del protocollo di esercizio 

Phase (Fase): Exer (Esercizio) Chck (Controllo), Base, 
Warm (Riscaldamento), 
Exer (Esercizio), Cool 
(Raffreddamento), Reco 
(Recupero), Stop 
(Arresto) 

 Nome della fase del protocollo di esercizio 

Speed (Velocità): 3,3 Da 0 a 25,0 miglia/h Solo per tapis roulant 
Grade (Grado): 10,5 Da 0 a 30,0 % Solo per tapis roulant 
Distance (Distanza): 1,201 Da 0 a 100,000 miglio Solo per tapis roulant 
 
Workload (Carico di 
lavoro): 

 
120 

 
Da 0 a 1000 

 
 
watt 

Per gli ergometri viene misurata. Per i tapis 
roulant viene stimata in base alla formula: 

 
(VELOCITÀ in miglia/h, pendenza in percentuale, 
PESO CORPOREO in kg) 

RPM: 47 Da 0 a 300 1/min Solo per ergometro. Rotazione/min 
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HR (FC): 86 Da 0 a 300 bpm Frequenza cardiaca 
Systolic (Sistolica): 203 Da 0 a 300 mmHg PA sistolica 
Diastolic (Diastolica): 78 Da 0 a 300 mmHg PS diastolica 
ST: -7,3 Da -20,0 a 20,0 mm Deviazione del tratto ST 

(per la derivazione ECG più significativa) 
Slope (Pendenza): 78,8 Da -100,0 a 100,0 mV/sec Pendenza del tratto ST 

(per la derivazione ECG più significativa) 
SpO2 : 97 Da 0 a 100 % In %. Saturazione dell'ossigeno nel sangue 
(il valore ?? viene visualizzato in caso di errore, fuori intervallo o se il parametro è n/d) 

Tabella 17: Formato file di trasferimento 

Esportazione dei valori in tempo reale del protocollo di esercizio 
Utilizzare questa opzione quando l'ECG da sforzo condivide le misurazioni del protocollo da sforzo con un'altra applicazione in 
tempo reale. I dati del protocollo vengono memorizzati in un file di testo a riga singola. 

Per attivare la funzione di esportazione del file del protocollo di esercizio 
• Fare clic su Setup > Environment (Configurazione > Ambiente). Fare clic sulla scheda Advance (Avanzate). 
• Selezionare Check Use real time protocol export file (Usa file di esportazione protocollo in tempo reale). 
• Inserire il nome completo del file di esportazione, compreso il percorso della directory. 

Un file di esportazione viene creato nella directory specificata. Il file di esportazione riceve i dati in tempo reale dall'applicazione per 
l'esame da sforzo, quali: nome fase, tipo di dispositivo per l'esame da sforzo (tapis roulant o ergometro), velocità o carico di lavoro, 
grado o RPM, frequenza cardiaca, pressione sanguigna, valore e pendenza ST. È un file di testo, aggiornato ogni secondo, che 
 
Formato del file di esportazione 
[AAAA~BBBB~C~DDDD~E~FFFF~GGG~HHHH~IIII~JJJJJ~KKK~LLLL~MMMM~]NNPP 
(dove uno spazio viene visualizzato come "~") 
AAAA: nome della fase e dello stadio combinati  

“Chck”: inizializzazione 
“Base”: fase base (Stadio riposo) 
“Warm”: fase di riscaldamento (fase di riscaldamento manuale pre-esame) “Exer”: fase di esercizio (fasi da sforzo). 
“Reco”: fase (tutte le fasi di recupero) 
“Stop”: fine dell'esame (post elaborazione, nessun ECG in corso)  

BBBB : valore del parametro di carico 1  
C: designatore del parametro di carico 1 

M : velocità del tapis roulant in [0,1 miglia/h]  
K : velocità del tapis roulant in [km/h]  
W : carico ergometro [Watt] 

DDDD : valore del parametro di carico 2  
E: designatore del parametro di carico 2 

%: pendenza tapis roulant in [0,1 %] 
U: giri dell'ergometro in [/min] = [giri/min] 

FFFF: frequenza cardiaca in [bpm] 
GGG: battiti ectopici ventricolari al minuto (non utilizzati, sempre ~~~0) HHHH : misurazione BP NBR (non utilizzata, sempre -999) 
IIII: pressione sanguigna in [mmHg] (-999 se non disponibile) 
JJJJJ: pressione sanguigna diastolica in [mmHg] (-999 se non disponibile) 
KKKK: livello ST per la derivazione ECG più significativa in [0,01 mV] (-999 se non disponibile) LLLLL: pendenza ST per la derivazione ECG più 
significativa in [0,01 mV/s] (-999 se non disponibile) MMMM: integrale ST per la derivazione ECG più significativa (non utilizzato, sempre -999) 
NN: i2 caratteri ASCII più a destra di checksum espressi esadecimali in MAIUSCOLO  
PP: stringa fissa "CR" per il ritorno a capo. 
 
Esempio 1: collegare il sistema per l'esame ECG da sforzo Norav al sistema CareFusion LAB 5 CPET 
 
Nella configurazione del sistema per l'esame ECG da sforzo Norav: 

Pannello Advanced (Avanzate) della scheda Environment (Ambiente) 
Inserire il nome del file di esportazione "C:\LAB5\DB\ERGOSPIR.DAT" 

Scheda GDT\BDT 
• Selezionare la casella di controllo Import from GDT\BDT (Importa da GDT/BDT) 
• Inserire il percorso "C:\LAB5\DB\" per la directory dei dati GDT\BDT 
• Inserire il testo "Hell" nel campo Token for PC-ECG (Token per PC-ECG)  
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Nella configurazione del sistema CareFusion LAB5 CPET: 
• Selezionare Extern ECG (ECG esterno) per lo strumento di configurazione Oxycon. 
• Eseguire il comando Service-Login (Accesso servizio). 
• Aprire Settings (Impostazioni) e selezionare Norav dall'elenco ECG-Type (Tipo ECG). 
• Nel campo Path and program name (Percorso e nome programma), selezionare Stress.EXE 
• Nome dell'eseguibile dell'applicazione con percorso completo. 
• Inserire Stress (Sforzo) nel campo Title: Use the text in ECG application (Titolo: usa testo 

nell'applicazione ECG) 
• Inserire "C:\LAB5\DB\" nel campo Path: When ECG is not located … (Percorso: quando l'ECG non è 

posizionato…). 
 
 

 
Esempio 2: collegare il sistema per l'esame ECG da sforzo Norav al sistema MetaSoft®Studio v4.6.0 CORTEX CPET 
 
Nella toolbox MetaSoft®Studio v4.6.0 CORTEX: 

• Selezionare Test Equipment/Device Configuration (Testa configurazione apparecchiatura/dispositivo) e aggiungere 
un ECG Norav. 

• Selezionare Special Settings/Software Interfaces/ECG Systems/Norav (Impostazioni speciali/Interfacce 
software/Sistemi ECG/Norav) e configurare una directory dei file di dati. Assicurarsi che non contenga spazi e che sia 
scrivibile dall'utente che esegue Norav Stress.exe e Metasoft. Ad esempio: "C:\CORNOR". Salvare e uscire dalla toolbox. 

 
Nella configurazione del sistema per l'esame ECG da sforzo Norav: 

Scheda GDT\BDT 
• Abilitare la casella di controllo Import from GDT\BDT (Importa da GDT\BDT). 
• Configurare GDT\BDT Data Directory (Directory dati GDT/BDT) in modo che sia uguale alla directory dei 

file di dati dalla fase "b" nella configurazione MetaSoft®Studio riportata sopra. Ad esempio: "C:\CORNOR" 
• Inserire "HELL" come Token for PC ECG (Token per ECG PC) 
• Inserire "MSS" come Token for Practice EDP (Token per EDP struttura)  

Pannello Advanced (Avanzate) della scheda Environment (Ambiente) 
• Abilitare la casella di controllo "Use real time protocol export file" (Usa file di esportazione protocollo in 

tempo reale) e digitare la posizione del file di comunicazione ERGOSPIR.DAT in modo che corrisponda al nome 
della directory dell'interfaccia GDT selezionata in precedenza. Ad esempio: "C:\CORNOR\ERGOSPIR.DAT" 

 
Funzionamento (per ogni singolo esame del paziente): 

Figura 47: Impostazioni CPET LAB5 CareFusion 
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• Stato iniziale: MetaSoft®Studio aperto e il sistema per l'ECG da sforzo Norav chiuso 
• Avviare il sistema per l'ECG da sforzo Norav dal tasto di scelta rapida sul desktop. 
• In MetaSoft®Studio, selezionare un flusso di lavoro, quindi passare alla visualizzazione Perform CPET (Esegui 

CPET). 
• L'applicazione ECG da sforzo passa automaticamente alla modalità di monitoraggio. 
• Da questo momento, l'esame è controllato dall'applicazione dell'ECG da sforzo. 
• Al termine dell'esame CPET, uscire dal programma ECG da sforzo. 
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Modalità operativa Slave 
Utilizzare questa opzione quando il sistema per l'ECG da sforzo funziona insieme ad altre apparecchiature, ad esempio per eseguire 
l'esame da sforzo cardiopolmonare (CPET/CPX), dove il tapis roulant/l'ergometro, la PS ecc. e le fasi/gli stadi dell'esame sono 
controllati dal sistema esterno. La funzionalità viene implementata tramite il file esterno generato sul lato del sistema esterno. 

Per abilitare la modalità operativa Slave 
• Fare clic su Setup > Environment (Configurazione > Ambiente).  
• Fare clic sulla scheda Advance (Avanzate). 
• Selezionare l'opzione Slave mode operation via external control file (Funzionamento modalità Slave tramite file di 

controllo esterno). 
• Inserire il nome completo del file di controllo, compreso il percorso della directory. 

 
All'avvio di un nuovo esame, il sistema esterno aggiornerà costantemente il file di controllo con i dati in tempo reale. L'applicazione 
dell'ECG da sforzo legge il file di controllo e aggiorna le informazioni sul pannello dei segni vitali. 
 
Formato del file di controllo 
[AAAA~BBBB~C~DDDD~E~FFFF~GGGG~HHHH~IIII~JJJJ~KKKK~LLLL~MMMM]NNPP 
(dove uno spazio viene visualizzato come "~") 
 
AAAA: fase combinata e nome stadio “Chck (Contr.)” : inizializzazione 

“Base”: fase base (Stadio riposo) 
“Warm”: fase di riscaldamento (fase di riscaldamento manuale pre-esame) “Exer”: fase di esercizio (fasi da sforzo). 
“Reco”: fase (tutte le fasi di recupero) 
“Stop”: fine dell'esame (post elaborazione, nessun ECG in corso) 

BBBB : valore del parametro di carico 1  
C: designatore del parametro di carico 1 

M : velocità del tapis roulant in [0,1 miglia/h]  
K : velocità del tapis roulant in [km/h]  
W : carico ergometro [Watt] 

DDDD : valore del parametro di carico 2  
E: designatore del parametro di carico 2 

%: pendenza tapis roulant in [0,1 %] 
U: giri dell'ergometro in [/min] = [giri/min] 

FFFF: comando evento 
None (Nessuno) :nesssun evento creato 
Save (Salva): creare l'evento ECG di 10 s. 

GGG: valore VO2 in [ml/min] (-999 se non disponibile)  
HHHH: valore METS x 100 (-999 se non disponibile)  
IIII: pressione sanguigna in [mmHg] (-999 se non disponibile)  
JJJJJ: pressione sanguigna diastolica in [mmHg] (-999 se non disponibile)  
KKKK: valore SpO2 in 0,1 % (-999 se non disponibile) 
LLLLL: intervallo di tempo in secondi dall'inizio dell'esame, valore HEX (-999 se non disponibile) 
MMMM : riservato (sempre -999) 
NN: i2 caratteri ASCII più a destra di checksum espressi esadecimali in MAIUSCOLO 
PP: stringa fissa "CR" per il ritorno a capo. 
 

Funzioni aggiuntive 

Per definire la FC max 
• Aprire un esame nella schermata Review (Revisione) (post-elaborazione). 
• Fare clic su Properties (Proprietà) nella barra degli strumenti. Viene visualizzata la finestra di dialogo Properties (Proprietà). 
• Selezionare la cella con il valore FC più alto. 
• Fare clic su Define Max HR (Definisci FC max). 

La cella selezionata viene evidenziata e il suo colore di sfondo cambia. 
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Per definire l'ST peggiore 
• Aprire un esame nella schermata Review (Revisione) (post-elaborazione). 
• Fare clic su Properties (Proprietà) nella barra degli strumenti. Viene visualizzata la finestra di dialogo Properties (Proprietà). 
• Selezionare una cella in uno dei canali con l'ST peggiore. 
• Fare clic su Define Worst ST (Definisci ST peggiore). 

Le celle nei 12 canali dello stesso evento vengono evidenziate e il colore di sfondo cambia. 

Per definire l'indice ST/FC 
• Aprire un esame in una schermata Review (Revisione) (post-elaborazione). 
• Fare clic su Properties (Proprietà) nella barra degli strumenti. Viene visualizzata la finestra di dialogo Properties (Proprietà). 
• Selezionare la cella con il valore dell'indice ST/CF rilevante. 
• Fare clic sul pulsante Define ST/HR index (Definisci indice ST/FC). 

La cella selezionata viene evidenziata e il suo colore di sfondo cambia. 
 
La schermata di post-elaborazione ora include il valore massimo dell'indice ST/FC nella scheda General (Generale) e lo aggiunge come 
nuova colonna nella tabella Test Result (Risultati esame). L'indice è applicabile solo quando viene rilevato un abbassamento del tratto 
ST e la variazione della frequenza cardiaca supera i 10 bpm rispetto alla linea di base. Se queste condizioni non vengono soddisfatte, 
viene visualizzato "-". I valori sono ricalcolati quando i valori FC o ST vengono aggiornati dall'utente. 

Funzione "Dynamic ST" (ST dinamico) 
Questa funzione visualizza automaticamente la derivazione con il tratto ST peggiore corrente nel display del valore QRS medio, nella 
parte superiore destra dello schermo. 
Per abilitare questa funzione: 

• In Setup (Configurazione), scegliere l'opzione View (Visualizza) e nella parte inferiore di Real time Average QRS (QRS 
medio in tempo reale) selezionare Dynamic (Dinamico) (ST caso peggiore). 

• Passare a ST, VPB Options (ST, opzioni VPB) e selezionare l'opzione necessaria per Worst Case ST Report (Referto 
caso ST peggiore). 

Funzione "Clean Trace" (Pulisci tracciato) 
Stampa del ritmo ECG sintetizzato in cui i battiti mediani vengono filtrati e collegati, creando un tracciato più chiaro e preciso. Nella 
parte inferiore della stampa verrà sempre visualizzato un tracciato del ritmo con dati non elaborati. 
I battiti ectopici sono esclusi dal processo e mostrati nella loro forma originale come tracciati in cui la qualità originale è estremamente 
bassa. 
 
Per abilitare questa funzione: 

• Nella scheda Real Time (Tempo reale), abilitare la casella di controllo Clean Trace (Pulisci tracciato). 
• Selezionare il formato di stampa 3x4 o 6x2. 

 
Nota 

Le funzioni Dynamic ST (ST dinamico) e Clean Trace (Pulisci tracciato) sono disponibili esclusivamente con il 
software S2 Advanced Stress. 

 

Referto riassuntivo configurato 
L'utente formatta il testo descrittivo e seleziona i campi di dati per creare il modello di referto. Il sistema unisce automaticamente testo 
e dati in base al modello selezionato. 
 
Per stampare il referto riassuntivo configurato 

• Fare clic sul pulsante Print (Stampa) nel menu principale per aprire il pannello di selezione dei referti finali. 
• Selezionare la casella di controllo Configured Summary Report (Referto di riepilogo configurato). 
• Fare clic su Edit Summary (Modifica riepilogo) per visualizzare l'anteprima del referto. 
• Il referto verrà aperto nella finestra Report Editor (Editor referti) 
• Se necessario, selezionare un altro modello dall'elenco Templates (Modelli). 
• Modificare il testo del referto. 
• Fare clic sul pulsante OK nella parte superiore dell'editor referti per salvare le modifiche. 
• Infine, fare clic sul pulsante Print Reports (Stampa referti) per stampare i referti selezionati. 
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Per creare o modificare un modello per il referto riassuntivo configurato 
• Aprire la scheda Setup/Printouts (Impostazione/Stampe). 
• Fare clic sul pulsante Change (Modifica) accanto al parametro Configured Summary (Riepilogo configurato). 
• Selezionare il modello desiderato nell'elenco, quindi fare clic su Edit (Modifica). 
• Modificare il testo del modello di referto nella finestra Template Editor (Editor modelli). 
• Utilizzare il menu Insert Report Item (Inserisci voce referto) per immettere valori quali nome paziente, data di nascita, 

protocollo, indice ST/FC, ecc. 
• Visualizzare in anteprima il referto di esempio nel pannello di destra. 
• Salvare le modifiche al modello e chiudere la finestra Template Editor (Editor modelli). 
• Selezionare il modello desiderato nell'elenco, quindi fare clic su Set Active (Imposta attivo) per contrassegnarlo come 

predefinito. 
 

Tipi di tapis roulant controllati tramite RS232 
Fornitore Modello Fax del fornitore E-mail Connettore RS232 

sul tapis roulant 
Tipo di cablaggio 
RS232 

Norav/Trackmaster TMX425 +1-316-283-3350  DB9 femmina Diritto 
TMX428 +1-316-283-3350  USB, DB9 femmina Diritto 

 
GE/Marquette 

 
Serie 2000 

  DB9 femmina 
(RS422) 

M422* 

 DIN 8 pin femmina Tx –5 
Rx – 4 
GND - 2 

Cardiac Science 
/QUINTON 

TM-55  internationalservice
@ 
cardiacscience.com 

DB9 femmina Diritto 
ST-55, ST-65  DB9 femmina 

(RS422) 
Q422* 

HP COSMOS/ 
Schiller 

Tutti i modelli +49-8669-864249  DB9 femmina Incrociato 

Lode Valiant 110082   DB9, femmina Incrociato 
OEM2   USB  

Woodway PPS55-MED   DB9 maschio Incrociato 
Technogym C-Safe Protocol     
RAM 770 +39-049-8703388  DB9 femmina Diritto 
SBI      

Powerjog GM, J +44-121-4333035    
System Biomedical  +91-22-4963147    
 
KIP Machines 

 
Serie KIP 

+5411-4327-2963 
+54341-464-7302 
+54341-463-7919 

 DB9 maschio Linee: RX, TX, 
posizione standard 
GND in DB9 
Connettore maschio 

 
 
BONTE 
MACHINEFABRIEK 
B.V. 

 
 
Bonte 

 
 
+ 31 038-4554030 

  
 
DB9, incrociato 

Tapis roulant (SUB- 
D 25) < > PC 
(SUB-D 25) 

2 3 
3 2 

7 7 
Bonte2     

Parker PM +1-334-8213221  DB9 femmina Diritto 
Parker Parker 1200     
Micromed Micromed     

 
 
Minato 

 
 
AR-100 

   
D-SUB 25P 
maschio 

Dritto, 
D-SUB 25 < > 
PC (D-SUB 25) 
2 2 
3 3 
7 7 
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* Richiede un adattatore speciale, fornito da Norav Medical 
Tabella 18: Tapis roulant controllati 

  



ND:  NV-100.5988.050|Rev.260224 PC-ECG 1200 Istruzioni per l'uso Pagina 88 di 129 

Ergometri controllati da RS232 
Fornitore Modello Fax del 

fornitore 
Connettore 
RS232 
sull'ergometro 

Tipo di 
cablaggio 
RS232 

Nota 

Ergometro 
analogico 

AE 1    Nessuna conferma digitale (controllo 
a circuito aperto) 

Ergometro 
analogico 

AE 2 (conferma)    Fornisce un feedback di conferma del 
carico 

Dimek 770 +49-30-
72376240 

   

Elmed      
Elmed (con PS)    Con modulo per pressione sanguigna 

automatico 
Daum Ergobike    Serie Daum Electronic “ergo_bike” 
Daum Ergofit    Ergometri per uso medico ERGO-

FIT 
Ergoline ER900 +49-7431-

989427 
DIN femmina 
a 5 pin 

 Modelli standard (senza modulo PS) 

Ergoline (con PS) +49-7431-
989427 

  Modelli con modulo PS automatico 

Ergosana  +41-41-
7618022 

DB9 femmina Diritto Modelli standard (senza PS) 

Ergosana (con PS) +41-41-
7618022 

  Modelli con modulo PS automatico 

HP Cosmos      
HP Cosmos (con PS)     
Konami Aerobike 75XLIII  D-sub 25 

femmina 
Incrociato Interfaccia di base: nessun checksum, 

nessuna conferma 
Lode BV Corival  DB9 femmina Diritto  
Lode BV Excalibur     
Mitsubishi StrengthErgo8  DB9 maschio Incrociato  
Monark Monark, Monark 

839E 
 DB9 maschio Incrociato  

Bicicletta 
elettrica 

(con PS)     

Seca CT100 +49-40-
20000050 

DB9 maschio Incrociato  

Technogym C-Safe Protocol    Utilizza il protocollo C-Safe standard 
Tunori T-Protocol  DB9 femmina 

(connettore T) 
 Interfaccia PC Tunturi (T-Protocol) 

Tabella 19: Egometri controllati 
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MEDIA SEGNALE DEI POTENZIALI TARDIVI 
(Questa opzione è disponibile con la licenza L1) 

 
Figura 48: Schermata Late Potential Signal Averaging (Media segnale dei potenziali tardivi)  

 

Avvio rapido 
Per avviare un nuovo esame 

• Fare clic su F1 (o sul pulsante New (Nuovo) sulla barra degli strumenti). 
• Inserire i dettagli del paziente nella finestra di dialogo. 
• Fare clic su OK. 
• Fare clic su F3 o F4 per avviare il test di media PT. 
• Immettere il nome dell'intervallo e/o le annotazioni secondo necessità nella finestra di dialogo e fare clic su OK. 
• Fare clic su F3 o F4(o sul pulsante Start/Stop Averaging (Avvia/Arresta calcolo media)) per interrompere il test della 

media PT (o attendere il termine). 
 
Per stampare 

• Fare clic su F6 o selezionare Print item (Stampa elemento) dal menu File. 
• Selezionare la stampante dalla finestra di dialogo Print (Stampa). 
• Fare clic su OK per chiudere la finestra di dialogo e stampare la visualizzazione (il referto della media PT o l'esame ECG). 

 

Utilizzo dei tasti funzione 
 

F1 Nuova registrazione 

F3/F4 Avvio/Arresto 

F6 Stampa 

F11 Aprire lo studio salvato 

Tabella 20: Tasti funzione Media segnale PT 
 
Per un esempio di referto stampato, vedere l'Appendice C. 
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Leads (Derivazioni) 
La registrazione viene eseguita per le derivazioni X, Y e Z (ortogonali) utilizzando il normale cavo a 12 derivazioni. Sistemare le 
derivazioni come segue: 

 
 
12 derivazioni Derivazione ortogonale (posizione) 

V1 X- (quarto spazio intercostale destro, linea ascellare media) 

V2 X- (quarto spazio intercostale sinistro, linea ascellare media) 

V3 Y- (aspetto superiore del manubrio dello sterno) 

V4 Y+ (cresta iliaca sinistra) 

V5 Z- (direttamente da posteriore a Z positivo) 

V6 Z+ (quarto spazio intercostale appena a sinistra dello sterno) 

RA, LA, LL, RL Stessa posizione dell'ECG a riposo a 12 derivazioni 

Figura 49: Posizionamento delle derivazioni per la media del segnale PT 
 

Configurazione media segnale PT 
Fare clic su Setup (Configurazione) sulla barra degli strumenti per accedere ai seguenti parametri: 
 
Scheda Opzione Descrizione 

 
 
 
 
 
 
 
 
 
 
 
ECG 
Recording 
(Registrazione 
ECG) 

Auto Save (Salvataggio auto) 
(opzioni di salvataggio) 

Quando l'opzione Auto Save (Salvataggio auto) è attivata, il 
file viene memorizzato per cognome o per ID. 
Quando l'opzione Auto Save (Salvataggio auto) è disattivata, il 
programma richiede un nome file. 

Set File Name by (Imposta 
nome file per) (opzioni di 
salvataggio) 

Impostare la convenzione di denominazione per il salvataggio 
dei file (per cognome o ID paziente) 

Simulator ECG (ECG 
simulatore) 

Se l'opzione è deselezionata (impostazione predefinita), la 
registrazione ECG è eseguita dall'unità PC-ECG. 
Se invece è selezionata, la registrazione ECG viene eseguita 
dal file demo incluso nel pacchetto software. L'unità di 
registrazione non è necessaria. 

Stop to confirm QRS (Arresta 
per confermare QRS) 

Quando l'opzione è attivata, l'utente può scegliere il valore 
QRS normale. 
Quando l'opzione è disattivata, il programma sceglie 
automaticamente il valore QRS normale. 

QRS Template Correlation 
(Correlazione modello QRS) 

Definisce la corrispondenza percentuale QRS durante la 
media del segnale. Un numero più alto corrisponde a una 
corrispondenza migliore. 

Target Number of Beats 
(Numero target di battiti) 

Numero di battiti cardiaci tipici che verranno conteggiati 
durante la fase di calcolo della media. 

Use ECG Database (Usa 
database ECG) 

Selezionare questa opzione per connettersi al database ECG 
predefinito. Gli esami ECG vengono salvati nel database. 

Data Directory (Directory 
dati) 

Definisce la directory per le registrazioni ECG salvate. 
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View (Visualizza) 

ECG's Colors (Colori ECG) Per modificare i colori dell'ECG, fare clic sul pulsante 
appropriato e selezionare il colore dalla tavolozza. 

Averages Color (Colore 
medie) 

Per modificare i colori nella finestra Averages (Medie), fare 
clic sul pulsante appropriato e selezionare il colore dalla 
tavolozza. 

HR Trend’s Color (Colore 
trend FC) 

Per modificare i colori nella finestra HR Trend (Trend FC), 
fare clic sul pulsante appropriato e selezionare il colore dalla 
tavolozza. 

Restore Defaults (Ripristina 
impostazioni predefinite) 

Fare clic per ripristinare i colori predefiniti di fabbrica. 

 
 
 
Installation 
(Installazione) 

 Salva i dati dell'ospedale e del medico. Questi dati sono inclusi 
nella stampa e nell'e-mail. 

Measurement Standard 
(Standard di misurazione) 

Consente di definire se le misurazioni verranno calcolate in 
base al sistema metrico o allo standard USA. Impostazione 
predefinita: sistema metrico. 

Magnetic Card Reader (Lettore 
schede magnetiche) 

Selezionare questa opzione per utilizzare una scheda 
magnetica con codice a barre per inserire i dati del paziente. 
Selezionare il tipo di scheda magnetica. 

 
 
 
 
 
Environment 
(Ambiente) 

Connection (Collegamento) Utilizzare il pulsante di opzione (porta COM/USB) per 
selezionare la porta per il collegamento del dispositivo. 
Se è selezionata la porta COM, selezionare l'ingresso seriale 
per l'unità PC-ECG dall'elenco delle porte COM. 
Selezionando il collegamento USB, l'elenco di selezione COM 
PC-ECG viene disabilitato. (Impostazione predefinita al 
momento dell'installazione: USB). 

Graph paper (Carta per 
grafici) 

Se l'opzione è attivata, il sistema stampa quadrati da 1 mm e 5 
mm sulle stampe. La griglia normale viene stampata da tutte le 
stampanti. 
L'opzione Improved Grid (Griglia migliorata) mostra una 
griglia sottile ma potrebbe non funzionare su alcune 
stampanti. 

Use large fonts for remarks 
(Usa caratteri grandi per le 
annotazioni) 

Ingrandisce il carattere per il testo libero. 

Color printouts (Stampe a 
colori) 

Deselezionare questa opzione per forzare la stampa in 
bianco e nero sulla stampante a colori. 

Display Size (Dimensioni del 
display) 

Questa impostazione è necessaria per visualizzare l'ECG e 
la griglia nella scala corretta. 

 
 
 
 
 
 

GDT/BDT 
Format 
(Formato 
GDT/BDT) 

Automatic Options (Opzioni 
automatiche) 

Definire le opzioni automatiche per il salvataggio e/o 
l'importazione dei file in formato GDT/BDT. 

File Format (Formato file) Consente di selezionare il formato del file: GDT o BDT 

Import Codepage 437 
(Importa Codepage 437) 

Selezionare l'opzione per importare la Codepage 437. 

Export Codepage 437 
(Esporta Codepage 437) 

Selezionare l'opzione per esportare la Codepage 437. 

Edit Labels (Modifica 
etichette) 

Fare clic su questo pulsante per aprire una finestra di 
dialogo con un elenco modificabile delle etichette dei 
campi utilizzato nei file GDT e BDT. 

GDT/BDT Data directory 
(Directory dati GDT/BDT) 

Consente di specificare il percorso della directory in cui 
conservare i file GDT/BDT. 

Token for PCECG (Token 
per PCECG) 

Impostazione predefinita: PEKG. 

Token for Practice EDP 
(Token per Practice EDP) 

Impostazione predefinita: EDV1. 

 
Holter File 
Path 
(Percorso file 
Holter) 

Download Flash Card 
Program (Percorso 
programma download scheda 
flash) 

Definire il percorso per la directory di programma della 
scheda flash. 

Download Directory 
(Directory di download) 

Definire la directory per la manutenzione dei file Holter 
scaricati. 

Tabella 21: Configurazione media segnale PT 
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Barra degli strumenti e menu 
 

Per questa azione 
Fare clic 
su questa 

icona 

Oppure 
utilizzare 

questo 
tasto di 
scelta 
rapida 

 
Oppure 

selezionare 
questo menu 

 
Descrizione 

 
 
Avviare un nuovo 
esame 

 
 

 

 
 

F1 

 
 
File > New 
(File > Nuovo) 

Avvia una nuova registrazione XYZ. I dati anagrafici del 
paziente possono essere immessi prima della registrazione 
ECG (opzionale). I tre canali vengono visualizzati sullo 
schermo per l'assicurazione della qualità. Se i risultati non 
sono soddisfacenti, controllare la preparazione della cute e i 
contatti degli elettrodi monouso. Quindi fare clic su 
Start/Stop Averaging (Avvia/Arresta calcolo media). 

Aprire un esame 
esistente 

 

 

F11 File > Open 
(File > Apri) 

Apre un esame esistente 

Salvare una 
registrazione 

 

 

Ctrl+S. File > Save 
(File > Salva) 

Salva la registrazione su disco. 

Inviare i dati 
tramite e-mail 

 

 

 File >Send… 
(File > Invia…) 

Invia i dati di registrazione tramite e-mail, se presenti sul 
computer. 

Stampare i 
risultati  

 

 

F6 File > Print 
Setup (File > 
Configurazione 
stampa) 

Stampa l'esame attivo 

 
 
Importare i dati 
demografici da 
HIS a PC-ECG 

  File > Format 
DT/BDT 
(Formato 
GDT/BDT) 
Per i dettagli, 
vedere 
Importare da 
GDT/BDT 

 
Questo file contiene sempre i dati dell'ultimo paziente. 

 
 
Esportare il file 
GDT/BDT da 
PC-ECG a HIS 

  File > Format 
DT/BDT 
(Formato 
GDT/BDT) 
Per i dettagli, 
vedere Salvare 
esame in 
GDT/BDT 

 
 
 
 
Questo file contiene sempre i dati dell'ultimo paziente. 

 
Impostare/Modifi
care i dati del 
paziente 

 

 

  
View > Patient 
Data (Visualizza 
> Dati 
paziente) 

Aggiunge questi dati alla registrazione. Vengono stampati 
insieme ai tracciati ECG. Se la registrazione viene salvata, i 
DATI DEL PAZIENTE vengono salvati insieme ai 
tracciati ECG. Utilizzare l'opzione Previous (Precedente) 
se lo stesso paziente viene sottoposto a un secondo esame. 

Aggiungere/visua
lizzare le 
annotazioni 

 

 

 View > 
Remarks 
(Visualizza > 
Annotazioni) 

Consente di digitare testo libero durante o dopo la 
registrazione ECG. Viene stampato e salvato insieme ai 
tracciati ECG. 

Impostare le 
preferenze 

 

 

Ctrl+T. View > Setup 
(Visualizza > 
Configurazione) 

Visualizza la finestra di dialogo di impostazione e consente 
all'utente di personalizzare le preferenze operative. 

Visualizzare le 
informazioni 

 

 

 Help > 
About… 
(Guida > 

Visualizza il numero di versione del software (che deve 
essere citato in qualsiasi richiesta relativa al software). 
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Informazioni 
su…) 

Visualizza anche le dimensioni della memoria e lo spazio 
libero su disco. 

 
Avviare/Arrestare 
il calcolo della 
media 

 

 

 
F3/F4 

ECG > 
Start/Stop 
Averaging 
(ECG > 
Avvia/Arresta 
calcolo media) 

Consente all'utente di avviare il periodo di calcolo della 
media. Periodo di calcolo della media predefinito: 200 
battiti. Può essere modificato in OPTIONS (OPZIONI), 
ECG RECORDING (REGISTRAZIONE ECG) e 
TARGET NUMBER (NUMERO DI DESTINAZIONE) 

 
Per questa 

azione 

Fare 
clic 
su 

ques
ta 

icon
a 

Oppure 
utilizzar
e questo 
tasto di 
scelta 
rapida 

 
Oppure 

selezionare 
questo 
menu 

 
Descrizione 

Visualizzare/
Nascondere la 
griglia 

 

 
 

View > Grid 
(Visualizza > 
Griglia) 

Visualizzazione opzionale di una griglia da 5 mm. Le 
stampe sono sempre con la griglia da 1 mm. 

Avviare il 
monitoraggio
. 

 

 

 
F2 

ECG > 
Start/Stop 
Monitoring 
(ECG > 
Avvia/Arrest
a 
monitoraggi
o) 

 
Avvia il monitoraggio. 

Interrompere 
il 
monitoraggio 

 

 
 

F2 
ECG > 
Start/Stop 
Monitoring 
(ECG > 
Avvia/Arrest
a 
monitoraggi
o) 

 
Arresta il monitoraggio. 

Attivare il 
contrassegno 
per l'esordio 

 

 Ctrl+ ECG Onset 
marker 
(Contrassegn
o esordio 
ECG) 

Consente all'utente il contrassegno dell'esordio utilizzando 
le icone delle frecce di direzione. 

Attivare 
l'indicatore di 
offset 

 

 Ctrl+ ECG Offset 
marker 
(Contrasseg
no offset 
ECG) 

Consente all'utente di spostare il contrassegno di offset 
utilizzando le icone delle frecce di direzione. 

Spostare i 
contrassegni 
On e Off 

/ 
   

Consente all'utente di spostare i contrassegni ON/OFF. 

Tabella 22: Barra degli strumenti e menu LP Signal Averaging (Media segnale PT) 
 

Interpretazione dei risultati 
Quando la fase di calcolo della media del segnale è completa, viene visualizzata la schermata dei risultati: 
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Figura 50: Schermata di revisione della media del segnale PT 

 

Risultati numerici 
I risultati vengono calcolati automaticamente. È possibile escludere il posizionamento automatico dei contrassegni di 
INSORGENZA/OFFSET con i tasti di direzione. 
 
Averaged Beats (Media battiti) Visualizza il numero di battiti normali medi acquisiti durante lo studio. 

HR Average in beat/min/(Media 
FC in battiti/min) 

 

High Frequency QRS Duration in 
Milliseconds from Onset to Offset 
(Durata QRS alta frequenza in 
millisecondi dall'insorgenza 
all'offset) 

Visualizza la larghezza del QRS filtrato contenente solo le alte frequenze. 
Un numero più alto indica un rischio maggiore per il paziente. 

RMS LASTS 40 milli-seconds in 
Microvolts (RMS DURA 40 
millisecondi in microvolt) 

Visualizza l'attività totale per l'ultima parte (40 ms) del QRS. Un valore più 
basso indica un rischio maggiore per il paziente. 

DURATION UNDER 40 
Microvolts in Milliseconds 
(DURATA INFERIORE A 40 
Microvolts in Milliseconds) 

Mostra il periodo in ms dall'offset del QRS fino al primo punto di attività di 
40 V. Un numero più alto indica un rischio maggiore per il paziente. 

H.F. Noise: in Microvolts (Rumore 
alta frequenza in mocrovolt) 

Garanzia di qualità. Un numero inferiore corrisponde a una maggiore 
accuratezza dei risultati. Il numero massimo non deve superare 1 V. 

Tabella 23: Risultati numerici della media del segnale PT 
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ECG DI MONITORAGGIO 
(Questa opzione è disponibile con la licenza M1) 
Questa opzione consente la registrazione a lungo termine e la memorizzazione su disco. L'utente decide quali derivazioni e a quale 
frequenza di campionamento monitorare sullo schermo e salvare su disco. Durante l'esame, è possibile stampare in tempo reale su una 
stampante termica. 

 
Figura 51: Schermata Monitoring ECG (ECG di monitoraggio) 

Avvio rapido 
Per avviare un nuovo esame 

• Fare clic su F1 (o sul pulsante New (Nuovo) sulla barra degli strumenti). 
• Inserire i dettagli del paziente nella finestra di dialogo. 
• Fare clic su OK. 
• Fare clic su F2 (o sul pulsante Start/Stop (Avvia/Arresta)) per interrompere la raccolta dei dati o attendere fino all'ora di 

fine. 
 
Per stampare 

• Fare clic su F6 o selezionare Print item (Stampa elemento) dal menu File. 
• Selezionare la stampante dalla finestra di dialogo Print (Stampa). 
• Fare clic su OK per chiudere la finestra di dialogo e stampare la visualizzazione. 

 
Print Study (Stampa studio) (stampa le derivazioni e un intervallo di tempo selezionato) 

• Fare clic su Print Study (Stampa studio) sulla barra degli strumenti o selezionare Print Study Item (Stampa elemento 
studio) dal menu File. 

• Definire l'intervallo di tempo e selezionare le derivazioni da stampare dalla finestra di dialogo. 
• Fare clic su OK per confermare la selezione e chiudere la finestra di dialogo. 
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• Selezionare la stampante nella finestra di dialogo Print (Stampa). 
• Fare clic su OK per avviare la stampa. 

 

Configurazione dell'ECG di monitoraggio 
Fare clic su Setup (Configurazione) sulla barra degli strumenti per accedere ai seguenti parametri: 

Scheda Opzione Descrizione 

Sample 
Rate\Leads 
Selection 
(Selezione 
frequenza di 
campionamento\d
erivazioni) 

 
Leads 
(Derivazioni) 

Consente all'utente di selezionare le derivazioni. Per selezionare tutte le derivazioni, fare 
clic su Select All (Seleziona tutte). Per deselezionare tutte le derivazioni, fare clic su 
Unselect (Annulla selezione). 

Sample rate 
(Frequenza di 
campionamento) 

Consente all'utente di scegliere i campioni al secondo richiesti per canale. 

 
X, Y, Z 

Selezionare questa opzione per monitorare gli assi X, Y e Z. Deselezionare l'opzione per 
selezionare le altre derivazioni da visualizzare e monitorare sullo schermo. 
Con questa opzione, non è possibile monitorare altre derivazioni (l'opzione è deselezionata 
per impostazione predefinita). 

12 Leads View 
(Vista 12 
derivazioni) 

Default 3 leads (3 
derivazioni 
predefinite) 

Questa funzione è disponibile solo se è selezionato il monitoraggio a 12 derivazioni. Se si 
utilizza il formato 3x1, vengono visualizzate 3 derivazioni. 

Strip Lead 
(Derivazione del 
tracciato) 

La derivazione di 10 sec. viene visualizzata nei formati 4x3 e 6x2. 

 
 
 
 
 
 
 
 
 
ECG recording 
(Registrazione 
ECG) 

Filter 50/60Hz 
(Filtro 50/60 Hz) 

Se questa opzione è selezionata, lo stato predefinito del filtro 50/60 Hz è attivo (in base 
alla frequenza controllata 50 o 60). Impostazione predefinita: opzione deselezionata. 

EMG Filter 
(Filtro EMG) 

Se l'opzione è selezionata, lo stato predefinito del filtro EMG è attivo. Impostazione 
predefinita: opzione deselezionata. 

Baseline filter 
(Filtro linea di 
base) 

Quando questa opzione è selezionata, lo stato predefinito del filtro della linea di base è 
ON. Impostazione predefinita: opzione deselezionata. 

Save options 
(Salva opzioni) 

Se l'opzione Auto Save (Salvataggio auto) è attiva, il file viene memorizzato per 
cognome o per ID. 
Se l'opzione Auto Save (Salvataggio auto) è disattivata, il programma richiede un nome 
file. 

 
Simulator ECG 
(ECG simulatore) 

Se l'opzione è deselezionata (impostazione predefinita), la registrazione ECG è eseguita 
dall'unità PC-ECG. 
Se invece è selezionata, la registrazione ECG è eseguita dal file demo incluso nel pacchetto 
software. L'unità di registrazione non è necessaria. 

ECG 
Recording time 
(h:m) (ECG 
Tempo di 
registrazione 
(hh:mm)) 

 
Determina la durata dello studio in minuti. 

Data Directory 
(Directory dati) 

Definisce la directory per le registrazioni ECG salvate. Utilizzare il disco rigido secondario, 
se disponibile. 

 
 
 
 
 
 
View (Visualizza) 

Draw Over Lead 
Borders (Traccia 
sui bordi delle 
derivazioni) 

Se l'opzione è selezionata (impostazione predefinita), non limita il superamento dei bordi 
degli impulsi ECG di ampiezza estremamente alta. 
Se l'opzione è deselezionata, gli impulsi vengono scalati ai bordi. 

Horizontal Scale 
(Scala orizzontale) 

Imposta il valore predefinito per la finestra della scala orizzontale sulla schermata. 

Vertical Scale 
(Scala verticale) 

Imposta il valore predefinito per la finestra della scala verticale sullo schermo. 

Slider step size 
(Dimensione 
passo cursore) 

Funzione offline. Imposta il valore predefinito per i passi del cursore quando viene 
spostato con il mouse o con i tasti freccia. 
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Colors (Colori) Consente all'utente di scegliere i colori. 

Restore Defaults 
(Ripristina 
impostazioni 
predefinite) 

Ripristina le impostazioni di fabbrica. 

 
 
Installation 
(Installazione) 

 Salva i dati dell'ospedale e del medico. Questi dati sono inclusi nella posta stampata. 

Measurement 
Standard 
(Standard di 
misurazione) 

Consente di definire se le misurazioni verranno calcolate in base al sistema metrico o allo 
standard USA. Impostazione predefinita: sistema metrico. 

Magnetic Card 
Reader (Lettore 
schede 
magnetiche) 

Selezionare questa opzione per utilizzare una scheda magnetica con codice a barre per 
inserire i dati del paziente. Selezionare il tipo di scheda magnetica. 

 
 
 
 
 
 
 
 

 
Environment 
(Ambiente) 

 
 

Connection 
(Collegamento) 

Selezionare il pulsante di opzione (porta COM/USB) per scegliere la porta per il 
collegamento del dispositivo. 
Se è selezionata la porta COM, selezionare l'ingresso seriale per l'unità PC-ECG 
dall'elenco delle porte COM. 
L'opzione è disabilitata se viene selezionato il collegamento USB. (Impostazione 
predefinita al momento dell'installazione: USB.) 

Display Size 
(Dimensioni del 
display) 

Questa impostazione è necessaria per visualizzare l'ECG e la griglia nella scala 
corretta. 

 
 

Graph paper 
(Carta per 
grafici) 

Se l'opzione è attivata, stampa quadrati da 1 mm e 5 mm sulle stampe. 
L'opzione Regular Grid (Griglia standard) è garantita per qualsiasi stampante. 
L'opzione Improved Grid (Griglia migliorata) mostra una griglia sottile ma potrebbe non 
funzionare su alcune stampanti. 

Large Remarks 
font (Carattere 
grande 
annotazioni) 

Consente di ingrandire il testo stampato. 

Color Printout 
(Stampa a colori) 

Forza la stampa in bianco e nero sulla stampante a colori. 

Thermal Plotter 
(Plotter termico) 

Imposta la porta LPT per la carta termica opzionale. 

 
 
 
 
 
 
 
 

GDT/BDT 
Format 
(Formato 
GDT/BDT) 

Automatic 
options 
(Opzioni 
automatiche) 

Configurare le opzioni automatiche per il salvataggio e/o l'importazione dei file in 
formato GDT/BDT. 

File Format 
(Formato file) 

Consente di selezionare il formato del file: GDT o BDT 

Import 
Codepage 437 
(Importa 
Codepage 
437) 

Selezionare l'opzione per importare la Codepage 437. 

Export 
Codepage 437 
(Esporta 
Codepage 
437) 

Selezionare l'opzione per esportare la Codepage 437. 

Edit Labels 
(Modifica 
etichette) 

Fare clic su questo pulsante per aprire una finestra di dialogo con un elenco 
modificabile delle etichette dei campi utilizzato nei file GDT e BDT. 

GDT/BDT 
Format 
Data Directory 
(Directory dati) 

Consente di specificare il percorso della directory in cui conservare i file GDT/BDT. 
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Token for PC-
ECG (Token 
per PC-ECG) 

Valore predefinito: PEKG. 

Token for 
Practice EDP 
(Token per 
Practice 
EDP) 

Valore predefinito: EDV1. 

Tabella 24: Monitoraggio delle opzioni di configurazione dell'ECG 
 

Barra degli strumenti e menu 
 

Per questa azione 
Fare clic 
su questa 

icona 

Oppure 
utilizzare 

questo 
tasto di 
scelta 
rapida 

 
Oppure 

selezionare 
questo menu 

 
Descrizione 

 
Avviare un nuovo 
esame 

 

 

 
 

F1 

 
File > New Test 
(File > Nuovo 
esame) 

Avvia una nuova sessione di monitoraggio. I dati del paziente 
possono essere immessi prima della registrazione ECG (opzionale). 
Il tempo di registrazione viene impostato in SETUP 
(CONFIGURAZIONE) per ECG RECORDING 
(REGISTRAZIONE ECG). L'utente può interrompere la 
registrazione facendo clic sull'icona (VAI/STOP). 

Aprire un esame 
esistente 

 

 

F11 File > Open (File 
> Apri) 

Mostra le registrazioni salvate sul disco. 

Salvare una 
registrazione 

 

 

Ctrl+S. File > Save (File 
> Salva) 

Salva la registrazione su disco. 

 
Stampare i 
risultati 

 

 

 
F6 

 
File > Print Setup 
(File > 
Configurazione 
stampa) 

Stampa offline. Determinare l'intervallo di tempo da stampare. 
L'ECG acquisito viene stampato in formato miniaturizzato 
orizzontale: 6,25 mm/sec e verticale: 2,5 mm/mV. 

 
 
Esportare in 
Riposo 

   
File > Export to 
Rest (File > 
Esporta in 
Riposo) 

Un segmento di 10 secondi contenente le derivazioni originali i, II, 
V1-V6 e le derivazioni calcolate III, aVR, aVL, aVF viene trasferito 
nel formato Rest (Riposo) (fino a 12 derivazioni 10 sec). Le 
derivazioni calcolate vengono eseguite solo se vengono acquisiti I e 
II. 

Esportare in 
MATLAB 

  File > Export to 
MATLAB (File > 
Esporta in 
MATLAB) 

Un segmento di 10 secondi contenente le derivazioni acquisite viene 
trasferito nel formato MATLAB. 

Importare da 
ISHNE 

  File > Import 
from ISHNE 
(File > Importa 
da ISHNE) 

L'ECG ad alta risoluzione a lungo termine registrato su Holter può 
essere trasferito in uno studio di monitoraggio. 

Stampare un 
grafico in tempo 
reale 

 

 

  Stampa in tempo reale su una stampante termica. Può stampare su 
base continua durante il monitoraggio di un massimo di 8 
derivazioni. 

Impostare/Modifi
care i dati del 
paziente 

 

 

 View > Patient 
data (Visualizza > 
Dati paziente) 

Visualizza i dati demografici del paziente. 

Aggiungere/visua
lizzare le 
annotazioni 

 

 

 View > Remarks 
(Visualizza > 
Annotazioni) 

Consente all'utente di immettere testo libero durante o dopo la 
registrazione ECG. Questo viene stampato e salvato insieme ai 
tracciati ECG. 

Impostare le 
preferenze 

 

 

  Consente all'utente di personalizzare le preferenze di 
funzionamento. 



ND:  NV-100.5988.050|Rev.260224 PC-ECG 1200 Istruzioni per l'uso Pagina 99 di 129 

 
Visualizzare le 
informazioni 

 
 

 

  
Help > About… 
(Guida > 
Informazioni 
su…) 

Numero della versione software. Indicare questa informazione per 
qualsiasi richiesta di software. Mostra anche le dimensioni della 
memoria e lo spazio libero su disco. Il numero ID HASP è l'ID delle 
chiavi software esistenti. Questo numero ID viene utilizzato per 
aggiungere opzioni software. 

Visualizzare/Nas
condere la griglia 

 

 

 View > Grid 
(Visualizza > 
Griglia) 

Visualizzazione opzionale di una griglia da 5 mm. 

Avviare la 
registrazione 
ECG. 

 

 

F2 ECG > 
Start/Stop (ECG 
> Avvia/Arresta) 

Avvia la registrazione ECG. 

Interrompere la 
registrazione 
ECG 

 

 

F2 ECG > 
Start/Stop (ECG 
> Avvia/Arresta) 

Arresta la registrazione ECG. 

Visualizzare 3x4 
derivazioni 

 

 

 
Ctrl+1 

View > Leads 
format > 
Windows 
(Visualizza > 
Formato 
derivazioni > 
Windows) 

Formato classico. Visualizza l'ECG a 12 derivazioni di 2,5 sec + il 
tracciato di 10 secondi.* 

Visualizzare 12x1 
derivazioni 

 

 
 

Ctrl+2 
View > Leads 
format > All 
leads (Visualizza 
> Formato 
derivazioni > 
Tutte le 
derivazioni) 

 
Visualizza l'ECG a 12 derivazioni di 10 secondi.* 

Visualizzar
e 3x1 
derivazioni 

 

 
 

Ctrl+3 
View > Leads 
format > Lead 
group 
(Visualizza > 
Formato 
derivazioni > 
Gruppo 
derivazioni) 

 
Visualizza l'ECG a 3 derivazioni di 10 secondi.* 

Visualizzar
e le 
derivazioni 
successive 

 
 

 
Ctrl+0 

View > Leads 
format > Next 
leads (Visualizza 
> Formato 
derivazioni > 
Derivazioni 
successive) 

Consente all'utente di scorrere tutte le derivazioni nella 
visualizzazione in formato 3x1 

Impostare il 
filtro 50/60 Hz 

 

 
 ECG > Filters 

> 50/60 Hz 
(ECG > Filtri > 
50/60 Hz) 

ON/OFF per il filtro di interferenza della linea. Impostare 
OPTIONS (OPZIONI) su 50 o 60 Hz prima dell'uso. 

Impostare il 
filtro EMG 

 

 
 ECG > Filters 

> EMG (ECG 
> Filtri > ECG) 

ON/OFF per il filtro rumore muscolare. 

Impostare il 
filtro della 
linea di base 

 

 
 ECG > Filters 

> BaseLine 
(ECG > Filtri > 
Linea di base) 

ON/OFF per il filtro della linea di base sui dati ECG. 

Tabella 25: Barra degli strumenti e menu Monitoring ECG (ECG di monitoraggio) 
* I dati ECG possono essere impostati come ampiezza limitata o ampiezza illimitata, che può causare la sovrapposizione dei dati di una 
derivazione a una derivazione vicina. 
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VARIABILITÀ DELLA FREQUENZA CARDIACA (VFC) 
(Questa opzione è disponibile con la licenza H1) 
L'analisi del dominio di tempo e frequenza è progettata per studi brevi in cui vengono misurati uno o più segmenti temporali, come in 
uno studio Tilt. 
I parametri misurati/riportati sono conformi alle linee guida NAPE/ESC. 

 
Figura 52: Schermata Heart Rate Variability (Variabilità della frequenza cardiaca) 

 
Legenda:  

Istogramma L'istogramma si riferisce alla parte attiva (gialla) del tacogramma 

P.S.D. La distribuzione dello spettro di potenza 

 
Tacogramma 

Il trend del tacogramma mostra tutti gli intervalli. Ogni inizio di un intervallo viene 
evidenziato con una linea rossa seguita dal nome dell'intervallo. Fare clic su un 
intervallo per attivarlo. Per attivare più segmenti adiacenti, premere SHIFT (MAIUSC) 
e spostare il cursore. 

Diagramma di 
dispersione 

Grafico a puntini dell'intervallo R-R corrente tracciato rispetto all'intervallo R-R 
precedente. 

 
 
Cursore 

Utilizzare il cursore nella parte inferiore per: Definire nuovi intervalli 
Modificare la durata dell'intervallo e 
attivare diversi intervalli 

Risultati VFC Il riquadro dei risultati VFC visualizza i risultati in formato numerico. 

Tabella 26: Schermata HRV (VFC) 

Avvio rapido 
Per avviare un nuovo esame 

• Fare clic su F1 (o sul pulsante New (Nuovo) sulla barra degli strumenti). 
• Inserire i dettagli del paziente nella finestra di dialogo. 
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• Fare clic su OK. 
• Fare clic su F3 o F4 per avviare l'esame VFC. 
• Immettere il nome dell'intervallo e/o le note secondo necessità nella finestra di dialogo e fare clic su OK. 
• Fare clic su F3 o F4 (o sul pulsante Start/Stop HRV (Avvia/Arresta VFC)) per interrompere l'esame VFC (o attendere la 

fine). 
 
Per stampare un referto VFC 

• Fare clic su Print (Stampa) nella barra degli strumenti o selezionare Print (Stampa) dal menu file. 
• Selezionare la stampante dalla finestra di dialogo Print (Stampa). 
• Fare clic su OK per stampare il referto. 

Per un esempio di referto stampato, vedere l'Appendice C. 
 
Per stampare un ECG 

• Fare clic sul pulsante Print ECG (Stampa ECG) nella barra degli strumenti o selezionare Print ECG (Stampa ECG) dal 
menu file. 

• Selezionare i battiti e le derivazioni da stampare nella finestra di dialogo e fare clic su OK. 
• Selezionare la stampante dalla finestra di dialogo Print (Stampa). 
• Fare clic su OK per chiudere la finestra di dialogo e stampare l'ECG. 

 

Configurazione VFC 
Scheda Opzione Descrizione 

Sample 
Rate\Leads 
Selection 
(Selezione 
frequenza di 
campionamento\
derivazioni) 

Leads (Derivazioni) Scegliere le derivazioni e la frequenza di campionamento. Selezionare fino a quattro 
derivazioni adiacenti per i calcoli. 

 
 
 
 
 
 
ECG 
Recording 
(Registrazione 
ECG) 
 
 

Filters (Filtri) Impostare i filtri come attivi. 
Test Duration (Durata 
esame) 

Definire la durata dell'esame in base al numero target di battiti o al tempo di registrazione 
ECG. Selezionare il parametro preferito e definire il valore per la durata dell'esame. 

 
Auto Interval 
(Intervallo auto) 

Imposta i tempi di intervallo che verranno creati automaticamente. Quando questa 
opzione è selezionata, l'esame ECG viene suddiviso in intervalli di tempo uguali durante 
la registrazione ECG. Regolare il parametro Duration (Durata) per impostare la durata 
dei tempi di intervallo. 

 
Save Options (Salva 
opzioni) 

Per salvare l'esame automaticamente alla fine, selezionare l'opzione Auto Save 
(Salvataggio auto). Quando questa opzione viene deselezionata, l'esame viene salvato 
solo su richiesta. 
Definire il formato di salvataggio come No ECG Data (Nessun dato ECG) o Full 
Disclosure (Intero ECG). 
Definire la convenzione di denominazione dei file salvati, in base al cognome o all'ID del 
paziente. 

Use ECG Database 
(Usa database ECG) 

Selezionare questa opzione per connettersi al database ECG predefinito. Quando questa 
opzione è selezionata, gli esami ECG vengono salvati nel database. 

Data Directory 
(Directory dati) 

Definire una directory per le registrazioni ECG salvate (se non si utilizza il database 
ECG). 
Utilizzare un disco rigido secondario, se disponibile. 

Simulator ECG 
(Simulatore ECG) 

Se l'opzione è deselezionata (impostazione predefinita), la registrazione ECG è eseguita 
dall'unità PC-ECG. Se invece è selezionata, la registrazione ECG viene eseguita dal file 
demo incluso nel pacchetto software. In questo caso, l'unità di registrazione non è 
necessaria. 

View (Visualizza)  Modificare i colori predefiniti per ECG e grafici. 
Restore Defaults 
(Ripristina 
impostazioni 
predefinite) 

Consente di ripristinare le definizioni dei colori predefinite in fabbrica per la 
visualizzazione e i grafici ECG. 

  Salva i dati dell'ospedale e del medico. Questi dati sono inclusi nella stampa e nella posta. 
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Installation 
(Installazione) 

Measurement 
Standard (Misurazione 
standard) 

Consente di definire se le misurazioni verranno calcolate in base al sistema metrico o allo 
standard USA. Impostazione predefinita: sistema metrico. 

Magnetic Card 
Reader (Lettore scheda 
magnetica) 

Selezionare questa opzione per utilizzare una scheda magnetica con codice a barre per 
inserire i dati del paziente. Selezionare il tipo di scheda magnetica. 

 
 
 
 
 
Environment 
(Ambiente) 

 
Connection 
(Collegamento) 

Selezionare il pulsante di opzione (porta COM/USB) per scegliere la porta per il 
collegamento del dispositivo. Se è selezionata la porta COM, selezionare l'ingresso seriale 
per l'unità PC-ECG dall'elenco delle porte COM. 
L'opzione è disabilitata se viene selezionato il collegamento USB. L'impostazione 
predefinita al momento dell'installazione è USB. 

Display Size 
(Dimensioni del 
display) 

Questa impostazione è necessaria per visualizzare l'ECG e la griglia nella scala corretta. 

Graph Paper (Carta 
per grafici) (opzioni di 
stampa) 

Se l'opzione è attivata, stampa quadrati da 1 mm e 5 mm sulle stampe. 
L'opzione Regular Grid (Griglia standard) funziona con qualsiasi stampante. 
L'opzione Improved Grid (Griglia migliorata) mostra una griglia sottile ma potrebbe 
non funzionare su alcune stampanti. 

Large Remarks 
Font (Carattere grande 
annotazioni) 

Ingrandisce il carattere per il testo libero. 

Color Printout 
(Stampa a colori) 

Deselezionare la casella di selezione per forzare la stampa in bianco e nero sulla 
stampante a colori. 

 
 
 
 
 
GDT/BDT 
Format 
(Formato 
GDT/BDT) 

Automatic options 
(Opzioni automatiche) 

Definire le opzioni automatiche per il salvataggio e/o l'importazione dei file in formato 
GDT/BDT. 

File Format (Formato 
file) 

Selezionare il formato del file: GDT o BDT. 

Import Codepage 
437 (Importa 
Codepage 437) 

Selezionare l'opzione per importare la Codepage 437. 

Export Codepage 
437 (Esporta 
Codepage 437) 

Selezionare l'opzione per esportare la Codepage 437. 

Edit Labels (Modifica 
etichette) 

Fare clic per aprire una finestra di dialogo con un elenco modificabile delle etichette dei 
campi utilizzato nei file GDT e BDT. 

GDT/BDT Data 
directory 
(Directory dati 
GDT/BDT) 

Consente di specificare il percorso della directory in cui conservare i file GDT/BDT. 

Token for PC-ECG 
(Token per PC-ECG) 

Valore predefinito: PEKG. 

Token for Practice 
EDP (Token per 
Practice EDP) 

Valore predefinito: EDV1. 

Tabella 27:  Configurazione VFC 
 

Avvio di un esame 
• Fare clic su New (Nuovo). 
• Immettere i dati del paziente nel campo Patient data (Dati paziente). 
• Le derivazioni ECG vengono monitorate sullo schermo per verificare la qualità. 
• Se il controllo qualità viene superato, fare clic sull'icona R-R. Il display comprende tre sezioni: 

o Le derivazioni ECG sono visualizzate nella parte superiore dello schermo. 
o La visualizzazione del trend dei tacogrammi è integrata nella striscia centrale. 
o Un cursore mostra lo stato e l'ora dello studio nella parte inferiore. 

• Durante l'esame, definire un nuovo segmento temporale (intervallo) facendo clic sull'icona della bandiera (intervallo). 
Assegnare un nome a ciascun intervallo durante l'esame per conservarlo come intervallo valido. 

• Quando tutti i battiti predefiniti sono completati o sono stati terminati facendo clic sull'icona R-R, viene visualizzata la 
schermata HRV (VFC). 
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Per aggiungere o sottrarre un intervallo 
• Selezionare l'intervallo con il cursore o con i comandi FROM-TO (DA-A) nel pannello laterale destro. 
• Fare clic su + o – nella parte superiore del riquadro dei risultati VFC. 

Per modificare i nomi degli intervalli 
Utilizzare l'icona a forma di matita. 

Per suddividere l'intero esame in intervalli equamente temporizzati 
• Online: attivare la casella di controllo Auto Interval (Intervallo auto) nella scheda di configurazione ECG Recording 

(Registrazione ECG). Selezionare questa opzione per creare intervalli di tempo uguali durante la registrazione ECG. 
• Offline: selezionare il comando Define Time Intervals (Definisci intervalli di tempo) nel menu principale View 

(Visualizza). L'opzione consente di creare intervalli di tempo di uguale durata su una registrazione memorizzata. 
 

Per importare o salvare il formato GDT/BDT 
Vedere Importa da GDT/BDT e Salva esame in GDT/BDT. 
 

Visualizzazione dei risultati 
Il valore AVERAGE HEART RATE (FREQUENZA CARDIACA MEDIA) viene visualizzato in basso a sinistra. 
Tutti i risultati sono relativi al segmento scelto (controllare la selezione gialla o il numero di bit Da-A). 
Altri risultati sono mostrati sul lato destro come segue: 
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Time Domain 
(Dominio 
tempo) 

RR no. (N. RR) Numero di battiti nell'intervallo attivo 

Max RR (RR max) Periodo R-R più lungo 

Min RR (RR min) Periodo R-R più breve 

Average RR (Media 
RR) 

Media dell'intervallo nell'intervallo attivo 

SDNN Deviazione standard di tutti i periodi R-R nell'intervallo 

SDANN Deviazione standard delle medie dei periodi R-R in tutti e 5 i 
segmenti dell'intervallo attivo 

RMSSD La radice quadrata della media della somma dei quadrati di 
differenze tra intervalli NN adiacenti 

HRV triangular 
Index (Indice VFC 
triangolare) 

Numero totale di tutti gli intervalli R-R diviso per l'altezza 
dell'istogramma di tutti gli intervalli R-R misurati su una scala 
discreta 

 
 
Frequency 
Domain 
(Dominio 
frequenza) 

ULF Potenza della gamma di frequenza ultrabassa 

VLF Potenza della gamma di frequenza molto bassa 

LF Potenza della gamma di frequenza bassa 

HF Potenza della gamma di frequenza alta 

Tabella 28: Risultati VFC 
 

Misurazione dell'intervallo VFC 
Un rilevatore QRS misura l'intervallo tra due battiti validi. Calcola una media N-N mobile rispetto a cui confronta ogni intervallo. In 
caso di variazione significativa, il battito corrente è un battito prematuro (come in PVC) o prolungato, che può indicare una pausa 
compensatoria a seguito di un PVC o di un battito mancante. Viene creata la media di un intervallo prematuro e di un successivo 
intervallo prolungato (pausa compensatoria) nell'intervallo di due volte l'intervallo N-N corrente. Questa metodologia mantiene un asse 
temporale costante in presenza di PVC. Se un intervallo prolungato segue un intervallo normale, ma al doppio dell'intervallo N-N 
corrente, questo indica la presenza di un battito mancante. Di conseguenza, il battito mancante viene calcolato come presente. Questo 
ultimo evento è molto raro perché la registrazione viene effettuata in condizioni di riposo e il software rileva il QRS in modo efficiente 
in tali condizioni. 
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MEASUREMENTS/ INTERPRETATION 
(MISURAZIONI/INTERPRETAZIONE) (MEDIE) 
(Questa opzione è disponibile con la licenza I1, I2 o I3) 
Measurements (Misurazioni) non è un'applicazione autonoma. L'applicazione Measurements (Misurazioni) viene utilizzata per i 
calcoli dei QRS e l'interpretazione del segnale ECG. L'utente può modificare manualmente i parametri di identificazione QRS. 
Vengono calcolati 10 secondi di dati. 

 
Figura 53: Misurazioni - Schermata Tabular (Tabellare) 

 

Avvio rapido 

Per avviare le misurazioni 
Fare clic sull'area delle misurazioni in Resting ECG (ECG a riposo) oppure sull'icona del righello Stress ECG (ECG da sforzo) e 
Monitoring ECG (ECG di monitoraggio) oppure fare clic su View > Measurements (Visualizza > Misurazioni) 
L'applicazione dispone di quattro formati di visualizzazione: 

• Tabella Measurements (Misurazioni) (visualizzazione predefinita) 
• Medie ECG 
• Segnale QRS 
• Calibro 

Per stampare i referti 
• Fare clic sull'icona della stampante o selezionare File > Print Reports (File > Stampa referti). 
• Selezionare i rapporti da stampare e fare clic su OK. 
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Esecuzione delle modifiche nei calcoli 

Per spostare il contrassegno QRS 
(Solo viste di medie e QRS) 

• Fare clic e trascinare il contrassegno nella posizione desiderata (tra i contrassegni precedente e successivo). 
• I calcoli vengono modificati di conseguenza. 

Per aggiungere o rimuovere un contrassegno d'onda 
• Fare clic sull'icona Aggiungi/Rimuovi contrassegni d'onda ECG nella barra degli strumenti 
• Selezionare o deselezionare i contrassegni delle forme d'onda nella finestra di dialogo visualizzata. 
• Fare clic su OK per salvare la selezione, chiudere la finestra di dialogo e visualizzare la modifica. 

Per spostare il contrassegno d'onda 
(Solo visualizzazione Caliper (Calibro)) 

• Selezionare una forma d'onda dall'elenco delle forme d'onda sul lato sinistro del visualizzatore (o dalla casella combinata 
Wave Type (Tipo onda)). 

• Fare clic sul contrassegno per selezionarlo dalla casella combinata Marker Name (Nome contrassegno) nella barra degli 
strumenti. 

• Utilizzare le frecce sinistra/superiore/destra/inferiore nella barra degli strumenti o trascinare il contrassegno nella posizione 
desiderata. 

I calcoli vengono modificati di conseguenza. 
 

Funzioni 
Visualizzare tutti i parametri calcolati per ogni QRS, su ogni canale e i calcoli medi nelle tabelle. 
La tabella superiore visualizza le misurazioni per un canale. La tabella inferiore visualizza i valori delle misurazioni per un QRS. 

Per visualizzare le misurazioni su un QRS 
Selezionare un QRS dalla tabella superiore e visualizzare i risultati nella tabella inferiore. 

Per visualizzare le misurazioni su un canale 
Selezionare un canale dalla tabella inferiore e visualizzare i valori in quella superiore. 

Per visualizzare le misurazioni su tutti i canali per QT 
Fare clic su ">" (tra le due tabelle) per visualizzare le misurazioni di All Leads for QT (Tutte le derivazioni per QT) nella tabella 
inferiore. 
 

Schermata Tabular (Tabellare) 
La schermata Tabular (Tabellare) visualizza i calcoli dei parametri QRS in tutte le derivazioni in un formato tabellare. I calcoli o le 
modifiche originali eseguite nelle altre schermate (Medie (Averages), QRS (QRS) o Caliper (Calibro)) vengono visualizzati in un 
formato tabellare e possono essere stampati. 
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Visualizzazione Averages (Medie) 
 

Figura 54: Misurazioni - Visualizzazione delle medie 
La schermata delle medie visualizza il QRS medio in ciascuna derivazione e l'ECG medio della derivazione del tracciato. Ogni QRS 
identificato è riconoscibile da un contrassegno rosso nella derivazione del tracciato (il contrassegno indica effettivamente l'onda R di 
ogni QRS). I contrassegni QRS possono essere spostati a sinistra e a destra (tra quello precedente e quello successivo). I cambiamenti 
nelle posizioni dei contrassegni vengono ricalcolati e visualizzati nella schermata Tabular (Tabellare) e nella schermata QRS. 
 

Visualizzazione QRS 
 

Figura 55: Misurazioni - Visualizzazione QRS 
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La schermata QRS visualizza il QRS in ciascuna delle derivazioni e una derivazione tracciato di una derivazione predefinita (definita 
nell'impostazione dell'applicazione da cui è stato effettuato l'accesso alle misurazioni). Il QRS visualizzato in ciascuna derivazione è 
contrassegnato da un rettangolo rosso nella derivazione del tracciato. Per visualizzare un QRS diverso in tutte le derivazioni, trascinare 
e rilasciare il quadrato di un QRS diverso. I contrassegni QRS possono essere spostati a sinistra e a destra (tra quello precedente e 
quello successivo). I cambiamenti nelle posizioni dei contrassegni vengono ricalcolati e visualizzati nella schermata Tabular (Tabellare) 
e nella schermata Averages (Medie). 
 

Barra degli strumenti delle visualizzazioni Averages/QRS (Medie/QRS) 

 
Figura 56: Barra degli strumenti di Averages/QRS (Medie/QRS) 

 

Visualizzazione Caliper (Calibro) 
 

Figura 57: Misurazioni - Caliper (Calibro) 
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Barra degli strumenti della visualizzazione Caliper (Calibro) 

 
Figura 58: Barra degli strumenti di Caliper (Calibro) 

 
La schermata Caliper (Calibro) (mostrata in alto) si apre tramite il menu, la barra degli strumenti o facendo doppio clic su una 
derivazione nelle schermate QRS o Averages (Medie). Visualizza un QRS con i relativi valori. L'utente può modificare le posizioni dei 
contrassegni d'onda, visualizzare QRS diversi nella stessa derivazione oppure navigare tra le derivazioni e visualizzare QRS in 
derivazioni diverse. I cambiamenti nelle posizioni dei contrassegni d'onda vengono ricalcolati e visualizzati nella schermata Tabular 
(Tabellare). 
 

Barra degli strumenti e menu 
 

 
Per questa azione 

Fare clic 
su questa 

icona 

Oppure 
utilizzare 

questi tasti 
di scelta 
rapida 

Oppure 
selezionare 

questo menu 

 
Descrizione 

Salvare le 
misurazioni 

 

 

Ctrl+S File > Save (File 
> Salva) 

Salva le misurazioni nel file di testo sul disco. 

 
Stampare l'ECG 

 

 

 
F6 

File > Print ECG 
(File > Stampa 
ECG) 

Stampa offline. L'ECG viene stampato in formato 
miniaturizzato. 
Orizzontale: 6,25 mm/sec; Verticale: 2,5 mm/mV. 

Aggiungere/visua
lizzare le 
annotazioni 

 

 

 
Alt+V+R. 

View > Remarks 
(Visualizza > 
Annotazioni) 

Consente di immettere testo libero durante o dopo 
la registrazione ECG. Questo viene stampato e 
salvato insieme ai tracciati ECG. 

 
Reimpostare le 
misurazioni 

 

 

 
Alt+F+M. 

 
File > Reset 
Measurements 
(File > Reimposta 
misurazioni) 

Consente di ripristinare le misurazioni su quelle 
calcolate dall'applicazione. Questa opzione elimina 
tutte le modifiche eseguite manualmente nelle 
misurazioni. 

Per aprire le 
misurazioni in 
formato tabellare 

 

 

 View > View 
Format > 
Measurements 
table (Visualizza 
> Visualizza 
formato > Tabella 
misurazioni) 

 
Visualizza le misurazioni in formato tabellare. 

Per visualizzare le 
medie QRS 

 

 

 View > View 
Format > 
Averages 
(Visualizza > 
Visualizza 
formato > Medie) 

 
Visualizza le medie QRS sullo schermo. 

Per visualizzare i 
QRS in tutti i 
canali 

 

 

 View > View 
Format > QRS 
(Visualizza > 

 
Visualizza i QRS in tutti i canali sullo schermo. 
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Visualizza 
formato > QRS) 

 
Visualizzare il 
calibro  

 

 

 View > View 
Format > Caliper 
(Visualizza > 
Formato vista > 
Calibro) 

 
Consente di visualizza il calibro. 

Visualizzare le 
derivazioni 
successive 

 

 

 
Ctrl+0 

View > View 
Format > Next 
strip (Visualizza > 
Visualizza 
formato > 
Tracciato 
successivo) 

 
Per scorrere tutte le derivazioni nel display 3x1. 

Visualizzare/nasc
ondere la griglia 

 

 

 View > Grid 
(Visualizza > 
Griglia) 

Visualizzazione opzionale di una griglia da 5 mm. 

 
Visualizzare le 
informazioni 

 
 

 

  
Help > About… 
(Guida > 
Informazioni 
su…) 

Visualizza il numero di versione del software. 
Indicare questa informazione per qualsiasi richiesta 
di software. Mostra anche le dimensioni della 
memoria e lo spazio libero su disco. Il numero ID 
HASP è l'ID delle chiavi software esistenti. Questo 
numero ID viene utilizzato per aggiungere opzioni 
software. 

 
QRS precedente 
QRS successivo 

 

 

 View > View 
Format > 
Previous QRS/ 
Next QRS 
(Visualizza > 
Formato 
visualizzazione > 
QRS 
precedente/QRS 
successivo) 

 
Consente di passare al QRS precedente o successivo 
sullo stesso canale. 

 
 
Pagina - Pagina + 

 

 

 View > View 
Format > 
Previous 10 sec 
ECG/ 
Next 10 sec ECG 
(Visualizza > 
Visualizza 
formato > ECG 
10 sec. 
precedente/ECG 
10 sec. 
successivo) 

 
 
Consente di passare alla pagina ECG 
precedente/successiva di registrazione del ritmo di 
10 secondi. 

Impostare il filtro 
50/60 Hz 

 

 

 ECG > Filters 
> 50/60 Hz 
(ECG > Filtri > 
50/60 Hz) 

ON/OFF per il filtro di interferenza della linea. 
Impostare le OPZIONI su 50 o 60 Hz prima 
dell'uso. 

Impostare il 
filtro EMG 

 

 
 ECG > Filters 

> EMG (ECG 
> Filtri > ECG) 

ON/OFF per filtro rumore muscolare. 

Impostare il 
filtro della linea 
di base 

 

 
 ECG > Filters 

> BaseLine 
(ECG > Filtri > 
Linea di base) 

ON/OFF per il filtro della linea di base sui dati 
ECG. 
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Spostare il 
contrassegno 
a destra/in 
basso 

 
 

 

  

 
------------ 

Opzione abilitata nella schermata Caliper (Calibro) 
quando sono selezionati un tipo di onda e un 
nome del contrassegno. Fare clic per spostare il 
contrassegno verso destra o verso il basso (in base 
al contrassegno selezionato). 
Opzione disabilitata quando non è selezionato 
alcun contrassegno d'onda o la schermata Capiler 
(Calibro) non è visualizzata. 

 
Risoluzione 
orizzontale 

 
 

 

 
 

--------------- 

(Schermate Averages (Medie) e QRS) 
Per scegliere tra visualizzazioni orizzontali di 
12,5, 25, 50 e 100 mm/sec. 
(Impostazione predefinita: 25 mm/sec) 

Selezionare il 
tipo onda 
QRS 

 
 
  

------------- 
In Caliper (Calibro), consente di selezionare il 
tipo di onda QRS dall'elenco per visualizzarne i 
contrassegni. Dopo aver selezionato il tipo di 
forma d'onda, selezionare il nome di un 
contrassegno per spostarlo. 

 
Risoluzione 
verticale 

 
 

 

 
 

------------- 

(Schermate Averages (Medie) e QRS) 
Per scegliere tra le visualizzazioni verticali di 5, 10, 
20 e 40 mm/mV. 
(Impostazione predefinita: 10 mm/mV) 

Selezionare il 
nome del 
contrassegno 
QRS 

 
 
 

------------- In Caliper (Calibro), consente di selezionare il 
nome di un contrassegno per modificarlo 
(spostarlo in alto/in basso/a sinistra/a destra). 

Aggiungere/Ri
muovere il 
contrassegno 
dell'onda ECG 

 

 

 File > 
Add/Remove 
ECG Wave 
Marker (File > 
Aggiungi/Rimuo
vi contrassegno 
onda ECG) 

(Solo schermata Caliper (Calibro)) 
Apre una finestra di dialogo che consente di 
selezionare/deselezionare i contrassegni d'onda da 
visualizzare e calcolare. 

 
Stampare i 
referti 

------ 
 

File > Print 
Reports (File > 
Stampa referti) 

Per scegliere il referto da stampare dal sottomenu: 
Single QRS/QT Report (Referto QRS/QT 
singolo), Multiple QRS Report (Referto QRS 
multiplo) o All Reports (Tutti i referti). 

Tabella 29: Barra degli strumenti e menu Measurements (Misurazioni) 
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APPLICAZIONE NEMS 
(Questa opzione è disponibile con la licenza D1/D2/D3) 
L'applicazione NEMS (Norav ECG Management System) è un pacchetto opzionale che richiede una licenza di autorizzazione NEMS-
A o NEMS-Q. Installare il database e l'applicazione NEMS dal pacchetto di installazione dedicato. 
 
Per informazioni relative all'applicazione NEMS, consultare le istruzioni per l'uso di NEMS. 
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INTERFACCIA CON I SISTEMI INFORMATIVI 
Esistono diversi modi per scambiare informazioni tra PC-ECG 1200 e il sistema informativo ospedaliero (HIS). Questi sono descritti 
di seguito: 

Dati demografici 
Il sistema informativo prepara i dati demografici del paziente per PC-ECG 1200: 
Questo utilizza un file di testo denominato PatientFile.ini. La posizione è definita nella configurazione NEMS. 
Nome file: PatientFile.ini  
Formato file: 
 
[DATIPAZIENTEXXX] 
ID= 
LastName (Cognome)=  
FirstName (Nome)=  
BirthDay (Giorno di nascita)=  
BirthMonth (Mese di nascita)=  
BirthYear (Anno di nascita)=  
Sex (Sesso)=  
Weight (Peso)=  
Altezza (Altezza)=  
Address (Indirizzo)=  
Phone1 (Telefono1)=  
Phone2 (Telefono2)=  
Fax= 
E-mail=  
Medications (Farmaci)=  
Other (Altro)= 
[DatiPazienteXXX] - Nome sezione. XXX: un numero da 000 a 200. 
È necessario completare almeno una delle chiavi ID, LastName (Cognome) o FirstName (Nome). Se tutte queste chiavi sono 
vuote, la sezione del paziente verrà ignorata. 
 
Le seguenti chiavi Height (Altezza), Address (Indirizzo), Phone1 (Telefono1), Phone2 (Telefono2), Fax, Email (E-mail), 
Medications (Farmaci) e Other (Altro) sono visualizzate solo con il database. 
 
Esempio:  
[PatientData001] I 
D=1234567890 
Cognome=Rossi  
Nome=Mario  
Giorno di nascita=11  
Mese di nascita=6  
Anno di nascita=1959  
Sesso=1 
Peso=59  
Altezza=170 
Indirizzo=via Roma, Italia  
Telefono1=702-8765643 
Telefono2=702-8743031  
Fax=702-8743032 
E-Mail=nkir@sympo.ca  
Farmaci=nessuno  
Altro=nulla 
 
[DatiPaziente003]  
ID=123456789 
Cognome=Rossi  
Nome=Mario3 
 
 

mailto:E-Mail%3Dnkir@sympo.ca
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File formato HL7 
PC-ECG prepara il file di formato HL7 con i risultati degli esami da sforzo 
Questo file viene creato su richiesta nella schermata di revisione dell'esame. Il file dell'esame da sforzo in formato HL7 include: 

• Informazioni paziente: 
Nome:   Mario 
Cognome:  Rossi 
ID:   12345678 
Data di nascita:  24/1/1955 
Sesso:   M 
Peso:   80 kg 

• Informazioni ospedale e medico:  
Nome ospedale:  Ospedale generale  
Indirizzo dell'ospedale: Milano  
Nome del medico:   Dott. Bianchi 

• Data e ora dell'esame 
Data dell'esame:  18/09/1999 
Ora dell'esame:  12:41:51 

• Risultati dell'esame: 
Protocollo:  Bruce 
FC target:  183 
FC max:   175 (95%) 
SBP max:  200 
DBP max:  100 
MET max:  8,8 
VO2 max:  30,9 
ST =    J+60 

 
• Risultati di pressione arteriosa, frequenza cardiaca, doppio prodotto (FCxPS SIS.), livello ST (mm) e pendenza ST 

(mV/sec) per le fasi più importanti dell'esame da sforzo: 
Riposo: PS: 150/100, FC: 79, prodotto: 11850, livello ST (mm), pendenza (mV/sec) (- 1,2/0,7, 0,2/1,8, 1,9/-0,5, -
2,0/0,4, -2,9/3,3, -1,1/2,6, -1,4/2,2, -1,6/1,8, -1,3/6,1, -1,8/2,5, -1,7/1,5) 
FC max: Ora: 7:05, PS: 200/100, FC: 175, prodotto: 35000, livello ST (mm), pendenza (mV/sec) (-1,2/0,7, 0,2/1,5, 
1,9/-0,5, -2,0/01, -2,9/3,3, -2,1/2,6, -1,4/2,2, - 1,4/1,8, -1,7/6,1, -1,2/2,4, -1,7/1,5) 
ST peggiore: Derivazione aVF:-1,2 mm, ora 4:15, PS:200/100, FC:137, prodotto: 27400, livello ST (mm),
 Pendenza (mV/sec) (-1,3/0,4, 0,2/1,5, 1,2/-0,5, -2,0/01, -2,5/3,3, -2,1/2,6, -1,7/2,2, -1,4/1,8, -1,3/2,1,
 -1,2/2,4, -1,7/1,5) 
Recupero:: Ora: 10:59, PS: 170/80, FC: 127, prodotto: 21590, livello ST (mm), pendenza (mV/sec) (-1,3/0,4, 0,6/1,5, 
1,3/-0,5, -2,0/01, -1,5/3,3, -2,1/2,6, -1,5/2,2, - 1,4/1,9, -1,3/2,1, -1,2/2,3, -1,7/1,5) 

 
• Osservazioni e conclusioni del medico:  

Motivo dell'esame:  Pressione torace  
Motivo della fine del l'esame: Affaticamento 
Conclusioni:   Pressione sanguigna normale 

 

Comunicazione tipo GDT/BDT 
PC-ECG e il sistema informativo dell'ospedale (HIS) mantengono una comunicazione di tipo GDT/BDT bidirezionale 

• Importare i dati demografici da HIS a PC-ECG 
1. Nella configurazione, selezionare GDT/BDT. 
2. Selezionare Import from GDT/BDT (Importa da GDT/BDT). 
3. Definire la directory GDT/BDT (in cui il file HIS sarà pronto). 
4. Definire i primi quattro caratteri del token per il file PC-ECG. Questo file contiene sempre i dati dell'ultimo paziente. 

• Esportare il file GDT/BDT da PC-ECG a HIS. 
1. Nella configurazione, selezionare GDT/BDT. 
2. Selezionare Save Test in GDT/BDT (Salva esame in GDT/BDT). 
3. Definire la directory GDT/BDT (in cui sarà pronto il file PC-ECG). 
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4. Definire i primi quattro caratteri del file Token for Practice EDP. Questo file contiene sempre i dati dell'ultimo 
paziente. 

 

Comunicazione DICOM 
Il sistema Norav PC-ECG 1200 è abilitato per le seguenti operazioni DICOM:  

• Ricezione delle richieste ECG tramite worklist in modalità DICOM (MWL).  
• Conservare i referti dell'esame come file PDF incapsulati.  
• Memorizzare l'esame ECG a riposo come forma d'onda ECG a 12 derivazioni.  
• Memorizzare i referti ECG a riposo nel formato immagine di acquisizione secondaria. 

 
Ricezione delle richieste ECG da DICOM MWL 
Per abilitare la funzionalità MWL nell'ECG a riposo o nell'ECG da sforzo: 

1. Avviare l'applicazione ECG a riposo/ECG da sforzo e aprire il pannello Setup > Worklist (Configurazione > Worklist). 
2. Selezionare l' opzione Query DICOM MWL. 
3. Immettere i parametri di connessione del server DICOM. 
4. Fare clic su Apply (Applica). 

 

 
Nota 

Si consiglia di impostare il valore del campo di testo Modality (Modalità ) su ECG. In questo modo si 
garantisce che solo gli ordini ECG vengano ricevuti da DICOM MWL. Se questo campo viene lasciato vuoto, 
verranno ricevuti tutti i tipi di ordini, che potrebbero non essere necessariamente correlati all'ECG. Vedere 
l'immagine riportata di seguito. 
 

 
Funzionamento: 
Avviare un nuovo paziente, fare clic su Worklist e selezionare il nome del paziente dall'elenco. 
 
Archiviare i referti in formato PDF incapsulati su DICOM SCP 
Supportato nelle applicazioni ECG a riposo e ECG da sforzo 
 
Per attivare la funzionalità del referto PDF incapsulato: 

1. Nella configurazione del software Resting ECG (ECG a riposo) aprire la scheda PDF\HL7 File\DICOM ECG. Nella 
configurazione del software Stress ECG (ECG da sforzo) aprire la scheda PDF\XML\DICOM\RDT 

2. Abilitare l'opzione Auto Save test Data in DICOM Encapsulated PDF (Salvataggio auto dei dati dell'esame in 
formato PDF DICOM incapsulato). 
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3. Selezionare la casella di controllo Store in PACS (Archivia in PACS). 

4. Compilare i dettagli di connessione del server PACS. 
5. Fare clic su Apply (Applica). 

 
Archiviare le forme d'onda ECG a 12 derivazioni su DICOM SCP 
Supportato nell'applicazione ECG a riposo. 
 
Per abilitare la funzionalità forma d'onda ECG a 12 derivazioni: 

1. Nella configurazione Resting ECG (ECG a riposo) aprire la scheda PDF\HL7 File\DICOM ECG. 
2. Abilitare l'opzione Auto Save Test Data in DICOM ECG (Salvataggio auto dei dati dell'esame in DICOM ECG). 
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3. Selezionare la casella di controllo Store in PACS (Archivia in PACS). 
4. Compilare i dettagli di connessione del server PACS. 
5. Fare clic su Apply (Applica). 

 
Memorizzare i referti ECG a riposo nel formato immagine di acquisizione secondaria DICOM 
Per abilitare l'esportazione di immagini di acquisizione secondaria DICOM: 

1. Nella configurazione Resting ECG (ECG a riposo) aprire la scheda PDF\HL7 File\DICOM ECG. Nella configurazione 
Stress ECG (ECG da sforzo) aprire la scheda PDF\XML\DICOM\RDT. 

2. Abilitare l'opzione Auto Save Test Data in DICOM Secondary Capture Image (Salvataggio auto dati esame 
nell'immagine di acquisizione secondaria DICOM). 

3. Selezionare la casella di controllo Store in PACS (Archivia in PACS). 
4. Compilare i dettagli di connessione del server PACS. 
5. Fare clic su Apply (Applica). 

 

Salvataggio dell'esame da sforzo come file di formato dati non elaborati ("binari 
nativi") 

• Registrare un esame da sforzo 
• Nel menu File, creare un file di dati non elaborati. 

 
Viene creato un file con estensione RDT, con la seguente struttura: 
(byte basso, byte alto) x 12 derivazioni x n campioni (1sec = 500 campioni). 
Derivazioni: I, II, III, AVR, AVL, AVF, V1, V2, V3, V4, V5, V6. 

Numero byte Tipo di byte Numero di 
derivazioni 

Numero 
campione 

Secondo 
numero 

1 Lb I  
 
 
 
 
 

 
 
 
 
 
 

2 Hb 

3 Lb II 

4 Hb 

… … … 
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21 Lb V5 1  
 
 
 
 
 
 
1 

22 Hb 

23 Lb V6 

24 Hb 

25 Lb I  
 
 
 
 
 
2 

26 Hb 

27 Lb II 

28 Hb 

… … … 

45 Lb V5 

46 Hb 

47 Lb V6 

48 Hb 

… … … … … 

1+(n-1)*24 Lb I  
 
 
 
 
 

n 

 
 
 
 
 
 

n/500 

2+(n-1)*24 Hb 

3+(n-1)*24 Lb II 

4+(n-1)*24 Hb 

… … … 

21+(n-1)*24 Lb V5 

22+(n-1)*24 Hb 

23+(n-1)*24 Lb V6 

n * 24 Hb 

Tabella 30: Formato file dati non elaborati per l'esame da sforzo 
 

Salvataggio dell'esame ECG di monitoraggio come file in formato dati non 
elaborati ("binari nativi") 

• Registrare un esame ECG di monitoraggio. 
• Nel menu File, creare un file di dati non elaborati. 

 
Viene creato un file con estensione RDT, con la seguente struttura: 
Numero di derivazioni (byte basso, byte alto) + velocità di campionamento (byte basso, byte alto) 
+ (byte  basso, byte alto) x numero derivazioni x n campioni (1 sec = (tasso di campionamento)). 

Numero byte Tipo di byte Numero di 
derivazioni 

Numero 
campione 

Secondo 
numero 

1 Lb 1  
 
 
1 

 
 
 
 
 
 
1 

2 Hb 

3 Lb 2 

4 Hb 

… … … 

2N -1 Lb N 

2N Hb 

2N +1 Lb 1  
 2N +2 Hb 
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2N +3 Lb 2  
2 2N +4 Hb 

… … … 

2N*2-1 Lb N 

2N*2 Hb 

… … … … … 

1+(n-1)*2N Lb 1  
 
 

n 

 
 

n/ 
(velocità 

di 
campionamento) 

2+(n-1)*2N Hb 

3+(n-1)*2N Lb 2 

4+(n-1)*2N Hb 

… … … 

2N*n-1 Lb N 

2N*n Hb 

Tabella 31: Monitoraggio del formato file dei dati non elaborati ECG 
  



ND:  NV-100.5988.050|Rev.260224 PC-ECG 1200 Istruzioni per l'uso Pagina 120 di 129 

 

SPECIFICHE TECNICHE 
Caratteristica Modello 

 1200M 1200S 1200HR 1200W/1200W V3 Blue-ECG NR-1207-E, 
NR-1207-3 

Dimensioni (mm) 128 x 75 x 27 170 x 90 x 30 140 x 95 x 50/156 x 82 x 40 125 x 65 x 22 92 x 75 x 23 
Peso (grammi) 200 300 350/252 100 103 

Alimentazione USB 5 V± 5% 2 batterie alcaline AA o 
ricaricabili NiMH/1 batteria 

alcalina AA o ricaricabile 
NiMH 

 

2 batterie alcaline 
AA o NiMH 
ricaricabili 

1 batteria alcalina 
AA o NiMH 
ricaricabile 

Consumo corrente 
USB 

<100 mA± 10% <200 mA± 10% <60 mA± 10% 
(nell'adattatore 1200WR) 

n/d 

Durata di funzionamento 
della batteria 

n/d Fino a 40 ore/Fino a 34 ore 
(con batterie alcaline) 

Fino a 12 ore Fino a 7 ore 

Derivazioni paziente Cavo standard AHA/IEC a 10 derivazioni Cavo standard AHA/IEC a 
10 o 14 derivazioni 

I 10 fili staccabili sono 
conformi allo standard AAMI 

Cavo standard a 10 derivazioni 
AHA/IEC 

Rilevamento derivazioni 
staccate 

n/d Derivazione staccata o offset > 0,5 V. 

Rilevamento degli impulsi 
del pacemaker 

n/d Da 0,1 a 2 ms a 2 - 700 mV 

Frequenza di 
campionamento del 
rilevamento del 
pacemaker digitale 

n/d 8000 campioni/sec. 8000 campioni/sec / 
8000, 128 000 campioni/sec 

n/d 

Sensibilità (mm/mV) 5, 10, 20, 40 
Scala 
orizzontale (mm/sec) 

12,5, 25, 50, 100 5, 12,5, 25, 50, 100 12,5, 25, 50, 100 

Frequenza di 
campionamento massima 
ECG a riposo 

1000 campioni/sec. 

ECG da sforzo 1000 campioni/sec. 
ECG di monitoraggio n/d 2000 campioni/sec (12 

derivazioni) 
4000 campioni/sec (6 

derivazioni) 

1000 campioni/sec. n/d 

Risoluzione A/D 12 bit 
(2,44 µV/LSB) 

12 bit 
(4,88 µV/LSB) 

24 bit 
(0,3 µV/LSB) 

24 bit 
(0,286 µV/LSB) 

12 bit 
(2,44 µV/LSB) 

Protezione da 
defibrillazione 

Sì, protezione da scariche a 360 J. Sì, con cavo ECG a 
banana 

Corrente di dispersione 
paziente 

< 10 µA 

Contemporaneamente 
12L 

Sì 

CMRR > 90 dB 
Impedenza ingresso > 10 MOhm 
Gamma dinamica del 
segnale 

10 mV 20 mV ±2,4 V 10 mV 

CC max ingresso ±300mV ±2,4 V ±300mV ±800mV 
Gamma di frequenza (-3 
dB) 

0,05 - 150 Hz 0,05 - 300 Hz 0,05 - 260 Hz/0,05 - 150 Hz 0,05 - 150 Hz 0,05 - 260 Hz 

Filtro passa-basso 
(software) 

20, 35, 40, 100 Hz 

Filtro della linea di base 
(software) 

Sì 

Filtro rumore di linea 
(software) 

50/60 Hz 

Interfaccia 
di comunicazione 

USB RF digitale, 
fino a 10 m in spazio aperto 

Bluetooth 2,1+EDR, classe 1 fino a 100 
m in spazio aperto 

Gamma di radiofrequenza n/d 2400 - 2483,5 MHz 
Potenza in uscita RF n/d 0,4 mW, 

Conforme a FCC 
100 mW, 

Conforme a FCC 
Temperatura di trasporto 
e conservazione 

Da -20 °C a +60 °C 

Temperatura di 
funzionamento 

Da 10°C a +45°C 
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Umidità relativa Da 10 a 95% 
Standard di sicurezza IEC 60601-1, 

IEC 60601-1-2, 
IEC 60601-2-25 

IEC 60601-1-2 IEC 60601-1, 
IEC 60601-1-2, 
IEC 60601-2-25 

Tabella 32: Specifiche tecniche 
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ESEMPI DI REFERTO 
 
 

Figura 59:  Referto esame a riposo 
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Figura 60: Applicazioni da sforzo - Referto completo 
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Figura 61: Referto ECG di monitoraggio 
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Figura 62: Referto della variabilità della frequenza cardiaca 
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Figura 63: Referto potenziale tardivo 
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RISOLUZIONE DEI PROBLEMI 
 

Condizione Cause Azione 

Il driver USB non è 
installato 
correttamente 
durante l'installazione 
del PC-ECG. 

Se si collega il dispositivo al PC tramite USB 
prima di avviare il CD di installazione del 
software, il driver USB potrebbe non essere 
installato. 

• Scollegare il cavo USB. 

• Installare il software PC-ECG 1200 dal CD-ROM. 

• Collegare il dispositivo alla porta USB. 

• Verificare che il driver sia installato correttamente (il 
LED sul dispositivo è acceso). 

• Se il dispositivo non è ancora installato correttamente, 
disinstallare il driver USB non identificato come segue: 
a. Con il dispositivo ancora collegato all'USB, fare 

clic con il pulsante destro del mouse su My 
Computer (Risorse del computer). 

b. Selezionare Properties (Proprietà) dal menu a 
comparsa. 

c. Fare clic su Device Manager (Gestione 
dispositivi) nella scheda Hardware. 

d. Fare doppio clic sul dispositivo USB con l'icona 
?nell'elenco dei dispositivi. 

e. Selezionare la scheda Driver. 
f. Fare clic su Uninstall (Disinstalla), quindi su 

OK. 

• Dopo aver eliminato il driver, scollegare il cavo USB 
dal PC. 

• Installare il software PC-ECG e andare al passo 
successivo. 

• Ricollegare il cavo USB al connettore del computer. 

• Attendere che il driver sia installato e che la spia verde 
sul dispositivo sia accesa. 

Recupero dei dati 
ECG dopo un 
arresto imprevisto 
dell'applicazione per 
l'esame da sforzo. 

Se l'applicazione termina inaspettatamente 
prima del completamento e del salvataggio 
dell'esame ECG, potrebbe essere possibile 
recuperare i dati ECG del paziente (esaurito 
[??]). 

L'applicazione dell'esame ECG da sforzo memorizza i dati 
ECG nativi nel file temporaneo. È possibile convertire questi 
dati nel formato file dell'applicazione dell'ECG di 
monitoraggio come segue: 

• Avviare l'applicazione dell'esame ECG da sforzo. 

• Fare clic su Recovery File to Monitoring Format… 
(Recupera file nel formato di monitoraggio…) nel 
menu File. 

Viene visualizzata la finestra di dialogo Choose files for 
conversion… (Scegli file per conversione…). 

• Selezionare la cartella Windows\Temp. 

• Selezionare l'ultimo file temporaneo creato strXX.tmp 
e fare clic su Open (Apri). 

• Selezionare la cartella Monitoring ECG files (File 
ECG di monitoraggio). 

• Inserire il nome del file ECG di monitoraggio in base 
all'ID paziente o al cognome e fare clic su Save 
(Salva). 

• Chiudere l'applicazione per l'esame ECG da sforzo. 

• Aprire la cartella Monitoring ECG files (File ECG di 
monitoraggio) e fare doppio clic sull'ultimo file 
memorizzato. 
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Si apre l'applicazione Monitoring ECG (ECG di 
monitoraggio). 

• Fare clic sul pulsante del menu principale Patient 
(Paziente) e immettere i dati del paziente. 

• Salvare il file ECG di monitoraggio aggiornato. È ora 
possibile ispezionare e stampare il tracciato ECG 
dall'applicazione Monitoring ECG (ECG di 
monitoraggio). 

Utilizzo della 
modalità di 
salvataggio 
automatico senza 
salvare le modifiche. 

 Se si eseguono modifiche (aggiunta/modifica annotazioni, 
misurazioni, ricalcoli, ecc.…) mentre è attiva la modalità 
Auto Save (Salvataggio auto), ma non si desidera salvare le 
modifiche, procedere come segue: 

• Fare clic su Setup (Configurazione). 

• Deselezionare l'opzione Auto Save (Salvataggio 
auto) e fare clic su OK. 

• Chiudere l'applicazione (o il file) con il pulsante X. 
Viene visualizzata una finestra di dialogo che richiede la 
conferma del salvataggio. 

• Fare clic su No. 

• Riaprire l'applicazione e il file. 

• Verificare che le modifiche non siano state salvate. 

• Ora è possibile riattivare la modalità Auto Save 
(Salvataggio auto) (se necessario). 

Viene visualizzata 
una linea retta spessa 
per tutte le 
derivazioni 

Quando il collegamento alla scatola di 
acquisizione non riesce, sullo schermo viene 
visualizzata una linea retta spessa per tutte le 
derivazioni. 

Quando si utilizza il collegamento USB, verificare che il 
LED sul dispositivo ECG sia illuminato. 
Se il LED sul dispositivo ECG non è illuminato, controllare i 
collegamenti alla porta USB e al dispositivo ECG. 
Se il LED sull'adattatore USB è illuminato o se è collegato 
tramite RS232, controllare il collegamento alla scatola di 
acquisizione e assicurarsi che la scatola sia accesa. 

Segnale ECG 
disturbato sulle 
derivazioni. 

Un segnale ECG disturbato su una o più 
derivazioni può essere causato da un 
collegamento non perfetto degli elettrodi o delle 
derivazioni appropriati sul paziente. 

Controllare il collegamento delle derivazioni appropriate sul 
paziente. Assicurarsi che gli elettrodi siano applicati 
correttamente sul paziente. 
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Dati mancanti dopo 
una linea spessa. 

Sullo schermo e nelle stampe dell'ECG, viene 
visualizzata per alcuni secondi una linea spessa e 
dopo che mancano dati per un certo periodo di 
tempo. I tracciati ECG riprendono dopo questo 
periodo di tempo casuale. Questo problema 
potrebbe essere causato dalla modalità di 
sospensione o di blocco nella quale entra il PC 
durante l'esecuzione dell'esame ECG. 

Tutte le impostazioni relative alla gestione dell'alimentazione 
devono essere disabilitate: nessuna modalità standby, 
nessuna interruzione HD, nessuna sospensione, ecc… sul 
computer portatile durante l'esame da sforzo. 
Per impostare la gestione dell'alimentazione, procedere come 
segue: 
Fare clic con il pulsante destro del mouse sul desktop. 
Selezionare PROPERTIES (PROPRIETÀ) dal menu a 
comparsa. 
Selezionare la scheda SCREENSAVER (Salvaschermo). 
Premere il pulsante di accensione nel riquadro alimentazione 
monitor. 
Selezionare combinazioni risparmio energia come 
PRESENTATION (Presentazione) o HOME\OFFICE 
DESK (Scrivania casa\ufficio). 
Non impostare MAI su "Turn off Hard Disk" (Spegni disco 
rigido), "System Standby" (Standby sistema) e "System 
Hibernates" (Blocco sistema). 
Premere OK per applicare questa configurazione. 

Sullo schermo viene 
visualizzato "Lead-
off" (Derivazione 
staccata) oppure 
alcune derivazioni 
vengono stampate 
come 
linee in grassetto 

Il contatto dell'elettrodo è scarso. Una 
derivazione potrebbe essere allentata. 
Una derivazione è scollegata dal paziente. 
Cavo delle derivazioni o cavo paziente rotto. 

Ricollegare l'elettrodo. Sostituire l'elettrodo. 
Verificare che la cute del paziente sia adeguatamente 
preparata. 
Verificare che gli elettrodi non siano scaduti. 

Interferenza del 
tremore muscolare 
sovrapposta alle 
forme d'onda. 

Il paziente non è tranquillo. 
Il paziente ha la febbre e ha i brividi. 
Il piano d'esame è troppo piccolo o stretto. 
Le fascette degli elettrodi sono strette. 

Aiutare il paziente a sentirsi a proprio agio. 
Controllare tutti i contatti degli elettrodi. 
Attivare il filtro EMG. 

Interferenza CA 
sovrapposta alle 
forme d'onda. 

Problema con gli elettrodi. 
Il tecnico tocca un elettrodo paziente che è a 
contatto con qualsiasi parte metallica del tavolo 
o del piano d'esame. 
Cavo ECG o cavo di alimentazione rotti. 
Dispositivi elettrici nelle immediate vicinanze, 
illuminazione, cablaggio nascosto in pareti o 
pavimenti. 
Presa elettrica con messa a terra non corretta. 
Impostazione della frequenza del filtro CA 
errata o filtro CA disattivato. 

Verificare che il paziente non tocchi alcuna parte metallica 
del letto o della stanza. 
Verificare che il cavo di alimentazione CA non sia collegato 
al cavo delle derivazioni paziente. 
Attivare il filtro AC. 
Verificare che sia selezionata la corretta impostazione del 
filtro CA (50 Hz o 60 Hz, a seconda della regione). 
Se l'interferenza persiste, il rumore può essere causato da 
altre apparecchiature presenti nella stanza o da linee di 
alimentazione con messa a terra inadeguata. 
Provare a spostarsi in un'altra stanza. 
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